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Oracle Database: SQL Fundamentals II   A - 3 

Practices and Solutions for Lesson I 
In this practice, you review the available SQL Developer resources. You also learn about 
your user account that you use in this course. You then start SQL Developer, create a new 
database connection, and browse your HR tables. You also set some SQL Developer 
preferences, execute SQL statements, and execute an anonymous PL/SQL block by using 
SQL Worksheet. Finally, you access and bookmark the Oracle Database 11g 
documentation and other useful Web sites that you can use in this course.  
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Oracle Database: SQL Fundamentals II   A - 4 

Practice I-1: Accessing SQL Developer Resources 
In this practice, you do the following:  

1) Access the SQL Developer home page. 

a. Access the online SQL Developer home page available at: 
http://www.oracle.com/technology/products/database/sql_developer/index.ht
ml 

b. Bookmark the page for easier future access. 

2) Access the SQL Developer tutorial available online at: 
http://st-curriculum.oracle.com/tutorial/SQLDeveloper/index.htm. Then review 
the following sections and associated demos:  

a) What to Do First 
b) Working with Database Objects 
c) Accessing Data 
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Practice I-2: Using SQL Developer 

1) Start SQL Developer by using the desktop icon.   

2) Create a database connection using the following information: 

a) Connection Name: myconnection  
b) Username: oraxx, where xx is the number of your PC (Ask your instructor to 

assign you an ora account out of the ora21-ora40 range of accounts.) 
c) Password: oraxx 
d) Hostname: localhost 
e) Port: 1521 
f) SID: orcl (or the value provided to you by the instructor) 

3) Test the new connection. If the status is Success, connect to the database by using 
this new connection. 

a) Click the Test button in the New/Select Database Connection window. 
b) If the status is Success, click the Connect button. 

4) Browse the structure of the EMPLOYEES table and display its data. 

a) Expand the myconnection connection by clicking the plus sign next to it. 

b) Expand the Tables icon by clicking the plus sign next to it. 

c) Display the structure of the EMPLOYEES table. 

d) View the data of the DEPARTMENTS table.  

5) Execute some basic SELECT statements to query the data in the EMPLOYEES 
table in the SQL Worksheet area. Use both the Execute Statement (or press F9) 
and the Run Script (or press F5) icons to execute the SELECT statements. Review 
the results of both methods of executing the SELECT statements on the 
appropriate tabbed pages. 

a) Write a query to select the last name and salary for any employee whose 
salary is less than or equal to $3,000. 

b) Write a query to display last name, job ID, and commission for all employees 
who are not entitled to receive a commission. 

6) Set your script pathing preference to /home/oracle/labs/sql2. 

a) Select Tools > Preferences > Database > Worksheet Parameters. 

b) Enter the value in the Select default path to look for scripts field. 

7) Enter the following in the Enter SQL Statement box. 
SELECT employee_id, first_name, last_name,  
       FROM   employees; 

8) Save the SQL statement to a script file by using the File > Save As menu item. 

a) Select File > Save As. 

b) Name the file intro_test.sql. 
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Practice I-2: Using SQL Developer (continued) 

Oracle Database: SQL Fundamentals II   A - 6 

c) Place the file under your /home/oracle/labs/sql2/labs folder. 

9) Open and run confidence.sql from your /home/oracle/labs/sql2/labs folder, 
and observe the output. 
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Oracle Database: SQL Fundamentals II   A - 7 

Practice Solutions I-1: Accessing SQL Developer Resources 
1) Access the SQL Developer home page. 

  a) Access the online SQL Developer home page available online at: 

   http://www.oracle.com/technology/products/database/sql_developer/index.html 

 

    The SQL Developer home page is displayed as follows:  

 

 
 

  b) Bookmark the page for easier future access. 

2) Access the SQL Developer tutorial available online at: 
http://st-curriculum.oracle.com/tutorial/SQLDeveloper/index.htm 
 
Then, review the following sections and associated demos:  

     a) What to Do First 

     b) Working with Database Objects 
     c) Accessing Data 
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Practice Solutions I-2: Using SQL Developer 
 

1) Start SQL Developer by using the desktop icon.  

 

 
 

2) Create a database connection using the following information: 

a. Connection Name: myconnection 

b. Username: oraxx (Ask your instructor to assign you one ora account out of the 
ora21–ora40 range of accounts.) 

c. Password: oraxx 

d. Hostname: localhost 

e. Port: 1521  

f. SID: orcl (or the value provided to you by the instructor) 

 

 

 

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
A

ca
de

m
y 

U
se

 O
nl

y 



Practice Solutions I-2: Using SQL Developer (continued) 
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3)  Test the new connection. If the status is Success, connect to the database by using this 

new connection. 
a) Click the Test button in the New/Select Database Connection window.  

 

 
 

 b) If the status is Success, click the Connect button. 
 

 
 

Browsing the Tables 

4) Browse the structure of the EMPLOYEES table and display its data. 

 a) Expand the myconnection connection by clicking the plus sign next to it. 
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Practice Solutions I-2: Using SQL Developer (continued) 
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 b) Expand the Tables icon by clicking the plus sign next to it. 
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c) Display the structure of the EMPLOYEES table. 

Click the EMPLOYEES table. The Columns tab displays the columns in the 
EMPLOYEES table as follows: 

 
 

d) View the data of the DEPARTMENTS table. 

In the Connections navigator, click the DEPARTMENTS table. Then click the Data 
tab. 
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5) Execute some basic SELECT statements to query the data in the EMPLOYEES table in 
the SQL Worksheet area. Use both the Execute Statement (or press F9) and the Run 
Script icons (or press F5) to execute the SELECT statements. Review the results of 
both methods of executing the SELECT statements on the appropriate tabbed pages. 

a) Write a query to select the last name and salary for any employee whose salary is 
less than or equal to $3,000. 

SELECT last_name, salary 
FROM employees 
WHERE salary <= 3000; 

b) Write a query to display last name, job ID, and commission for all employees who 
are not entitled to receive a commission. 

SELECT last_name, job_id, commission_pct 
FROM   employees 
WHERE  commission_pct IS NULL; 

  
6) Set your script pathing preference to /home/oracle/labs/sql2. 

     a) Select Tools > Preferences > Database > Worksheet Parameters. 

     b) Enter the value in the Select default path to look for scripts field. Then, click OK. 
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7) Enter the following SQL statement: 

    SELECT employee_id, first_name, last_name 
  FROM employees; 

 
8) Save the SQL statement to a script file by using the File > Save As menu item.  

       a) Select File > Save As. 

 

                
                            

      b) Name the file intro_test.sql. 
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          Enter intro_test.sql in the File_name text box. 

      c) Place the file under the /home/oracle/labs/SQL2/labs folder. 
 

        

 
 
Then, click Save. 

9)  Open and run confidence.sql from your /home/oracle/labs/SQL2/labs folder 
and observe the output. 
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Open the confidence.sql script file by using the File > Open menu item.  

 
Then, press F5 to execute the script.  

The following is the expected result: 
  

 
 
COUNT(*)                
----------------------  
8                       
 
1 rows selected 
 
COUNT(*)                
----------------------  
107                     
 
1 rows selected 
 
COUNT(*)                
----------------------  
25                      
 
1 rows selected 
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COUNT(*)                
----------------------  
4                       
 
1 rows selected 
 
COUNT(*)                
----------------------  
23                      
 
1 rows selected 
 
COUNT(*)                
----------------------  
27                      
 
1 rows selected 
 
COUNT(*)                
----------------------  
19                      
 
1 rows selected 
 
COUNT(*)                
----------------------  
10                      
 
1 rows selected 
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Practices and Solutions for Lesson 1 
 

Practice 1-1: Controlling User Access 
 
1. What privilege should a user be given to log on to the Oracle server? Is this a system 

privilege or an object privilege? 
 _________________________________________________________________ 
2. What privilege should a user be given to create tables? 
 _________________________________________________________________ 
3. If you create a table, who can pass along privileges to other users in your table? 
 _________________________________________________________________ 
4. You are the DBA. You create many users who require the same system privileges. 

What should you use to make your job easier? 
 _________________________________________________________________ 
5. What command do you use to change your password? 
 _________________________________________________________________ 
6. User21 is the owner of the EMP table and grants the DELETE privilege to User22 

by using the WITH GRANT OPTION clause. User22 then grants the DELETE 
privilege on EMP to User23. User21 now finds that User23 has the privilege and 
revokes it from User22. Which user can now delete from the EMP table? 

 _________________________________________________________________ 
7. You want to grant SCOTT the privilege to update data in the DEPARTMENTS table. 

You also want to enable SCOTT to grant this privilege to other users. What command 
do you use? 

  _________________________________________________________________ 
 
To complete question 8 and the subsequent ones, you need to connect to the 
database by using SQL Developer. If you are already not connected, do the 
following to connect: 

1. Click the SQL Developer desktop icon. 

2. In the Connections Navigator, use the oraxx account and the corresponding 
password provided by your instructor to log on to the database. 

 
 
8. Grant another user query privilege on your table. Then, verify whether that user can 

use the privilege. 
Note: For this exercise, team up with another group. For example, if you are user 
ora21, team up with another user ora22. 

a. Grant another user privilege to view records in your REGIONS table. Include 
an option for this user to further grant this privilege to other users. 

b. Have the user query your REGIONS table. 
c. Have the user pass on the query privilege to a third user (for example, 

ora23). 
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d. Take back the privilege from the user who performs step b.  
 Note: Each team can run exercises 9 and 10 independently. 
9. Grant another user query and data manipulation privileges on your COUNTRIES 

table. Make sure that the user cannot pass on these privileges to other users. 
10. Take back the privileges on the COUNTRIES table granted to another user. 
 Note: For exercises 11 through 17, team up with another group. 
11. Grant another user access to your DEPARTMENTS table. Have the user grant you 

query access to his or her DEPARTMENTS table. 
12. Query all the rows in your DEPARTMENTS table. 
 

 
. . . 

13. Add a new row to your DEPARTMENTS table. Team 1 should add Education as 
department number 500. Team 2 should add Human Resources as department 
number 510. Query the other team’s table. 

14. Create a synonym for the other team’s DEPARTMENTS table. 

15. Query all the rows in the other team’s DEPARTMENTS table by using your synonym. 

Team 1 SELECT statement results: 
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Team 2 SELECT statement results: 

 
 

16. Revoke the SELECT privilege from the other team. 

17. Remove the row that you inserted into the DEPARTMENTS table in step 13 and save 
the changes. 
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Practice Solutions 1-1: Controlling User Access 

To complete question 8 and the subsequent ones, you need to connect to the database by 
using SQL Developer.  

 

1. What privilege should a user be given to log on to the Oracle server? Is this a 
system or an object privilege? 
The CREATE SESSION system privilege 

 

2. What privilege should a user be given to create tables? 
The CREATE TABLE privilege 

 

3. If you create a table, who can pass along privileges to other users in your table? 
You can, or anyone you have given those privileges to, by using WITH GRANT 
OPTION 

 

4. You are the DBA. You create many users who require the same system 
privileges. 
What should you use to make your job easier? 
Create a role containing the system privileges and grant the role to the users.  

 

5. What command do you use to change your password? 
The ALTER USER statement 

 

6. User21 is the owner of the EMP table and grants DELETE privileges to User22 
by using the WITH GRANT OPTION clause. User22 then grants DELETE 
privileges on EMP to User23. User21 now finds that User23 has the 
privilege and revokes it from User22. Which user can now delete data from the 
EMP table? 

Only User21  

7. You want to grant SCOTT the privilege to update data in the DEPARTMENTS 
table. You also want to enable SCOTT to grant this privilege to other users. What 
command do you use? 
GRANT UPDATE ON departments TO scott WITH GRANT 
OPTION; 
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8. Grant another user query privilege on your table. Then, verify whether that user 
can use the privilege. 

      Note: For this exercise, team up with another group. For example, if you are user 
ora21, team up with another user ora22. 

      a) Grant another user privilege to view records in your REGIONS table. 
Include an option for this user to further grant this privilege to other users. 

           Team 1 executes this statement:  

GRANT select 
ON regions 
TO <team2_oraxx> WITH GRANT OPTION; 

      b) Have the user query your REGIONS table. 

           Team 2 executes this statement: 

SELECT * FROM <team1_oraxx>.regions; 

      c) Have the user pass on the query privilege to a third user (for example, ora23). 

             Team 2 executes this statement. 

GRANT select 
ON <team1_oraxx>.regions 
TO <team3_oraxx>; 

      d) Take back the privilege from the user who performs step b. 

             Team 1 executes this statement. 

REVOKE select 
ON regions 
FROM <team2_oraxx>; 

9. Grant another user query and data manipulation privileges on your COUNTRIES 
table. Make sure the user cannot pass on these privileges to other users. 

Team 1 executes this statement. 
GRANT select, update, insert 
ON COUNTRIES  
TO <team2_oraxx>; 
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10. Take back the privileges on the COUNTRIES table granted to another user. 
        Team 1 executes this statement. 
REVOKE select, update, insert ON COUNTRIES FROM <team2_oraxx>; 

Note: For the exercises 11 through 17, team up with another group. 

11. Grant another user access to your DEPARTMENTS table. Have the user grant you 
query access to his or her DEPARTMENTS table. 

 

   Team 2 executes the GRANT statement. 
GRANT select 
ON departments 
TO <team1_oraxx>; 

      Team 1 executes the GRANT statement. 
GRANT select 
ON departments 
TO <team2_oraxx>; 

 

Here, <team1_oraxx> is the username of Team 1 and <team2_oraxx> is the 
username of Team 2. 

12.  Query all the rows in your DEPARTMENTS table. 

 
      SELECT  * 
      FROM    departments; 

  

13. Add a new row to your DEPARTMENTS table. Team 1 should add Education 
as department number 500. Team 2 should add Human Resources as 
department number 510. Query the other team’s table.  

 

   Team 1 executes this INSERT statement. 
       INSERT INTO departments(department_id, department_name) 
        VALUES (500, 'Education'); 
        COMMIT; 

   Team 2 executes this INSERT statement. 
       INSERT INTO departments(department_id, department_name) 
        VALUES (510, 'Human Resources'); 
        COMMIT; 
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14. Create a synonym for the other team’s DEPARTMENTS table. 

   Team 1 creates a synonym named team2. 
 
 

CREATE SYNONYM team2 
         FOR <team2_oraxx>.DEPARTMENTS; 

   Team 2 creates a synonym named team1. 
CREATE SYNONYM team1 
         FOR <team1_oraxx>. DEPARTMENTS; 
 

 

15. Query all the rows in the other team’s DEPARTMENTS table by using your 
synonym. 

 
 

   Team 1 executes this SELECT statement. 
SELECT  * 
   FROM    team2; 

   Team 2 executes this SELECT statement. 
SELECT  * 
    FROM    team1; 

   

 

16. Revoke the SELECT privilege from the other team. 

    Team 1 revokes the privilege. 
REVOKE select 
     ON departments 
     FROM  <team2_oraxx>; 

    Team 2 revokes the privilege. 
REVOKE select 
     ON departments  
     FROM <team1_oraxx>; 
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17. Remove the row that you inserted into the DEPARTMENTS table in step 8 and 
save the changes. 

    

     Team 1 executes this DELETE statement. 
        DELETE FROM departments 
        WHERE department_id = 500; 
        COMMIT; 

    Team 2 executes this DELETE statement. 
        DELETE FROM departments 
        WHERE department_id = 510;  
        COMMIT; 
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Practices and Solutions for Lesson 2 

Practice 2-1: Managing Schema Objects 
In this practice, you use the ALTER TABLE command to modify columns and add 
constraints. You use the CREATE INDEX command to create indexes when creating a 
table, along with the CREATE TABLE command. You create external tables.  
1. Create the DEPT2 table based on the following table instance chart. Enter the syntax 

in the SQL Worksheet. Then, execute the statement to create the table. Confirm that 
the table is created. 

 

 

 

 

 

 

 

 

 

 
2. Populate the DEPT2 table with data from the DEPARTMENTS table. Include only the 

columns that you need. 

3. Create the EMP2 table based on the following table instance chart. Enter the syntax in 
the SQL Worksheet. Then execute the statement to create the table. Confirm that the 
table is created. 

 

 

 

 

 

 

 

 

 

 

 

 

Column Name ID NAME 

Key Type   

Nulls/Unique   

FK Table   

FK Column   

Data type NUMBER VARCHAR2 

Length 7 25 

 
 

Column Name ID LAST_NAME FIRST_NAME DEPT_ID 

Key Type     

Nulls/Unique     

FK Table     

FK Column     

Data type NUMBER VARCHAR2 VARCHAR2 NUMBER 

Length 7 25 25 7 
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4. Modify the EMP2 table to allow for longer employee last names. Confirm your 
modification. 

 
5. Create the EMPLOYEES2 table based on the structure of the EMPLOYEES table. 

Include only the EMPLOYEE_ID, FIRST_NAME, LAST_NAME, SALARY, and 
DEPARTMENT_ID columns. Name the columns in your new table ID, 
FIRST_NAME, LAST_NAME, SALARY, and DEPT_ID, respectively. 

6. Drop the EMP2 table. 

7. Query the recycle bin to see whether the table is present. 

 
8. Restore the EMP2 table to a state before the DROP statement.  

 
9. Drop the FIRST_NAME column from the EMPLOYEES2 table. Confirm your 

modification by checking the description of the table. 
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10. In the EMPLOYEES2 table, mark the DEPT_ID column as UNUSED. Confirm your 

modification by checking the description of the table. 

 
11. Drop all the UNUSED columns from the EMPLOYEES2 table. Confirm your 

modification by checking the description of the table. 

12. Add a table-level PRIMARY KEY constraint to the EMP2 table on the ID column. The 
constraint should be named at creation. Name the constraint my_emp_id_pk. 

13. Create a PRIMARY KEY constraint to the DEPT2 table using the ID column. The 
constraint should be named at creation. Name the constraint my_dept_id_pk.  

14. Add a foreign key reference on the EMP2 table that ensures that the employee is not 
assigned to a nonexistent department. Name the constraint my_emp_dept_id_fk.  

15. Modify the EMP2 table. Add a COMMISSION column of the NUMBER data type, 
precision 2, scale 2. Add a constraint to the COMMISSION column that ensures that a 
commission value is greater than zero.  

16. Drop the EMP2 and DEPT2 tables so that they cannot be restored. Verify the recycle 
bin.  

17. Create the DEPT_NAMED_INDEX table based on the following table instance chart. 
Name the index for the PRIMARY KEY column as DEPT_PK_IDX. 
 
 
 
 
 
 
 
 
 

18. Create an external table library_items_ext. Use the ORACLE_LOADER access 
driver. 

Column Name Deptno Dname 

Primary Key Yes  

Data Type Number VARCHAR2 

Length 4 30 
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Note: The emp_dir directory and library_items.dat file are already created 
for this exercise. library_items.dat has records in the following format: 

2354,    2264, 13.21, 150, 

2355,    2289, 46.23, 200, 

2355,    2264, 50.00, 100, 

a.   Open the lab_02_18.sql file. Observe the code snippet to create the 
library_items_ext external table. Then replace <TODO1>, <TODO2>, 
<TODO3>, and <TODO4> as appropriate and save the file as 
lab_02_18_soln.sql. Run the script to create the external table. 

b. Query the library_items_ext table. 

 
 

19. The HR department needs a report of the addresses of all departments. Create an 
external table as dept_add_ext using the ORACLE_DATAPUMP access driver. 
The report should show the location ID, street address, city, state or province, and 
country in the output. Use a NATURAL JOIN to produce the results. 

      Note: The emp_dir directory is already created for this exercise. 

 

a. Open the lab_02_19.sql file. Observe the code snippet to create the 
dept_add_ext external table. Then, replace <TODO1>, <TODO2>, and 
<TODO3> with the appropriate code. Replace <oraxx_emp4.exp> and 
<oraxx_emp5.exp> with the appropriate file names. For example, if you are 
the ora21 user, your file names are ora21_emp4.exp and 
ora21_emp5.exp. Save the script as lab_02_19_soln.sql. 

b. Run the lab_02_19_soln.sql script to create the external table. 

c. Query the dept_add_ext table. 
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Note: When you perform the preceding step, two files oraxx_emp4.exp and 
oraxx_emp5.exp are created under the default directory emp_dir. 

 

20. Create the emp_books table and populate it with data. Set the primary key as 
deferred and observe what happens at the end of the transaction. 

a. Run the lab_02_20_a.sql file to create the emp_books table. Observe that 
the emp_books_pk primary key is not created as deferrable. 

 

 
b. Run the lab_02_20_b.sql file to populate data into the emp_books table. 

What do you observe? 

 
c. Set the emp_books_pk constraint as deferred. What do you observe? 

 
d. Drop the emp_books_pk constraint. 

 
e. Modify the emp_books table definition to add the emp_books_pk constraint 

as deferrable this time. 
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f. Set the emp_books_pk constraint as deferred. 

 
g. Run the lab_02_20_g.sql file to populate data into the emp_books table. 

What do you observe? 

 
 

h. Commit the transaction. What do you observe? 
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Practice Solutions 2-1: Managing Schema Objects 

1. Create the DEPT2 table based on the following table instance chart. Enter the syntax 
in the SQL Worksheet. Then, execute the statement to create the table. Confirm that 
the table is created. 

 

CREATE TABLE dept2 
       (id NUMBER(7), 
        name VARCHAR2(25)); 
 
DESCRIBE dept2 

 

2. Populate the DEPT2 table with data from the DEPARTMENTS table. Include only the 
columns that you need. 
 

      INSERT INTO dept2 
      SELECT  department_id, department_name 
      FROM    departments; 
 

 

3. Create the EMP2 table based on the following table instance chart. Enter the syntax in 
the SQL Worksheet. Then execute the statement to create the table. Confirm that the 
table is created. 

Column Name ID NAME 

Key Type   

Nulls/Unique   

FK Table   

FK Column   

Data type NUMBER VARCHAR2 

Length 7 25 

 
 

Column Name ID LAST_NAME FIRST_NAME DEPT_ID 

Key Type     

Nulls/Unique     

FK Table     

FK Column     

Data type NUMBER VARCHAR2 VARCHAR2 NUMBER 

Length 7 25 25 7 
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      CREATE TABLE  emp2 
      (id           NUMBER(7), 
       last_name     VARCHAR2(25), 
       first_name    VARCHAR2(25), 
       dept_id       NUMBER(7)); 
 
      DESCRIBE emp2 
 

 

4. Modify the EMP2 table to allow for longer employee last names. Confirm your 
modification. 
 

      ALTER TABLE emp2 
      MODIFY (last_name   VARCHAR2(50)); 
  
      DESCRIBE emp2 

 

5. Create the EMPLOYEES2 table based on the structure of the EMPLOYEES table. 
Include only the EMPLOYEE_ID, FIRST_NAME, LAST_NAME, SALARY, and 
DEPARTMENT_ID columns. Name the columns in your new table ID, 
FIRST_NAME, LAST_NAME, SALARY, and DEPT_ID, respectively. 

 
 

      CREATE TABLE employees2 AS 
      SELECT  employee_id id, first_name, last_name, salary,    
              department_id dept_id 
      FROM    employees; 
 

 

 

6. Drop the EMP2 table. 
 

       

     DROP TABLE emp2; 
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7.  Query the recycle bin to see whether the table is present. 

 
   SELECT original_name, operation, droptime  
FROM recyclebin; 

 
 

8. Restore the EMP2 table to a state before the DROP statement. 

 
 

      FLASHBACK TABLE emp2 TO BEFORE DROP; 
      DESC emp2; 

 

9. Drop the FIRST_NAME column from the EMPLOYEES2 table. Confirm your 
modification by checking the description of the table. 
 

       ALTER TABLE employees2 
      DROP COLUMN first_name; 
 
   DESCRIBE employees2 

  

10. In the EMPLOYEES2 table, mark the DEPT_ID column as UNUSED. Confirm your 
modification by checking the description of the table. 
 

   ALTER TABLE employees2 
   SET   UNUSED (dept_id); 
 
   DESCRIBE employees2 

 

11. Drop all the UNUSED columns from the EMPLOYEES2 table. Confirm your 
modification by checking the description of the table. 
   
   ALTER TABLE employees2 
      DROP UNUSED COLUMNS; 
 
      DESCRIBE employees2 
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12. Add a table-level PRIMARY KEY constraint to the EMP2 table on the ID column. The  
constraint should be named at creation. Name the constraint my_emp_id_pk. 
 

      ALTER TABLE    emp2 
      ADD CONSTRAINT my_emp_id_pk PRIMARY KEY (id); 
 

13. Create a PRIMARY KEY constraint to the DEPT2 table using the ID column. The 
constraint should be named at creation. Name the constraint my_dept_id_pk.  
 

     ALTER TABLE    dept2 
     ADD CONSTRAINT my_dept_id_pk PRIMARY KEY(id); 

 

14. Add a foreign key reference on the EMP2 table that ensures that the employee is not 
assigned to a nonexistent department. Name the constraint my_emp_dept_id_fk.  
 

      ALTER TABLE emp2 
      ADD CONSTRAINT my_emp_dept_id_fk 
      FOREIGN KEY (dept_id) REFERENCES dept2(id); 

 

15. Modify the EMP2 table. Add a COMMISSION column of the NUMBER data type, 
precision 2, scale 2. Add a constraint to the COMMISSION column that ensures that a 
commission value is greater than zero.  

 
      ALTER TABLE emp2 
      ADD commission NUMBER(2,2) 
      CONSTRAINT my_emp_comm_ck CHECK (commission > 0); 

 

16. Drop the EMP2 and DEPT2 tables so that they cannot be restored. Check in the 
recycle bin. 

 
     DROP TABLE emp2 PURGE; 
     DROP TABLE dept2 PURGE; 
 
     SELECT original_name, operation, droptime  
       FROM recyclebin; 

 

17. Create the DEPT_NAMED_INDEX table based on the following table instance chart. 
Name the index for the PRIMARY KEY column as DEPT_PK_IDX. 

Column Name Deptno Dname 

Primary Key Yes  

Data Type Number VARCHAR2 

Length 4 30 
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      CREATE TABLE DEPT_NAMED_INDEX  
       (deptno NUMBER(4) 
       PRIMARY KEY USING INDEX 
       (CREATE INDEX dept_pk_idx ON 
        DEPT_NAMED_INDEX(deptno)), 
        dname VARCHAR2(30)); 

 

18. Create an external table library_items_ext. Use the ORACLE_LOADER access 
driver.  
Note: The emp_dir directory and library_items.dat are already created for 
this exercise. Ensure that the external file and the database are on the same machine. 
 
library_items.dat has records in the following format: 

  2354,    2264, 13.21, 150, 

       2355,    2289, 46.23, 200, 

        2355,    2264, 50.00, 100, 

    a) Open the lab_02_18.sql file. Observe the code snippet to create the  
library_items_ext external table. Then, replace <TODO1>, <TODO2>,  
 <TODO3>, and <TODO4> as appropriate and save the file as 
lab_02_18_soln.sql. 
Run the script to create the external table.  

      
CREATE TABLE library_items_ext ( category_id   number(12) 
                               , book_id number(6) 
                               , book_price number(8,2) 
                               , quantity   number(8) 
                               ) 
ORGANIZATION EXTERNAL 
 (TYPE ORACLE_LOADER  
  DEFAULT DIRECTORY emp_dir 
  ACCESS PARAMETERS (RECORDS DELIMITED BY NEWLINE 
                     FIELDS TERMINATED BY ',') 
 LOCATION ('library_items.dat') 
 ) 
REJECT LIMIT UNLIMITED;  
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  b) Query the library_items_ext table. 
SELECT * FROM library_items_ext; 

19. The HR department needs a report of addresses of all the departments. Create an 
external table as dept_add_ext using the ORACLE_DATAPUMP access driver. 
The report should show the location ID, street address, city, state or province, and 
country in the output. Use a NATURAL JOIN to produce the results. 
 
Note: The emp_dir directory is already created for this exercise. Ensure that the 
external file and the database are on the same machine. 

a)  Open the lab_02_19.sql file. Observe the code snippet to create the  
dept_add_ext external table. Then, replace <TODO1>, <TODO2>, and 
<TODO3> with appropriate code. Replace <oraxx_emp4.exp> and 
<oraxx_emp5.exp> with appropriate file names. For example, if you are user 
ora21, your file names are ora21_emp4.exp and ora21_emp5.exp. Save   

the script as lab_02_19_soln.sql. 
CREATE TABLE dept_add_ext (location_id, 
                           street_address, city, 
                           state_province, 
                           country_name) 
ORGANIZATION EXTERNAL( 
TYPE ORACLE_DATAPUMP 
DEFAULT DIRECTORY emp_dir 
LOCATION ('oraxx_emp4.exp','oraxx_emp5.exp')) 
PARALLEL 
AS  
SELECT location_id, street_address, city, state_province, 
country_name 
FROM locations  
NATURAL JOIN countries; 

        Note: When you perform the preceding step, two files oraxx_emp4.exp and  
        oraxx_emp5.exp are created under the default directory emp_dir. 

               Run the lab_02_19_soln.sql script to create the external table. 
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b) Query the dept_add_ext table. 
SELECT * FROM dept_add_ext; 

20. Create the emp_books table and populate it with data. Set the primary key as 
deferred and observe what happens at the end of the transaction.  

a) Run the lab_02_20a.sql script to create the emp_books table. Observe 
that the emp_books_pk primary key is not created as deferrable. 
 

CREATE TABLE emp_books (book_id number, 
                       title varchar2(20), CONSTRAINT 
emp_books_pk  PRIMARY KEY (book_id)); 

b) Run the lab_02_20b.sql script to populate data into the emp_books 
table.  
    What do you observe? 

INSERT INTO emp_books VALUES(300,'Organizations'); 
INSERT INTO emp_books VALUES(300,'Change Management'); 

The first row is inserted. However, you see the ora-00001 error with the 
second row insertion. 
c) Set the emp_books_pk constraint as deferred. What do you observe? 
 

SET CONSTRAINT emp_books_pk DEFERRED; 

  You see the following error: “ORA-02447: Cannot defer a constraint that is not 
deferrable.” 

      d) Drop the emp_books_pk constraint. 
ALTER TABLE emp_books DROP CONSTRAINT emp_books_pk; 

e) Modify the emp_books table definition to add the emp_books_pk 
constraint as deferrable this time. 

ALTER TABLE emp_books ADD (CONSTRAINT emp_books_pk PRIMARY KEY 
(book_id) DEFERRABLE); 

 f) Set the emp_books_pk constraint as deferred. 
SET CONSTRAINT emp_books_pk DEFERRED; 
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g) Run the lab_02_20g.sql script to populate data into the emp_books 
table. 
      What do you observe? 

INSERT INTO emp_books VALUES (300,'Change Management'); 
INSERT INTO emp_books VALUES (300,'Personality'); 
INSERT INTO emp_books VALUES (350,'Creativity'); 

 You see that all the rows are inserted. 

    h) Commit the transaction. What do you observe? 
COMMIT; 

 
 You see that the transaction is rolled back.
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Practices and Solutions for Lesson 3 
 

Practice 3-1: Managing Objects with Data Dictionary Views 
In this practice, you query the dictionary views to find information about objects in your 
schema. 
 
1. Query the USER_TABLES data dictionary view to see information about the tables 

that you own. 
 

 
… 
2. Query the ALL_TABLES data dictionary view to see information about all the tables 

that you can access. Exclude the tables that you own. 
      Note: Your list may not exactly match the following list: 
 

 
… 

 
 
3. For a specified table, create a script that reports the column names, data types, and 

data types’ lengths, as well as whether nulls are allowed. Prompt the user to enter the 
table name. Give appropriate aliases to the DATA_PRECISION and DATA_SCALE 
columns. Save this script in a file named lab_03_01.sql.  
For example, if the user enters DEPARTMENTS, the following output results: 
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4. Create a script that reports the column name, constraint name, constraint type, search 
condition, and status for a specified table. You must join the USER_CONSTRAINTS 
and USER_CONS_COLUMNS tables to obtain all this information. Prompt the user to 
enter the table name. Save the script in a file named lab_03_04.sql. 
For example, if the user enters DEPARTMENTS, the following output results:  

 
 

5. Add a comment to the DEPARTMENTS table. Then query the 
USER_TAB_COMMENTS view to verify that the comment is present. 

 

 
 

6. Create a synonym for your EMPLOYEES table. Call it EMP. Then find the names of 
all synonyms that are in your schema. 

 
 

7. Run lab_03_07.sql to create the dept50 view for this exercise. 
You need to determine the names and definitions of all the views in your schema.  
Create a report that retrieves view information: the view name and text from the 
USER_VIEWS data dictionary view. 
Note: The EMP_DETAILS_VIEW was created as part of your schema.  
Note: You can see the complete definition of the view if you use Run Script (or press 
F5) in SQL Developer. If you use Execute Statement (or press F9) in SQL Developer, 
scroll horizontally in the result pane. If you use SQL*Plus, to see more contents of a 
LONG column, use the SET LONG n command, where n is the value of the number 
of characters of the LONG column that you want to see. 
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8. Find the names of your sequences. Write a query in a script to display the following 
information about your sequences: sequence name, maximum value, increment size, 
and last number. Name the script lab_03_08.sql. Run the statement in your 
script. 

 

 
Run the lab_03_09_tab.sql script as a prerequisite for exercises 9 through 11. 
Alternatively, open the script file to copy the code and paste it into your SQL Worksheet. 
Then execute the script. This script: 

• Drops if there are existing tables DEPT2 and EMP2 

• Creates the DEPT2 and EMP2 tables  

Note: In Practice 2, you should have already dropped the DEPT2 and EMP2 tables so that 
they cannot be restored. 

 

9. Confirm that both the DEPT2 and EMP2 tables are stored in the data dictionary. 

 
 

10. Confirm that the constraints were added by querying the USER_CONSTRAINTS 
view. Note the types and names of the constraints. 

 
 

11. Display the object names and types from the USER_OBJECTS data dictionary view 
for the EMP2 and DEPT2 tables. 

12. Create the SALES_DEPT table based on the following table instance chart. Name the 
index for the PRIMARY KEY column SALES_PK_IDX. Then query the data 
dictionary view to find the index name, table name, and whether the index is unique. 
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Column Name Team_Id Location 

Primary Key Yes  

Data Type Number VARCHAR2 

Length 3 30 
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Practice Solutions 3-1: Managing Objects with Data Dictionary 
Views 

1. Query the data dictionary to see information about the tables you  
own. 
SELECT table_name 
   FROM   user_tables; 

2. Query the dictionary view to see information about all the tables that you can access. 
Exclude tables that you own. 
SELECT table_name, owner 
  FROM   all_tables 
  WHERE  owner <>'ORAxx'; 

3.  For a specified table, create a script that reports the column names, data types, and 
data types’ lengths, as well as whether nulls are allowed. Prompt the user to enter the 
table name. Give appropriate aliases to the DATA_PRECISION and DATA_SCALE 
columns. Save this script in a file named lab_03_01.sql.  
SELECT column_name, data_type, data_length, 
       data_precision PRECISION, data_scale SCALE, nullable 
FROM   user_tab_columns 
WHERE  table_name = UPPER('&tab_name'); 

To test, run the script and enter DEPARTMENTS as the table name. 

4. Create a script that reports the column name, constraint name, constraint type, search 
condition, and status for a specified table. You must join the USER_CONSTRAINTS 
and USER_CONS_COLUMNS tables to obtain all this information. Prompt the user to 
enter the table name. Save the script in a file named lab_03_04.sql. 

 
SELECT ucc.column_name, uc.constraint_name, 
uc.constraint_type,    
       uc.search_condition, uc.status 
FROM   user_constraints uc JOIN user_cons_columns ucc 
ON     uc.table_name = ucc.table_name 
AND    uc.constraint_name = ucc.constraint_name 
AND    uc.table_name = UPPER('&tab_name');  

To test, run the script and enter DEPARTMENTS as the table name. 
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5. Add a comment to the DEPARTMENTS table. Then query the 
USER_TAB_COMMENTS view to verify that the comment is present. 

 
COMMENT ON TABLE departments IS  
  'Company department information including name, code, and 
location.'; 
 
SELECT COMMENTS  
FROM   user_tab_comments 
WHERE  table_name = 'DEPARTMENTS'; 

 

6. Create a synonym for your EMPLOYEES table. Call it EMP. Then, find the names of 
all the synonyms that are in your schema. 

 
CREATE SYNONYM emp FOR EMPLOYEES; 
SELECT *  
FROM   user_synonyms; 

 

7. Run lab_03_07.sql to create the dept50 view for this exercise. You need to 
determine the names and definitions of all the views in your schema. Create a report 
that retrieves view information: the view name and text from the USER_VIEWS data 
dictionary view. 

Note: The EMP_DETAILS_VIEW was created as part of your schema.  

Note: You can see the complete definition of the view if you use Run Script (or press 
F5) in SQL Developer. If you use Execute Statement (or press F9) in SQL 
Developer, scroll horizontally in the result pane. If you use SQL*Plus to see more 
contents of a LONG column, use the SET LONG n command, where n is the value 
of the number of characters of the LONG column that you want to see. 

 
SELECT   view_name, text 
FROM     user_views; 
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8. Find the names of your sequences. Write a query in a script to display the following 
information about your sequences: sequence name, maximum value, increment size, 
and last number. Name the script lab_03_08.sql. Run the statement in your 
script. 

 
SELECT   sequence_name, max_value, increment_by, last_number 
FROM user_sequences; 

Run the lab_03_09_tab.sql script as a prerequisite for exercises 9 through 11. 
Alternatively, open the script file to copy the code and paste it into your SQL 
Worksheet. Then execute the script. This script: 

 Drops the DEPT2 and EMP2 tables 

 Creates the DEPT2 and EMP2 tables 

Note: In Practice 2, you should have already dropped the DEPT2 and EMP2 tables so 
that they cannot be restored.  

9. Confirm that both the DEPT2 and EMP2 tables are stored in the data dictionary. 
 
SELECT   table_name 
FROM     user_tables 
WHERE    table_name IN ('DEPT2', 'EMP2'); 

10. Query the data dictionary to find out the constraint names and types for both the 
tables. 
 
SELECT   constraint_name, constraint_type 
FROM     user_constraints 
WHERE    table_name IN ('EMP2', 'DEPT2'); 

11. Query the data dictionary to display the object names and types for both the tables. 
 
SELECT   object_name, object_type 
FROM     user_objects 
WHERE    object_name LIKE 'EMP%' 
OR       object_name LIKE 'DEPT%'; 
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12. Create the SALES_DEPT table based on the following table instance chart. Name the 
index for the PRIMARY KEY column as SALES_PK_IDX. Then query the data 
dictionary view to find the index name, table name, and whether the index is unique. 

 

  
CREATE TABLE SALES_DEPT  
       (team_id NUMBER(3) 
       PRIMARY KEY USING INDEX 
       (CREATE INDEX sales_pk_idx ON 
        SALES_DEPT(team_id)), 
        location VARCHAR2(30)); 
 
SELECT INDEX_NAME, TABLE_NAME, UNIQUENESS 
FROM USER_INDEXES 
WHERE TABLE_NAME = ‘SALES_DEPT’; 

 
 

 

 

 

Column Name Team_Id Location 

Primary Key Yes  

Data Type Number VARCHAR2 

Length 3 30 
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Practices and Solutions for Lesson 4 

Practice 4-1: Manipulating Large Data Sets 
In this practice, you perform multitable INSERT and MERGE operations, and track row 
versions. 

 

1. Run the lab_04_01.sql script in the lab folder to create the SAL_HISTORY 
table. 

2. Display the structure of the SAL_HISTORY table. 

 

3. Run the lab_04_03.sql script in the lab folder to create the MGR_HISTORY 
table. 

4. Display the structure of the MGR_HISTORY table. 

 
5. Run the lab_04_05.sql script in the lab folder to create the SPECIAL_SAL 

table. 

6. Display the structure of the SPECIAL_SAL table. 

 
 

7.  a. Write a query to do the following: 

- Retrieve details such as the employee ID, hire date, salary, and manager ID of 
those employees whose employee ID is less than 125 from the EMPLOYEES 
table. 

- If the salary is more than $20,000, insert details such as the employee ID and 
salary into the SPECIAL_SAL table. 
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- Insert details such as the employee ID, hire date, and salary into the 
SAL_HISTORY table. 

- Insert details such as the employee ID, manager ID, and salary into the 
MGR_HISTORY table. 

 

b. Display the records from the SPECIAL_SAL table. 

 
 

c. Display the records from the SAL_HISTORY table. 

 
 

d. Display the records from the MGR_HISTORY table. 

 
 

 

8.     

a. Run the lab_04_08_a.sql script in the lab folder to create the 
SALES_WEEK_DATA table. 

b. Run the lab_04_08b.sql script in the lab folder to insert records into the 
SALES_WEEK_DATA table. 
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c. Display the structure of the SALES_WEEK_DATA table. 

 
d. Display the records from the SALES_WEEK_DATA table. 

 
e. Run the lab_04_08_e.sql script in the lab folder to create the 

EMP_SALES_INFO table. 

f. Display the structure of the EMP_SALES_INFO table. 

 
g. Write a query to do the following: 

- Retrieve details such as ID, week ID, sales quantity on Monday, sales 
quantity on Tuesday, sales quantity on Wednesday, sales quantity on 
Thursday, and sales quantity on Friday from the SALES_WEEK_DATA 
table. 

- Build a transformation such that each record retrieved from the 
SALES_WEEK_DATA table is converted into multiple records for the 
EMP_SALES_INFO table. 
Hint: Use a pivoting INSERT statement. 

h. Display the records from the EMP_SALES_INFO table. 

 
 

9. You have the data of past employees stored in a flat file called emp.data. You want 
to store the names and email IDs of all employees, past and present, in a table. To do 
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this, first create an external table called EMP_DATA using the emp.dat source file 
in the emp_dir directory. Use the lab_04_09.sql script to do this. 

10. Next, run the lab_04_10.sql script to create the EMP_HIST table. 

a. Increase the size of the email column to 45. 

b. Merge the data in the EMP_DATA table created in the last lab into the data in 
the EMP_HIST table. Assume that the data in the external EMP_DATA table is 
the most up-to-date. If a row in the EMP_DATA table matches the EMP_HIST 
table, update the email column of the EMP_HIST table to match the 
EMP_DATA table row. If a row in the EMP_DATA table does not match, insert 
it into the EMP_HIST table. Rows are considered matching when the 
employee’s first and last names are identical. 

c. Retrieve the rows from EMP_HIST after the merge. 

  
 

11. Create the EMP3 table by using the lab_04_11.sql script. In the EMP3 table, 
change the department for Kochhar to 60 and commit your change. Next, change 
the department for Kochhar to 50 and commit your change. Track the changes to 
Kochhar by using the Row Versions feature. 

 
 

 

 

 

 

 

 

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
A

ca
de

m
y 

U
se

 O
nl

y 



 

Oracle Database: SQL Fundamentals II   A - 51 

Practice Solutions 4-1: Manipulating Large Data Sets 

1. Run the lab_04_01.sql script in the lab folder to create the SAL_HISTORY 
table.  

 

2. Display the structure of the SAL_HISTORY table. 
 
     DESC sal_history 

 

3. Run the lab_04_03.sql script in the lab folder to create the MGR_HISTORY  
table. 

 

4. Display the structure of the MGR_HISTORY table. 
      
     DESC mgr_history 

 

5. Run the lab_04_05.sql script in the lab folder to create the SPECIAL_SAL 
table. 

 

6. Display the structure of the SPECIAL_SAL table. 

 
     DESC special_sal  

 

 

7. a) Write a query to do the following: 
- Retrieve details such as the employee ID, hire date, salary, and manager ID 

of those employees whose employee ID is less than 125 from the 
EMPLOYEES table. 

- If the salary is more than $20,000, insert details such as the employee ID 
and salary into the SPECIAL_SAL table. 

- Insert details such as the employee ID, hire date, and salary into the 
SAL_HISTORY table. 

- Insert details such as the employee ID, manager ID, and salary into the 
MGR_HISTORY table. 
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INSERT ALL 
WHEN SAL > 20000 THEN 
INTO  special_sal VALUES (EMPID, SAL) 
ELSE 
INTO sal_history VALUES(EMPID,HIREDATE,SAL) 
INTO mgr_history VALUES(EMPID,MGR,SAL) 
SELECT employee_id EMPID, hire_date HIREDATE, 
salary SAL, manager_id MGR 
FROM employees  
WHERE employee_id < 125; 

 

 

  b) Display the records from the SPECIAL_SAL table. 
       
         SELECT * FROM  special_sal; 

 

 c) Display the records from the SAL_HISTORY table. 
      
         SELECT * FROM  sal_history; 

 

 d) Display the records from the MGR_HISTORY table. 
       
         SELECT * FROM mgr_history; 

 

8.  a) Run the lab_04_08a.sql script in the lab folder to create the 
  SALES_WEEK_DATA table. 

 

 b) Run the lab_04_08b.sql script in the lab folder to insert records into the  
  SALES_WEEK_DATA table. 

      

 c) Display the structure of the SALES_WEEK_DATA table. 
      
        DESC sales_week_data 

 

 d) Display the records from the SALES_WEEK_DATA table. 
      
        SELECT * FROM SALES_WEEK_DATA; 
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   e) Run the lab_04_08_e.sql script in the lab folder to create the 
EMP_SALES_INFO table. 

      

   f) Display the structure of the EMP_SALES_INFO table. 
      
        DESC emp_sales_info 

 
   g) Write a query to do the following:  

- Retrieve details such as the employee ID, week ID, sales quantity on 
Monday, sales quantity on Tuesday, sales quantity on Wednesday, sales 
quantity on Thursday, and sales quantity on Friday from the 
SALES_WEEK_DATA table.  

- Build a transformation such that each record retrieved from the 
SALES_WEEK_DATA table is converted into multiple records for the 
EMP_SALES_INFO table. 
 
Hint: Use a pivoting INSERT statement. 

 
 INSERT ALL 
      INTO emp_sales_info VALUES (id, week_id, QTY_MON) 
      INTO emp_sales_info VALUES (id, week_id, QTY_TUE) 
      INTO emp_sales_info VALUES (id, week_id, QTY_WED) 
      INTO emp_sales_info VALUES (id, week_id, QTY_THUR) 
      INTO emp_sales_info VALUES (id, week_id, QTY_FRI) 
 SELECT ID, week_id, QTY_MON, QTY_TUE, QTY_WED,  
      QTY_THUR,QTY_FRI FROM sales_week_data; 

 
       

    h) Display the records from the SALES_INFO table. 
  
    SELECT * FROM emp_sales_info;  

 
 
 
 

 

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
A

ca
de

m
y 

U
se

 O
nl

y 



Practice Solutions 4-1: Manipulating Large Data Sets (continued) 

Oracle Database: SQL Fundamentals II   A - 54 

9.  You have the data of past employees stored in a flat file called emp.data. You 
want to store the names and email IDs of all employees past and present in a 
table. To do this, first create an external table called EMP_DATA using the 
emp.dat source file in the emp_dir directory. You can use the script in 
lab_04_09.sql to do this. 

 
CREATE TABLE emp_data 
  (first_name  VARCHAR2(20) 
  ,last_name   VARCHAR2(20) 
  , email     VARCHAR2(30) 
  ) 
ORGANIZATION EXTERNAL 
( 
 TYPE oracle_loader 
 DEFAULT DIRECTORY emp_dir 
 ACCESS PARAMETERS 
 ( 
  RECORDS DELIMITED BY NEWLINE CHARACTERSET US7ASCII 
  NOBADFILE 
  NOLOGFILE 
  FIELDS 
  ( first_name POSITION ( 1:20) CHAR 
  , last_name POSITION (22:41) CHAR 
  ,  email   POSITION (43:72) CHAR ) 
 ) 
 LOCATION ('emp.dat') ) ; 

 
10. Next, run the lab_04_10.sql script to create the EMP_HIST table.  

a) Increase the size of the email column to 45. 
 

 
ALTER TABLE emp_hist MODIFY email varchar(45); 

 
 
 
b) Merge the data in the EMP_DATA table created in the last lab into the data in 

the EMP_HIST table. Assume that the data in the external EMP_DATA table 
is the most up-to-date. If a row in the EMP_DATA table matches the 
EMP_HIST table, update the email column of the EMP_HIST table to match 
the EMP_DATA table row. If a row in the EMP_DATA table does not match, 
insert it into the EMP_HIST table. Rows are considered matching when the 
employee’s first and last names are identical.  

 
 

 
MERGE INTO EMP_HIST f USING EMP_DATA h 
 ON (f.first_name = h.first_name 
 AND f.last_name = h.last_name) 
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WHEN MATCHED THEN 
 UPDATE SET f.email = h.email 
WHEN NOT MATCHED THEN 
 INSERT (f.first_name 
    , f.last_name 
    , f.email) 
 VALUES (h.first_name 
    , h.last_name 
    , h.email); 

 

 
c) Retrieve the rows from EMP_HIST after the merge. 
 

SELECT * FROM emp_hist; 
 
11. Create the EMP3 table using the lab_04_11.sql script. In the EMP3 table, 

change the department for Kochhar to 60 and commit your change. Next, 
change the department for Kochhar to 50 and commit your change. Track the 
changes to Kochhar using the Row Versions feature. 

  
  
    UPDATE emp3 SET department_id = 60  
    WHERE last_name = ‘Kochhar’; 
    COMMIT; 
    UPDATE emp3 SET department_id = 50  
    WHERE last_name = ‘Kochhar’; 
    COMMIT; 

 
SELECT VERSIONS_STARTTIME "START_DATE",      
   VERSIONS_ENDTIME "END_DATE",  DEPARTMENT_ID   
FROM EMP3   
   VERSIONS BETWEEN SCN MINVALUE AND MAXVALUE  
WHERE LAST_NAME ='Kochhar'; 
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Practices and Solutions for Lesson 5 

Practice 5-1: Managing Data in Different Time Zones 
In this practice, you display time zone offsets, CURRENT_DATE, 
CURRENT_TIMESTAMP, and LOCALTIMESTAMP. You also set time zones and use the 
EXTRACT function. 

1. Alter the session to set NLS_DATE_FORMAT to DD-MON-YYYY HH24:MI:SS. 

2. a. Write queries to display the time zone offsets (TZ_OFFSET) for the following 
time zones. 

- US/Pacific-New 

 
- Singapore 

 
- Egypt 

 
 

b. Alter the session to set the TIME_ZONE parameter value to the time zone 
offset of US/Pacific-New. 

c. Display CURRENT_DATE, CURRENT_TIMESTAMP, and 
LOCALTIMESTAMP for this session. 

d. Alter the session to set the TIME_ZONE parameter value to the time zone 
offset of Singapore. 

e. Display CURRENT_DATE, CURRENT_TIMESTAMP, and 
LOCALTIMESTAMP for this session. 

Note: The output might be different based on the date when the command is 
executed.  

 
Note: Observe in the preceding practice that CURRENT_DATE, 
CURRENT_TIMESTAMP, and LOCALTIMESTAMP are sensitive to the 
session time zone. 

3. Write a query to display DBTIMEZONE and SESSIONTIMEZONE. 

 
4. Write a query to extract the YEAR from the HIRE_DATE column of the EMPLOYEES 

table for those employees who work in department 80. 
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5. Alter the session to set NLS_DATE_FORMAT to DD-MON-YYYY. 

6. Examine and run the lab_05_06.sql script to create the SAMPLE_DATES table 
and populate it. 

a. Select from the table and view the data.  

 
 

b. Modify the data type of the DATE_COL column and change it to 
TIMESTAMP. Select from the table to view the data.  

 
 

c. Try to modify the data type of the DATE_COL column and change it to 
TIMESTAMP WITH TIME ZONE. What happens? 

 

7. Create a query to retrieve last names from the EMPLOYEES table and calculate the 
review status. If the year hired was 1998, display Needs Review for the review 
status; otherwise, display not this year! Name the review status column 
Review. Sort the results by the HIRE_DATE column. 
Hint: Use a CASE expression with the EXTRACT function to calculate the review 
status. 

 

 
… 
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8. Create a query to print the last names and the number of years of service for each 
employee. If the employee has been employed for five or more years, print 5 years 
of service. If the employee has been employed for 10 or more years, print 10 
years of service. If the employee has been employed for 15 or more years, 
print 15 years of service. If none of these conditions match, print maybe 
next year! Sort the results by the HIRE_DATE column. Use the EMPLOYEES 
table. 
Hint: Use CASE expressions and TO_YMINTERVAL. 

 
... 
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Practice Solutions 5-1: Managing Data in Different Time Zones 
 

1.  Alter the session to set NLS_DATE_FORMAT to DD-MON-YYYY HH24:MI:SS. 
 

   ALTER SESSION SET NLS_DATE_FORMAT =  
   'DD-MON-YYYY HH24:MI:SS'; 

 

2. a.  Write queries to display the time zone offsets (TZ_OFFSET) for the following 
time zones: US/Pacific-New, Singapore, and Egypt. 

 

  US/Pacific-New 
      SELECT TZ_OFFSET ('US/Pacific-New') from dual;  

  Singapore 
    SELECT TZ_OFFSET ('Singapore') from dual; 

  Egypt 
    SELECT TZ_OFFSET ('Egypt') from dual; 

 

b. Alter the session to set the TIME_ZONE parameter value to the time zone offset 
of US/Pacific-New. 

 
     ALTER SESSION SET TIME_ZONE = '-7:00'; 

 

c. Display CURRENT_DATE, CURRENT_TIMESTAMP, and LOCALTIMESTAMP 
for this session. 
Note: The output may be different based on the date when the command is 
executed.  

 

        SELECT CURRENT_DATE, CURRENT_TIMESTAMP,    
  LOCALTIMESTAMP FROM DUAL;  

 

d. Alter the session to set the TIME_ZONE parameter value to the time zone offset 
of Singapore. 

  
 ALTER SESSION SET TIME_ZONE = '+8:00'; 

 

e. Display CURRENT_DATE, CURRENT_TIMESTAMP, and LOCALTIMESTAMP 
for this session. 
Note: The output might be different, based on the date when the command is 
executed.  

 

    SELECT CURRENT_DATE, CURRENT_TIMESTAMP,    
 LOCALTIMESTAMP FROM DUAL; 
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Practice Solutions 5-1: Managing Data in Different Time Zones 
(continued) 
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Note: Observe in the preceding practice that CURRENT_DATE, 
CURRENT_TIMESTAMP, and LOCALTIMESTAMP are all sensitive to the session 
time zone. 

 

3.  Write a query to display DBTIMEZONE and SESSIONTIMEZONE. 
 

     SELECT DBTIMEZONE,SESSIONTIMEZONE 
     FROM DUAL;  

 

4.  Write a query to extract YEAR from the HIRE_DATE column of the EMPLOYEES 
table for those employees who work in department 80. 

 

     SELECT last_name, EXTRACT (YEAR FROM HIRE_DATE) 
     FROM employees 
     WHERE department_id = 80; 

 

5. Alter the session to set NLS_DATE_FORMAT to DD-MON-YYYY. 

 
           ALTER SESSION SET NLS_DATE_FORMAT = 'DD-MON-YYYY'; 

 

6. Examine and run the lab_05_06.sql script to create the SAMPLE_DATES table 
and populate it.  

 
a. Select from the table and view the data.  

 
      SELECT * FROM sample_dates; 

 
b. Modify the data type of the DATE_COL column and change it to TIMESTAMP. 

Select from the table to view the data.  
 

ALTER TABLE sample_dates MODIFY date_col TIMESTAMP; 
SELECT * FROM sample_dates; 

 
c. Try to modify the data type of the DATE_COL column and change it to 

TIMESTAMP WITH TIME ZONE. What happens? 
 

ALTER TABLE sample_dates MODIFY date_col  
TIMESTAMP WITH TIME ZONE; 
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(continued) 
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You are unable to change the data type of the DATE_COL column because the 
Oracle server does not permit you to convert from TIMESTAMP to TIMESTAMP 
WITH TIMEZONE by using the ALTER statement.  

7. Create a query to retrieve last names from the EMPLOYEES table and calculate the 
review status. If the year hired was 1998, display Needs Review for the review 
status; otherwise, display not this year! Name the review status column 
Review. Sort the results by the HIRE_DATE column. 
Hint: Use a CASE expression with the EXTRACT function to calculate the review 
status. 

 
SELECT e.last_name 
   ,     (CASE extract(year from e.hire_date) 
           WHEN 1998 THEN 'Needs Review' 
           ELSE 'not this year!' 
     END )           AS "Review " 
FROM   employees e 
ORDER BY e.hire_date; 

 
8. Create a query to print the last names and the number of years of service for each 

employee. If the employee has been employed five or more years, print 5 years of 
service. If the employee has been employed 10 or more years, print 10 years 
of service. If the employee has been employed 15 or more years, print 15 years 
of service. If none of these conditions match, print maybe next year! Sort 
the results by the HIRE_DATE column. Use the EMPLOYEES table. 
Hint: Use CASE expressions and TO_YMINTERVAL. 
SELECT e.last_name, hire_date, sysdate, 
       (CASE 
    WHEN  (sysdate -TO_YMINTERVAL('15-0'))>=  
            hire_date THEN '15 years of service' 
        WHEN (sysdate -TO_YMINTERVAL('10-0'))>= hire_date   
          THEN '10 years of service' 
        WHEN (sysdate - TO_YMINTERVAL('5-0'))>= hire_date  
           THEN '5 years of service' 
     ELSE 'maybe next year!' 
          END) AS "Awards" 
     FROM   employees e; 
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Practices and Solutions for Lesson 6 
 

Practice 6-1: Retrieving Data by Using Subqueries 
In this practice, you write multiple-column subqueries, and correlated and scalar 
subqueries. You also solve problems by writing the WITH clause. 

 

1. Write a query to display the last name, department number, and salary of any 
employee whose department number and salary both match the department number 
and salary of any employee who earns a commission. 

 
 

2. Display the last name, department name, and salary of any employee whose salary 
and commission match the salary and commission of any employee located in 
location ID 1700.  

 
 

3. Create a query to display the last name, hire date, and salary for all employees who 
have the same salary and commission as Kochhar. 

 Note: Do not display Kochhar in the result set. 

 
 

4. Create a query to display the employees who earn a salary that is higher than the 
salary of all the sales managers (JOB_ID = 'SA_MAN'). Sort the results from the 
highest to the lowest. 
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5. Display details such as the employee ID, last name, and department ID of those 
employees who live in cities the names of which begin with T.  

 
6. Write a query to find all employees who earn more than the average salary in their 

departments. Display last name, salary, department ID, and the average salary for the 
department. Sort by average salary and round to two decimals. Use aliases for the 
columns retrieved by the query as shown in the sample output. 

 
7. Find all employees who are not supervisors. 

a. First, do this using the NOT EXISTS operator. 
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b. Can this be done by using the NOT IN operator? How, or why not? 

8. Write a query to display the last names of the employees who earn less than the 
average salary in their departments. 

 
 

9. Write a query to display the last names of the employees who have one or more 
coworkers in their departments with later hire dates but higher salaries. 

 

 
 

10. Write a query to display the employee ID, last names, and department names of all 
the employees.  
Note: Use a scalar subquery to retrieve the department name in the SELECT 
statement. 

 

 
… 
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11. Write a query to display the department names of those departments whose total 

salary cost is above one-eighth (1/8) of the total salary cost of the whole company. 
Use the WITH clause to write this query. Name the query SUMMARY. 
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Practice Solutions 6-1: Retrieving Data by Using Subqueries 

1. Write a query to display the last name, department number, and salary of any 
employee whose department number and salary match the department number and 
salary of any employee who earns a commission. 

 

    SELECT last_name, department_id, salary 
    FROM   employees 
    WHERE  (salary, department_id) IN  
              (SELECT  salary, department_id 
               FROM    employees 
             WHERE   commission_pct IS NOT NULL); 

  

2.  Display the last name, department name, and salary of any employee whose salary 
and commission match the salary and commission of any employee located in 
location ID1700. 

 

     SELECT e.last_name, d.department_name, e.salary 
     FROM   employees e, departments d 
     WHERE  e.department_id = d.department_id 
     AND   (salary, NVL(commission_pct,0)) IN  
                 (SELECT salary, NVL(commission_pct,0) 
               FROM employees e, departments  d 
               WHERE e.department_id = d.department_id 
                AND d.location_id = 1700); 

 

3. Create a query to display the last name, hire date, and salary for all employees 
who have the same salary and commission as Kochhar. 

 Note: Do not display Kochhar in the result set. 
 

SELECT last_name, hire_date, salary 
FROM   employees 
WHERE  (salary, NVL(commission_pct,0)) IN  
             (SELECT salary, NVL(commission_pct,0) 
              FROM   employees 
              WHERE  last_name = 'Kochhar') 
AND last_name != 'Kochhar'; 

4.  Create a query to display the employees who earn a salary that is higher than the 
salary of all the sales managers (JOB_ID = 'SA_MAN'). Sort the results on 
salary from the highest to the lowest.                    
 

    SELECT last_name, job_id, salary 
    FROM   employees 
    WHERE  salary > ALL  
                 (SELECT salary 
                  FROM   employees 
    WHERE  job_id = 'SA_MAN') 
    ORDER BY salary DESC; 
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(continued) 
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5.  Display details such as the employee ID, last name, and department ID of those 
employees who live in cities the names of which begin with T. 

 

     SELECT employee_id, last_name, department_id 
     FROM   employees 
     WHERE  department_id IN (SELECT department_id 
                              FROM departments 
                              WHERE location_id IN   
                                   (SELECT  location_id 
                                    FROM locations 
                                    WHERE city LIKE 'T%')); 

 

6.   Write a query to find all employees who earn more than the average salary in their 
departments. Display last name, salary, department ID, and the average salary for 
the department. Sort by average salary. Use aliases for the columns retrieved by 
the query as shown in the sample output.    

  

  SELECT e.last_name ename, e.salary salary,  
             e.department_id deptno, AVG(a.salary) dept_avg 
       FROM   employees e, employees a 
       WHERE  e.department_id = a.department_id 
       AND    e.salary > (SELECT AVG(salary) 
                    FROM   employees 
                    WHERE  department_id = e.department_id ) 
       GROUP BY e.last_name, e.salary, e.department_id 
       ORDER BY AVG(a.salary); 
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Practice Solutions 6-1: Retrieving Data by Using Subqueries 
(continued) 
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7. Find all employees who are not supervisors. 

a.  First, do this by using the NOT EXISTS operator.  
                     

   SELECT outer.last_name 
   FROM    employees outer 
   WHERE  NOT EXISTS (SELECT 'X' 
                      FROM employees inner 
                       WHERE inner.manager_id =  
                             outer.employee_id); 

 

b.  Can this be done by using the NOT IN operator? How, or why not? 
 

 

        SELECT outer.last_name 
        FROM   employees outer 
        WHERE  outer.employee_id  
        NOT IN (SELECT inner.manager_id 
                FROM   employees inner); 

 
This alternative solution is not a good one. The subquery picks up a NULL value, so the 
entire query returns no rows. The reason is that all conditions that compare a NULL 
value result in NULL. Whenever NULL values are likely to be part of the value set, do 
not use NOT IN as a substitute for NOT EXISTS. 

 

8.   Write a query to display the last names of the employees who earn less than the 
average salary in their departments. 

 

         SELECT last_name 
         FROM    employees outer 
         WHERE outer.salary < (SELECT AVG(inner.salary) 
                               FROM employees inner 
                               WHERE inner.department_id  
                                     = outer.department_id); 
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Practice Solutions 6-1: Retrieving Data by Using Subqueries 
(continued) 
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9. Write a query to display the last names of employees who have one or more 
coworkers in their departments with later hire dates but higher salaries. 

 

        SELECT  last_name 
         FROM    employees outer 
         WHERE EXISTS (SELECT 'X' 
                       FROM employees inner 
                       WHERE inner.department_id =  
                             outer.department_id  
                       AND inner.hire_date > outer.hire_date 
                       AND inner.salary > outer.salary);  

 

10. Write a query to display the employee ID, last names, and department names of 
all employees. 

     Note: Use a scalar subquery to retrieve the department name in the SELECT 
statement.  
 

        SELECT employee_id, last_name,  
            (SELECT department_name 
           FROM departments d 
             WHERE   e.department_id =    
                  d.department_id ) department 
     FROM employees e 
     ORDER BY department; 

 

11. Write a query to display the department names of those departments whose total 
salary cost is above one-eighth (1/8) of the total salary cost of the whole 
company. Use the WITH clause to write this query. Name the query SUMMARY.  

 

WITH  
summary AS ( 
  SELECT d.department_name, SUM(e.salary) AS dept_total 
  FROM employees e, departments d 
  WHERE e.department_id = d.department_id 
  GROUP BY d.department_name) 
SELECT department_name, dept_total 
FROM summary 
WHERE dept_total > ( SELECT SUM(dept_total) * 1/8 
                    FROM summary  ) 
ORDER BY dept_total DESC; 
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Practices and Solutions for Lesson 7 
 

Practice 7-1: Regular Expression Support 
In this practice, you use regular expressions functions to search for, replace, and 
manipulate data. You also create a new CONTACTS table and add a CHECK constraint to 
the p_number column to ensure that phone numbers are entered into the database in a 
specific standard format. 
1. Write a query to search the EMPLOYEES table for all the employees whose first 

names start with “Ki” or “Ko.” 
 

 
 
2. Create a query that removes the spaces in the STREET_ADDRESS column of the 

LOCATIONS table in the display. Use “Street Address” as the column heading.  

 
 
3. Create a query that displays “St” replaced by “Street” in the STREET_ADDRESS 

column of the LOCATIONS table. Be careful that you do not affect any rows that 
already have “Street” in them. Display only those rows that are affected. 

 
 
4. Create a contacts table and add a check constraint to the p_number column to 

enforce the following format mask to ensure that phone numbers are entered into the 
database in the following standard format: (XXX) XXX-XXXX. The table should 
have the following columns: 

- l_name varchar2(30) 
- p_number varchar2 (30) 
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Practice 7-1: Regular Expression Support (continued) 
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5. Run the SQL script lab_07_05.sql to insert the following seven phone numbers 
into the contacts table. Which numbers are added? 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
6. Write a query to find the number of occurrences of the DNA pattern ctc in the string  

gtctcgtctcgttctgtctgtcgttctg. Ignore case-sensitivity. 
 

 
 

l_name Column Value p_number Column Value 

NULL ‘(650) 555-5555’ 

NULL ‘(215) 555-3427’ 

NULL ‘650 555-5555’ 

NULL ‘650 555 5555’ 

NULL ‘650-555-5555’ 

NULL ‘(650)555-5555’ 

NULL ‘ (650) 555-5555’ 
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Practice Solutions 7-1: Regular Expression Support 

1. Write a query to search the EMPLOYEES table for all employees whose first 
names start with “Ki” or “Ko.” 
 

SELECT first_name, last_name 
FROM employees 
WHERE REGEXP_LIKE (last_name, '^K(i|o).'); 

 
 
 

2. Create a query that removes the spaces in the STREET_ADDRESS column of the 
LOCATIONS table in the display. Use “Street Address” as the column heading. 
 

SELECT regexp_replace (street_address, ' ', '') AS "Street 
Address" 
FROM locations; 

 
3. Create a query that displays “St” replaced by “Street” in the STREET_ADDRESS 

column of the LOCATIONS table. Be careful that you do not affect any rows that 
already have “Street” in them. Display only those rows, which are affected. 

 
         SELECT regexp_replace (street_address, 'St$', 
'Street') 
 FROM locations 
    WHERE regexp_like (street_address, 'St'); 

 
 
 
4.  Create a contacts table and add a check constraint to the p_number column to 

enforce the following format mask to ensure that phone numbers are entered into 
the database in the following standard format: (XXX) XXX-XXXX. The table 
should have the following columns: 
 l_name varchar2(30) 
 p_number varchar2 (30) 

 
CREATE TABLE contacts 
( 
  l_name    VARCHAR2(30),  
  p_number  VARCHAR2(30) 
    CONSTRAINT p_number_format       
      CHECK ( REGEXP_LIKE ( p_number, '^\(\d{3}\) \d{3}-
\d{4}$' ) ) 
); 
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Practice Solutions 7-1: Regular Expression Support (continued) 
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5. Run the lab_07_05.sql SQL script to insert the following seven phone 
numbers into the contacts table. Which numbers are added? 

      Only the first two INSERT statements use a format that conforms to the 
c_contacts_pnf constraint; the remaining statements generate CHECK 
constraint errors. 

6.   Write a query to find the number of occurrences of the DNA pattern ctc in the 
string 
gtctcgtctcgttctgtctgtcgttctg. Use the alias Count_DNA. Ignore 
case-sensitivity. This function, introduced with 11g Release 2, returns the 
number of times a pattern match is found in the input string. 

     
SELECT REGEXP_COUNT('gtctcgtctcgttctgtctgtcgttctg','ctc') 
AS Count_DNA 
FROM dual; 
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Table Descriptions
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Schema Description

Overall Description

The Oracle database sample schemas portray a sample company that operates worldwide to fill orders 
for several different products. The company has three divisions:

• Human Resources: Tracks information about the employees and facilities
• Order Entry: Tracks product inventories and sales through various channels
• Sales History: Tracks business statistics to facilitate business decisions

Each of these divisions is represented by a schema. In this course, you have access to the objects in 
all the schemas. However, the emphasis of the examples, demonstrations, and practices is on the 
Human Resources (HR) schema.

All scripts necessary to create the sample schemas reside in the
$ORACLE_HOME/demo/schema/ folder.

Human Resources (HR)

This is the schema that is used in this course. In the Human Resource (HR) records, each employee 
has an identification number, email address, job identification code, salary, and manager. Some 
employees earn commissions in addition to their salary.

The company also tracks information about jobs within the organization. Each job has an 
identification code, job title, and a minimum and maximum salary range. Some employees have been 
with the company for a long time and have held different positions within the company. When an 
employee resigns, the duration the employee was working for, the job identification number, and the 
department are recorded. 

The sample company is regionally diverse, so it tracks the locations of its warehouses and 
departments. Each employee is assigned to a department, and each department is identified either by 
a unique department number or a short name. Each department is associated with one location, and 
each location has a full address that includes the street name, postal code, city, state or province, and 
the country code.

In places where the departments and warehouses are located, the company records details such as the 
country name, currency symbol, currency name, and the region where the country is located 
geographically.
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The HR Entity Relationship Diagram

HR DEPARTMENTS
department_id

department_name
manager_id
location_id

LOCATIONS
location_id

street_address
postal_code

city
state_province

country_id

COUNTRIES
country_id

country_name
region_id

REGIONS
region_id

region_name

EMPLOYEES
employee_id

first_name
last_name

email
phone_number

hire_date
job_id
salary

commission_pct
manager_id

department_id

JOBS
job_id

job_title
min_salary
max_salary

JOB_HISTORY
employee_id
start_date
end_date

job_id
department_id
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The Human Resources (HR) Table Descriptions

DESCRIBE countries

SELECT * FROM countries;
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The Human Resources (HR) Table Descriptions (continued)

DESCRIBE departments

SELECT * FROM departments;
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The Human Resources (HR) Table Descriptions (continued)

DESCRIBE employees

SELECT * FROM employees;
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The Human Resources (HR) Table Descriptions (continued)

DESCRIBE job_history

SELECT * FROM job_history
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The Human Resources (HR) Table Descriptions (continued)

DESCRIBE jobs

SELECT * FROM jobs
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The Human Resources (HR) Table Descriptions (continued)

DESCRIBE locations

SELECT * FROM locations
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The Human Resources (HR) Table Descriptions (continued)

DESCRIBE regions

SELECT * FROM regions
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Using SQL Developer
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Objectives

After completing this appendix, you should be able to do the 
following:

• List the key features of Oracle SQL Developer

• Identify menu items of Oracle SQL Developer

• Create a database connection

• Manage database objects

• Use SQL Worksheet

• Save and run SQL scripts

• Create and save reports

Objectives

In this appendix, you are introduced to the graphical tool called SQL Developer. You learn how 
to use SQL Developer for your database development tasks. You learn how to use SQL 
Worksheet to execute SQL statements and SQL scripts.
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What Is Oracle SQL Developer?

• Oracle SQL Developer is a graphical tool that enhances 
productivity and simplifies database development tasks.

• You can connect to any target Oracle database schema by 
using standard Oracle database authentication.

SQL Developer

What Is Oracle SQL Developer?

Oracle SQL Developer is a free graphical tool designed to improve your productivity and 
simplify the development of everyday database tasks. With just a few clicks, you can easily 
create and debug stored procedures, test SQL statements, and view optimizer plans.

SQL Developer, the visual tool for database development, simplifies the following tasks:
• Browsing and managing database objects
• Executing SQL statements and scripts
• Editing and debugging PL/SQL statements
• Creating reports

You can connect to any target Oracle database schema by using standard Oracle database 
authentication. When connected, you can perform operations on objects in the database.

The SQL Developer 1.2 release tightly integrates with Developer Migration Workbench that 
provides users with a single point to browse database objects and data in third-party databases, 
and to migrate from these databases to Oracle. You can also connect to schemas for selected 
third-party (non-Oracle) databases such as MySQL, Microsoft SQL Server, and Microsoft 
Access, and you can view metadata and data in these databases.

Additionally, SQL Developer includes support for Oracle Application Express 3.0.1 (Oracle 
APEX).
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Specifications of SQL Developer

• Shipped along with Oracle Database 11g Release 2

• Developed in Java

• Supports Windows, Linux, and Mac OS X platforms

• Default connectivity by using the Java Database 
Connectivity (JDBC) thin driver

• Connects to Oracle Database version 9.2.0.1 and later

• Freely downloadable from the following link:
– http://www.oracle.com/technology/products/database/sql_de

veloper/index.html

Specifications of SQL Developer

Oracle SQL Developer 1.5 is shipped along with Oracle Database 11g Release 2. SQL 
Developer is developed in Java leveraging the Oracle JDeveloper integrated development 
environment (IDE). Therefore, it is a cross-platform tool. The tool runs on Windows, Linux, and 
Mac operating system (OS) X platforms.

Default connectivity to the database is through the JDBC thin driver, and therefore, no Oracle 
Home is required. SQL Developer does not require an installer and you need to simply unzip the 
downloaded file. With SQL Developer, users can connect to Oracle Databases 9.2.0.1 and later, 
and all Oracle database editions including Express Edition. 

Note
For Oracle Database versions earlier than Oracle Database 11g Release 2, you will have to 
download and install SQL Developer. SQL Developer 1.5 is freely downloadable from the 
following link:

http://www.oracle.com/technology/products/database/sql_developer/index.html.  
For instructions on how to install SQL Developer, you can visit the following link:

http://download.oracle.com/docs/cd/E12151_01/index.htm
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SQL Developer 1.5 Interface

You must define a 
connection to start 

using SQL Developer 
for running SQL queries 
on a database schema. 

SQL Developer 1.5 Interface
The SQL Developer 1.5 interface contains three main navigation tabs, from left to right:

• Connections tab: By using this tab, you can browse database objects and users to which 
you have access.

• Files tab: Identified by the Files folder icon, this tab enables you to access files from your 
local machine without having to use the File > Open menu.

• Reports tab: Identified by the Reports icon, this tab enables you to run predefined reports 
or create and add your own reports.

General Navigation and Use
SQL Developer uses the left side for navigation to find and select objects, and the right side to 
display information about selected objects. You can customize many aspects of the appearance 
and behavior of SQL Developer by setting preferences. 
Note: You need to define at least one connection to be able to connect to a database schema and 
issue SQL queries or run procedures/functions.
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SQL Developer 1.5 Interface (continued)
Menus
The following menus contain standard entries, plus entries for features specific to SQL 
Developer:

• View: Contains options that affect what is displayed in the SQL Developer interface
• Navigate: Contains options for navigating to various panes and for executing 

subprograms
• Run: Contains the Run File and Execution Profile options that are relevant when a 

function or procedure is selected, and also debugging options
• Source: Contains options for use when you edit functions and procedures
• Versioning: Provides integrated support for the following versioning and source control 

systems: Concurrent Versions System (CVS) and Subversion
• Migration: Contains options related to migrating third-party databases to Oracle
• Tools: Invokes SQL Developer tools such as SQL*Plus, Preferences, and SQL 

Worksheet

Note: The Run menu also contains options that are relevant when a function or procedure is 
selected for debugging. These are the same options that are found in the Debug menu in 
version 1.2.

 

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
A

ca
de

m
y 

U
se

 O
nl

y 



Oracle Database: SQL Fundamentals II C - 7

Copyright © 2010, Oracle. All rights reserved.

Creating a Database Connection

• You must have at least one database connection to use 
SQL Developer.

• You can create and test connections for multiple:
– Databases

– Schemas

• SQL Developer automatically imports any connections 
defined in the tnsnames.ora file on your system.

• You can export connections to an Extensible Markup 
Language (XML) file.

• Each additional database connection created is listed in 
the Connections Navigator hierarchy.

Creating a Database Connection

A connection is a SQL Developer object that specifies the necessary information for connecting 
to a specific database as a specific user of that database. To use SQL Developer, you must have 
at least one database connection, which may be existing, created, or imported.

You can create and test connections for multiple databases and for multiple schemas.

By default, the tnsnames.ora file is located in the $ORACLE_HOME/network/admin
directory, but it can also be in the directory specified by the TNS_ADMIN environment variable 
or registry value. When you start SQL Developer and display the Database Connections dialog 
box, SQL Developer automatically imports any connections defined in the tnsnames.ora file 
on your system.

Note: On Windows, if the tnsnames.ora file exists but its connections are not being used by 
SQL Developer, define TNS_ADMIN as a system environment variable.

You can export connections to an XML file so that you can reuse it later.

You can create additional connections as different users to the same database or to connect to the 
different databases.
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Creating a Database Connection

1 2

3

Creating a Database Connection (continued)

To create a database connection, perform the following steps:
1. On the Connections tabbed page, right-click Connections and select New Connection.
2. In the New/Select Database Connection window, enter the connection name. Enter the 

username and password of the schema that you want to connect to.
a) From the Role drop-down box, you can select either default or SYSDBA (you choose 

SYSDBA for the sys user or any user with database administrator privileges). 
b) You can select the connection type as:

- Basic: In this type, enter hostname and SID for the database you want to 
connect to. Port is already set to 1521. Or you can also choose to enter the 
Service name directly if you use a remote database connection.

- TNS: You can select any one of the database aliases imported from the 
tnsnames.ora file.

- LDAP: You can look up database services in Oracle Internet Directory which is 
a component of Oracle Identity Management. 

- Advanced: You can define a custom JDBC URL to connect to the database.
c) Click Test to ensure that the connection has been set correctly.
d) Click Connect.
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Creating a Database Connection (continued)

If you select the Save Password check box, the password is saved to an XML file. So, after 
you close the SQL Developer connection and open it again, you are not prompted for the 
password.

3. The connection gets added in the Connections Navigator. You can expand the connection 
to view the database objects and view object definitions, for example, dependencies, 
details, statistics, and so on.

Note: From the same New/Select Database Connection window, you can define connections to 
non-Oracle data sources using the Access, MySQL, and SQL Server tabs. However, these 
connections are read-only connections that enable you to browse objects and data in that data 
source.
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Browsing Database Objects

Use the Connections Navigator to:

• Browse through many objects in a database schema

• Review the definitions of objects at a glance

Browsing Database Objects

After you create a database connection, you can use the Connections Navigator to browse 
through many objects in a database schema including Tables, Views, Indexes, Packages, 
Procedures, Triggers, and Types.

You can see the definition of the objects broken into tabs of information that is pulled out of the 
data dictionary. For example, if you select a table in the Navigator, the details about columns, 
constraints, grants, statistics, triggers, and so on are displayed on an easy-to-read tabbed page.

If you want to see the definition of the EMPLOYEES table as shown in the slide, perform the 
following steps:

1. Expand the Connections node in the Connections Navigator. 
2. Expand Tables.
3. Click EMPLOYEES. By default, the Columns tab is selected. It shows the column 

description of the table. Using the Data tab, you can view the table data and also enter new 
rows, update data, and commit these changes to the database.
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Displaying the Table Structure

Use the DESCRIBE command to display the structure of a table:

Displaying the Table Structure

In SQL Developer, you can also display the structure of a table using the DESCRIBE command. 
The result of the command is a display of column names and data types as well as an indication 
if a column must contain data.
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Browsing Files

Use the File Navigator to explore the file system and open 
system files.

Browsing Database Objects

You can use the File Navigator to browse and open system files.
• To view the files navigator, click the Files tab, or click View > Files.
• To view the contents of a file, double-click a file name to display its contents in the SQL 

worksheet area.
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Creating a Schema Object

• SQL Developer supports the creation of any schema 
object by:
– Executing a SQL statement in SQL Worksheet

– Using the context menu

• Edit the objects by using an edit dialog box or one of the 
many context-sensitive menus.

• View the data definition language (DDL) for adjustments 
such as creating a new object or editing an existing 
schema object.

Creating a Schema Object

SQL Developer supports the creation of any schema object by executing a SQL statement in 
SQL Worksheet. Alternatively, you can create objects using the context menus. When created, 
you can edit the objects using an edit dialog box or one of the many context-sensitive menus.

As new objects are created or existing objects are edited, the DDL for those adjustments is 
available for review. An Export DDL option is available if you want to create the full DDL for 
one or more objects in the schema.

The slide shows how to create a table using the context menu. To open a dialog box for creating 
a new table, right-click Tables and select New Table. The dialog boxes to create and edit 
database objects have multiple tabs, each reflecting a logical grouping of properties for that type 
of object.
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Creating a New Table: Example 

Creating a New Table: Example

In the Create Table dialog box, if you do not select the Advanced check box, you can create a 
table quickly by specifying columns and some frequently used features.

If you select the Advanced check box, the Create Table dialog box changes to one with multiple 
options, in which you can specify an extended set of features while you create the table.

The example in the slide shows how to create the DEPENDENTS table by selecting the 
Advanced check box. 

To create a new table, perform the following steps:
1. In the Connections Navigator, right-click Tables.
2. Select Create TABLE.
3. In the Create Table dialog box, select Advanced.
4. Specify column information.
5. Click OK.

Although it is not required, you should also specify a primary key by using the Primary Key tab 
in the dialog box. Sometimes, you may want to edit the table that you have created; to do so, 
right-click the table in the Connections Navigator and select Edit. 
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Using the SQL Worksheet

• Use the SQL Worksheet to enter and execute SQL, 
PL/SQL, and SQL *Plus statements.

• Specify any actions that can be processed by the database 
connection associated with the worksheet.

Click the Open SQL 
Worksheet icon.Select SQL 

Worksheet from the 
Tools menu, or

Using the SQL Worksheet

When you connect to a database, a SQL Worksheet window for that connection automatically 
opens. You can use the SQL Worksheet to enter and execute SQL, PL/SQL, and SQL*Plus 
statements. The SQL Worksheet supports SQL*Plus statements to a certain extent. SQL*Plus 
statements that are not supported by the SQL Worksheet are ignored and not passed to the 
database.

You can specify actions that can be processed by the database connection associated with the 
worksheet, such as:

• Creating a table
• Inserting data
• Creating and editing a trigger
• Selecting data from a table
• Saving the selected data to a file

You can display a SQL Worksheet by using one of the following:
• Select Tools > SQL Worksheet.
• Click the Open SQL Worksheet icon.
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Using the SQL Worksheet

1

2

3

4

5

6

7

8

9

Using the SQL Worksheet (continued)

You may want to use the shortcut keys or icons to perform certain tasks such as executing a SQL 
statement, running a script, and viewing the history of SQL statements that you have executed. 
You can use the SQL Worksheet toolbar that contains icons to perform the following tasks:

1. Execute Statement: Executes the statement where the cursor is located in the Enter SQL 
Statement box. You can use bind variables in the SQL statements, but not substitution 
variables.

2. Run Script: Executes all statements in the Enter SQL Statement box by using the Script 
Runner. You can use substitution variables in the SQL statements, but not bind variables.

3. Commit: Writes any changes to the database and ends the transaction
4. Rollback: Discards any changes to the database, without writing them to the database, and 

ends the transaction
5. Cancel: Stops the execution of any statements currently being executed
6. SQL History: Displays a dialog box with information about SQL statements that you have 

executed
7. Execute Explain Plan: Generates the execution plan, which you can see by clicking the

Explain tab
8. Autotrace: Generates trace information for the statement
9. Clear: Erases the statement or statements in the Enter SQL Statement box
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Using the SQL Worksheet

• Use the SQL Worksheet to enter and execute SQL, 
PL/SQL, and SQL*Plus statements.

• Specify any actions that can be processed by the database 
connection associated with the worksheet.

Enter SQL 
statements.

Results are 
shown here.

Using the SQL Worksheet (continued)

When you connect to a database, a SQL Worksheet window for that connection automatically 
opens. You can use the SQL Worksheet to enter and execute SQL, PL/SQL, and SQL*Plus 
statements. All SQL and PL/SQL commands are supported as they are passed directly from the 
SQL Worksheet to the Oracle database. SQL*Plus commands used in the SQL Developer have 
to be interpreted by the SQL Worksheet before being passed to the database. 

The SQL Worksheet currently supports a number of SQL*Plus commands. Commands not 
supported by the SQL Worksheet are ignored and are not sent to the Oracle database. Through 
the SQL Worksheet, you can execute SQL statements and some of the SQL*Plus commands.

You can display a SQL Worksheet by using any of the following two options:
• Select Tools > SQL Worksheet.
• Click the Open SQL Worksheet icon.
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Executing SQL Statements

Use the Enter SQL Statement box to enter single or multiple 
SQL statements.

F9 F5

F9

F5

Executing SQL Statements

The example in the slide shows the difference in output for the same query when the F9 key or 
Execute Statement is used versus the output when F5 or Run Script is used.
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Saving SQL Scripts

Click the Save icon to 
save your SQL 
statement to a file.

The contents of the saved 
file are visible and editable 
in your SQL Worksheet 
window.

Identify a location, 
enter a file name, 
and click Save. 

1

2
3

Saving SQL Scripts

You can save your SQL statements from the SQL Worksheet into a text file. To save the 
contents of the Enter SQL Statement box, follow these steps:

1. Click the Save icon or use the File > Save menu item.
2. In the Windows Save dialog box, enter a file name and the location where you want the 

file saved.
3. Click Save.

After you save the contents to a file, the Enter SQL Statement window displays a tabbed page of 
your file contents. You can have multiple files open at the same time. Each file displays as a 
tabbed page.

Script Pathing

You can select a default path to look for scripts and to save scripts. Under Tools > Preferences > 
Database > Worksheet Parameters, enter a value in the “Select default path to look for scripts”
field.
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1. Use the Files tab to locate the 
script file that you want to open.

2. Double-click the script to display 
the code in the SQL Worksheet.

Executing Saved Script Files: Method 1

To run the code, click either:

• Execute Script (F9), or

• Run Script (F5)

1

3 Select a connection from 
the drop-down list.

2

Executing Saved Script Files: Method 1

To open a script file and display the code in the SQL Worksheet area, perform the following: 
1. In the files navigator select (or navigate to) the script file that you want to open. 
2. Double-click to open. The code of the script file is displayed in the SQL Worksheet area.
3. Select a connection from the connection drop-down list. 
4. To run the code, click the Run Script (F5) icon on the SQL Worksheet toolbar. If you have 

not selected a connection from the connection drop-down list, a connection dialog box will 
appear. Select the connection you want to use for the script execution.

Alternatively, you can also:
1. Select File > Open. The Open dialog box is displayed.
2. In the Open dialog box, select (or navigate to) the script file that you want to open.
3. Click Open. The code of the script file is displayed in the SQL Worksheet area.
4. Select a connection from the connection drop-down list. 
5. To run the code, click the Run Script (F5) icon on the SQL Worksheet toolbar. If you have 

not selected a connection from the connection drop-down list, a connection dialog box will 
appear. Select the connection you want to use for the script execution. 

 

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
A

ca
de

m
y 

U
se

 O
nl

y 



Oracle Database: SQL Fundamentals II C - 21

Copyright © 2010, Oracle. All rights reserved.

Executing Saved Script Files: Method 2

Use the @ command 
followed by the location and 
name of the file you want to 
execute, and click the Run 
Script icon.

The output from the 
script is displayed on 
the Script Output 
tabbed page.

Executing Saved Script Files: Method 2 

To run a saved SQL script, perform the following:
1. Use the @ command, followed by the location, and name of the file you want to run, in the 

Enter SQL Statement window.
2. Click the Run Script icon.

The results from running the file are displayed on the Script Output tabbed page. You can also 
save the script output by clicking the Save icon on the Script Output tabbed page. The Windows 
Save dialog box appears and you can identify a name and location for your file.
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Formatting the SQL Code

Before 
formatting

After 
formatting

Formatting the SQL Code

You may want to beautify the indentation, spacing, capitalization, and line separation of the 
SQL code. SQL Developer has a feature for formatting SQL code.

To format the SQL code, right-click in the statement area and select Format SQL.

In the example in the slide, before formatting, the SQL code has the keywords not capitalized 
and the statement not properly indented. After formatting, the SQL code is beautified with the 
keywords capitalized and the statement properly indented.
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Using Snippets

Snippets are code fragments that may be just syntax or 
examples.

When you place your cursor here, 
it shows the Snippets window. 

From the drop-down list, you can 
select the functions category that 

you want. 

Using Snippets

You may want to use certain code fragments when you use the SQL Worksheet or create or edit 
a PL/SQL function or procedure. SQL Developer has the feature called Snippets. Snippets are 
code fragments such as SQL functions, Optimizer hints, and miscellaneous PL/SQL 
programming techniques. You can drag snippets into the Editor window.

To display Snippets, select View > Snippets.

The Snippets window is displayed at the right side. You can use the drop-down list to select a 
group. A Snippets button is placed in the right window margin, so that you can display the 
Snippets window if it becomes hidden.
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Using Snippets: Example

Inserting a
snippet

Editing the 
snippet

Using Snippets: Example

To insert a Snippet into your code in a SQL Worksheet or in a PL/SQL function or procedure, 
drag the snippet from the Snippets window into the desired place in your code. Then you can 
edit the syntax so that the SQL function is valid in the current context. To see a brief description 
of a SQL function in a tool tip, place the cursor over the function name.

The example in the slide shows that CONCAT(char1, char2)is dragged from the Character 
Functions group in the Snippets window. Then the CONCAT function syntax is edited and the 
rest of the statement is added as in the following:

SELECT CONCAT(first_name, last_name)
FROM employees;
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Debugging Procedures and Functions

• Use SQL Developer to debug 
PL/SQL functions and 
procedures.

• Use the “Compile for Debug” 
option to perform a PL/SQL 
compilation so that the 
procedure can be debugged.

• Use Debug menu options to set 
breakpoints, and to perform step 
into and step over tasks.

Debugging Procedures and Functions

In SQL Developer, you can debug PL/SQL procedures and functions. Using the Debug menu 
options, you can perform the following debugging tasks:

• Find Execution Point goes to the next execution point. 
• Resume continues execution.
• Step Over bypasses the next method and goes to the next statement after the method. 
• Step Into goes to the first statement in the next method. 
• Step Out leaves the current method and goes to the next statement. 
• Step to End of Method goes to the last statement of the current method. 
• Pause halts execution but does not exit, thus allowing you to resume execution. 
• Terminate halts and exits the execution. You cannot resume execution from this point; 

instead, to start running or debugging from the beginning of the function or procedure, 
click the Run or Debug icon on the Source tab toolbar. 

• Garbage Collection removes invalid objects from the cache in favor of more frequently 
accessed and more valid objects.

These options are also available as icons on the debugging toolbar.
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Database Reporting

SQL Developer provides a number of predefined reports about 
the database and its objects.

Database Reporting

SQL Developer provides many reports about the database and its objects. These reports can be 
grouped into the following categories:

• About Your Database reports
• Database Administration reports
• Table reports
• PL/SQL reports
• Security reports
• XML reports
• Jobs reports
• Streams reports
• All Objects reports
• Data Dictionary reports
• User-Defined reports

To display reports, click the Reports tab at the left side of the window. Individual reports are 
displayed in tabbed panes at the right side of the window; and for each report, you can select 
(using a drop-down list) the database connection for which to display the report. For reports 
about objects, the objects shown are only those visible to the database user associated with the 
selected database connection, and the rows are usually ordered by Owner. You can also create 
your own user-defined reports.
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Creating a User-Defined Report

Create and save user-defined reports for repeated use.

Organize reports in folders.

Creating a User-Defined Report

User-defined reports are reports created by SQL Developer users. To create a user-defined 
report, perform the following steps:

1. Right-click the User Defined Reports node under Reports, and select Add Report.
2. In the Create Report Dialog box, specify the report name and the SQL query to retrieve 

information for the report. Then, click Apply.

In the example in the slide, the report name is specified as emp_sal. An optional description is 
provided indicating that the report contains details of employees with salary >= 10000. 
The complete SQL statement for retrieving the information to be displayed in the user-defined 
report is specified in the SQL box. You can also include an optional tool tip to be displayed 
when the cursor stays briefly over the report name in the Reports navigator display.

You can organize user-defined reports in folders, and you can create a hierarchy of folders and 
subfolders. To create a folder for user-defined reports, right-click the User Defined Reports node 
or any folder name under that node and select Add Folder. Information about user-defined 
reports, including any folders for these reports, is stored in a file named UserReports.xml
under the directory for user-specific information.
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Search Engines and External Tools

Links to popular 
search engines and 
discussion forums

Shortcuts to 
frequently used tools

1

2

Search Engines and External Tools

To enhance productivity of the SQL developers, SQL Developer has added quick links to 
popular search engines and discussion forums such as AskTom, Google, and so on. Also, you 
have shortcut icons to some of the frequently used tools such as Notepad, Microsoft Word, and 
Dreamweaver, available to you. 

You can add external tools to the existing list or even delete shortcuts to tools that you do not 
use frequently. To do so, perform the following:

1. From the Tools menu, select External Tools.
2. In the External Tools dialog box, select New to add new tools. Select Delete to remove any 

tool from the list.
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Setting Preferences

• Customize the SQL Developer interface and environment.

• In the Tools menu, select Preferences.

Setting Preferences

You can customize many aspects of the SQL Developer interface and environment by modifying 
SQL Developer preferences according to your preferences and needs. To modify SQL Developer 
preferences, select Tools, then Preferences.

The preferences are grouped into the following categories:
• Environment
• Accelerators (keyboard shortcuts)
• Code Editors
• Database
• Debugger
• Documentation
• Extensions
• File Types
• Migration 
• PL/SQL Compilers
• PL/SQL Debugger, and so on
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Resetting the SQL Developer Layout

Resetting the SQL Developer Layout

While working with SQL Developer, if the Connections Navigator disappears or if you cannot 
dock the Log window in its original place, perform the following steps to fix the problem: 

1. Exit from SQL Developer.
2. Open a terminal window and use the locate command to find the location of

windowinglayout.xml.
3. Go to the directory which has windowinglayout.xml and delete it.
4. Restart SQL Developer. 
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Summary

In this appendix, you should have learned how to use SQL 
Developer to do the following:

• Browse, create, and edit database objects

• Execute SQL statements and scripts in SQL Worksheet

• Create and save custom reports

Summary 

SQL Developer is a free graphical tool to simplify database development tasks. Using SQL 
Developer, you can browse, create, and edit database objects. You can use SQL Worksheet to 
run SQL statements and scripts. SQL Developer enables you to create and save your own special 
set of reports for repeated use.
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Using SQL*Plus 
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Objectives

After completing this appendix, you should be able to do the 
following:

• Log in to SQL*Plus

• Edit SQL commands

• Format the output using SQL*Plus commands

• Interact with script files

Objectives

You might want to create SELECT statements that can be used again and again. This appendix also
covers the use of SQL*Plus commands to execute SQL statements. You learn how to format output 
using SQL*Plus commands, edit SQL commands, and save scripts in SQL*Plus.
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SQL and SQL*Plus Interaction

Buffer

Server

SQL statements

Query results

SQL 
scripts

SQL*Plus

SQL and SQL*Plus 

SQL is a command language used for communication with the Oracle server from any tool or 
application. Oracle SQL contains many extensions. When you enter a SQL statement, it is stored in a 
part of memory called the SQL buffer and remains there until you enter a new SQL statement. 
SQL*Plus is an Oracle tool that recognizes and submits SQL statements to the Oracle9i Server for 
execution. It contains its own command language.

Features of SQL
• Can be used by a range of users, including those with little or no programming

experience
• Is a nonprocedural language
• Reduces the amount of time required for creating and maintaining systems
• Is an English-like language

Features of SQL*Plus 
• Accepts ad hoc entry of statements
• Accepts SQL input from files
• Provides a line editor for modifying SQL statements
• Controls environmental settings
• Formats query results into basic reports
• Accesses local and remote databases
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SQL Statements Versus
SQL*Plus Commands 

SQL

• A language

• ANSI-standard

• Keywords cannot be
abbreviated.

• Statements manipulate 
data
and table definitions in the
database.

SQL
statements

SQL
buffer

SQL*Plus 
commands

SQL*Plus 
buffer

SQL*Plus 

• An environment

• Oracle-proprietary

• Keywords can be 
abbreviated.

• Commands do not 
allow manipulation of 
values in the database.

SQL and SQL*Plus (continued)

The following table compares SQL and SQL*Plus:

SQL SQL*Plus 
Is a language for communicating with the 
Oracle server to access data 

Recognizes SQL statements and sends them 
to the server 

Is based on American National Standards 
Institute (ANSI)–standard SQL 

Is the Oracle-proprietary interface for 
executing SQL statements 

Manipulates data and table definitions in the 
database 

Does not allow manipulation of values in the 
database 

Is entered into the SQL buffer on one or 
more lines 

Is entered one line at a time, not stored in the 
SQL buffer 

Does not have a continuation character Uses a dash (–) as a continuation character if 
the command is longer than one line 

Cannot be abbreviated Can be abbreviated 

Uses a termination character to execute 
commands immediately 

Does not require termination characters; 
executes commands immediately 

Uses functions to perform some formatting Uses commands to format data 
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Overview of SQL*Plus 

• Log in to SQL*Plus.

• Describe the table structure.

• Edit your SQL statement.

• Execute SQL from SQL*Plus.

• Save SQL statements to files and append SQL statements 
to files.

• Execute saved files.

• Load commands from the file to buffer to edit.

SQL*Plus

SQL*Plus is an environment in which you can:
• Execute SQL statements to retrieve, modify, add, and remove data from the database
• Format, perform calculations on, store, and print query results in the form of reports
• Create script files to store SQL statements for repeated use in the future

SQL*Plus commands can be divided into the following main categories:

Category Purpose 

Environment Affect the general behavior of SQL statements for the session. 

Format Format query results. 

File manipulation Save, load, and run script files. 

Execution Send SQL statements from the SQL buffer to the Oracle server. 

Edit Modify SQL statements in the buffer. 

Interaction Create and pass variables to SQL statements, print variable values, and 
print messages to the screen. 

Miscellaneous Connect to the database, manipulate the SQL*Plus environment, and 
display column definitions. 
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sqlplus [username[/password[@database]]]

Logging In to SQL*Plus 

1

2

Logging In to SQL*Plus

How you invoke SQL*Plus depends on which type of operating system you are running Oracle 
Database.

To log in from a Linux environment:
1. Right-click your Linux desktop and select terminal. 
2. Enter the sqlplus command shown in the slide. 
3. Enter the username, password, and database name.

In the syntax:
username Your database username
password Your database password (Your password is visible if you enter it here.)
@database The database connect string

Note: To ensure the integrity of your password, do not enter it at the operating system prompt. 
Instead, enter only your username. Enter your password at the password prompt.
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Displaying the Table Structure

Use the SQL*Plus DESCRIBE command to display the structure 
of a table:

DESC[RIBE] tablename

Displaying the Table Structure

In SQL*Plus, you can display the structure of a table using the DESCRIBE command. The result of 
the command is a display of column names and data types as well as an indication if a column must 
contain data.

In the syntax:

tablename The name of any existing table, view, or synonym that is accessible to   
the user

To describe the DEPARTMENTS table, use this command:
SQL> DESCRIBE DEPARTMENTS
Name                    Null?    Type
----------------------- -------- ---------------

DEPARTMENT_ID           NOT NULL NUMBER(4)
DEPARTMENT_NAME         NOT NULL VARCHAR2(30)
MANAGER_ID              NUMBER(6)
LOCATION_ID             NUMBER(4)
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Displaying the Table Structure

Name                    Null?    Type
----------------------- -------- ------------
DEPARTMENT_ID           NOT NULL NUMBER(4)
DEPARTMENT_NAME         NOT NULL VARCHAR2(30)
MANAGER_ID              NUMBER(6)
LOCATION_ID             NUMBER(4)

DESCRIBE departments

Displaying the Table Structure (continued)

The example in the slide displays the information about the structure of the DEPARTMENTS table. In 
the result:
Null?: Specifies whether a column must contain data (NOT NULL indicates that a column must 

contain data.)
Type: Displays the data type for a column
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SQL*Plus Editing Commands

• A[PPEND] text

• C[HANGE] / old / new

• C[HANGE] / text /

• CL[EAR] BUFF[ER]

• DEL

• DEL n

• DEL m n

SQL*Plus Editing Commands

SQL*Plus commands are entered one line at a time and are not stored in the SQL buffer.

Guidelines
• If you press Enter before completing a command, SQL*Plus prompts you with a line number.
• You terminate the SQL buffer either by entering one of the terminator characters (semicolon or 

slash) or by pressing Enter twice. The SQL prompt then appears.

Command    Description 
A[PPEND] text  Adds text to the end of the current line 
C[HANGE] / old / new
  

Changes old  text to new  in the current line 

C[HANGE] / text /  Deletes text  from the current line 
CL[EAR] BUFF[ER] Deletes all lines from the SQL buffer 
DEL Deletes current line 
DEL n Deletes line n  
DEL m n Deletes lines m  to n  inclusive 
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SQL*Plus Editing Commands

• I[NPUT]

• I[NPUT] text

• L[IST]

• L[IST] n

• L[IST] m n 

• R[UN]

• n

• n text

• 0 text

SQL*Plus Editing Commands (continued)

Note: You can enter only one SQL*Plus command for each SQL prompt. SQL*Plus commands are 
not stored in the buffer. To continue a SQL*Plus command on the next line, end the first line with a 
hyphen (-).

Command  Description 
I[NPUT]    Inserts an indefinite number of lines 
I[NPUT] text Inserts a line consisting of text 
L[IST] Lists all lines in the SQL buffer 
L[IST] n  Lists one line (specified by n) 
L[IST] m n  Lists a range of lines (m to n) inclusive 
R[UN]  Displays and runs the current SQL statement in the buffer 
n Specifies the line to make the current line 
n text  Replaces line n with text 
0 text  Inserts a line before line 1 
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Using LIST, n, and APPEND

LIST
1  SELECT last_name
2* FROM   employees

1
1* SELECT last_name

A , job_id
1* SELECT last_name, job_id

LIST
1  SELECT last_name, job_id
2* FROM   employees

Using LIST, n, and APPEND

• Use the L[IST] command to display the contents of the SQL buffer. The asterisk (*) beside 
line 2 in the buffer indicates that line 2 is the current line. Any edits that you made apply to the 
current line.

• Change the number of the current line by entering the number (n) of the line that you want to 
edit. The new current line is displayed.

• Use the A[PPEND] command to add text to the current line. The newly edited line is displayed. 
Verify the new contents of the buffer by using the LIST command.

Note: Many SQL*Plus commands, including LIST and APPEND, can be abbreviated to just their 
first letter. LIST can be abbreviated to L; APPEND can be abbreviated to A.
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Using the CHANGE Command

LIST
1* SELECT * from employees

c/employees/departments
1* SELECT * from departments

LIST

1* SELECT * from departments

Using the CHANGE Command

• Use L[IST] to display the contents of the buffer.
• Use the C[HANGE] command to alter the contents of the current line in the SQL buffer. In this 

case, replace the employees table with the departments table. The new current line is 
displayed.

• Use the L[IST] command to verify the new contents of the buffer.
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SQL*Plus File Commands

• SAVE filename

• GET filename

• START filename

• @ filename

• EDIT filename

• SPOOL filename

• EXIT

SQL*Plus File Commands

SQL statements communicate with the Oracle server. SQL*Plus commands control the environment, 
format query results, and manage files. You can use the commands described in the following table:

Command Description 

SAV[E] filename [.ext] 
[REP[LACE]APP[END]] 

Saves current contents of SQL buffer to a file. Use APPEND 
to add to an existing file; use REPLACE to overwrite an 
existing file. The default extension is .sql. 

GET filename [.ext] 
  

Writes the contents of a previously saved file to the SQL 
buffer. The default extension for the file name is .sql. 

STA[RT] filename [.ext] Runs a previously saved command file 

@ filename    Runs a previously saved command file (same as START) 

ED[IT]    
 

Invokes the editor and saves the buffer contents to a file 
named afiedt.buf 

ED[IT] [filename[.ext]] Invokes the editor to edit the contents of a saved file 
SPO[OL] [filename[.ext]| 
OFF|OUT]  

Stores query results in a file. OFF closes the spool file. OUT 
closes the spool file and sends the file results to the printer. 

EXIT     Quits SQL*Plus 
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Using the SAVE and START Commands

LIST
1  SELECT last_name, manager_id, department_id
2* FROM employees

SAVE my_query
Created file my_query

START my_query

LAST_NAME                 MANAGER_ID DEPARTMENT_ID
------------------------- ---------- -------------
King                                            90
Kochhar                          100            90
...
107 rows selected.

Using the SAVE and START Commands

SAVE

Use the SAVE command to store the current contents of the buffer in a file. In this way, you can store 
frequently used scripts for use in the future.

START

Use the START command to run a script in SQL*Plus. You can also, alternatively, use the symbol @
to run a script.

@my_query
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SERVEROUTPUT Command

• Use the SET SERVEROUT[PUT] command to control 
whether to display the output of stored procedures or 
PL/SQL blocks in SQL*Plus. 

• The DBMS_OUTPUT line length limit is increased from 255 
bytes to 32767 bytes.

• The default size is now unlimited.
• Resources are not preallocated when SERVEROUTPUT is 

set.
• Because there is no performance penalty, use UNLIMITED

unless you want to conserve physical memory.

SET SERVEROUT[PUT] {ON | OFF} [SIZE {n | UNL[IMITED]}] 
[FOR[MAT] {WRA[PPED] | WOR[D_WRAPPED] | TRU[NCATED]}]

SERVEROUTPUT Command 

Most of the PL/SQL programs perform input and output through SQL statements to store data in 
database tables or query those tables. All other PL/SQL input/output is done through APIs that 
interact with other programs. For example, the DBMS_OUTPUT package has procedures such as 
PUT_LINE. To see the result outside of PL/SQL you require another program, such as SQL*Plus, to 
read and display the data passed to DBMS_OUTPUT.

SQL*Plus does not display DBMS_OUTPUT data unless you first issue the SQL*Plus command SET 
SERVEROUTPUT ON as follows:

SET SERVEROUTPUT ON

Note 
• SIZE sets the number of bytes of the output that can be buffered within the Oracle Database 

server. The default is UNLIMITED. n cannot be less than 2000 or greater than 1,000,000. 
• For additional information about SERVEROUTPUT, see the Oracle Database PL/SQL User’s 

Guide and Reference 11g.
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Using the SQL*Plus SPOOL Command

SPO[OL] [file_name[.ext] [CRE[ATE] | REP[LACE] | 
APP[END]] | OFF | OUT]

Stops spooling and sends the file to your computer’s 
standard (default) printer

OUT

Stops spoolingOFF

Spools output to the specified file namefile_name[.ext]

APP[END]

REP[LACE]

CRE[ATE]

Option

Creates a new file with the name specified

Adds the contents of the buffer to the end of the file 
you specify

Replaces the contents of an existing file. If the file 
does not exist, REPLACE creates the file.

Description

Using the SQL*Plus SPOOL Command

The SPOOL command stores query results in a file or optionally sends the file to a printer. The 
SPOOL command has been enhanced. You can now append to, or replace an existing file, where 
previously you could only use SPOOL to create (and replace) a file. REPLACE is the default. 

To spool output generated by commands in a script without displaying the output on the screen, use 
SET TERMOUT OFF. SET TERMOUT OFF does not affect output from commands that run 
interactively.

You must use quotation marks around file names containing white space. To create a valid HTML 
file using SPOOL APPEND commands, you must use PROMPT or a similar command to create the 
HTML page header and footer. The SPOOL APPEND command does not parse HTML tags. Set 
SQLPLUSCOMPAT[IBILITY] to 9.2 or earlier to disable the CREATE, APPEND, and SAVE
parameters. 
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Using the AUTOTRACE Command

• It displays a report after the successful execution of SQL 
data manipulation statements (DML) statements such as 
SELECT, INSERT, UPDATE, or DELETE.

• The report can now include execution statistics and the 
query execution path.

SET AUTOT[RACE] {ON | OFF | TRACE[ONLY]} [EXP[LAIN]] 
[STAT[ISTICS]]

SET AUTOTRACE ON
-- The AUTOTRACE report includes both the optimizer
-- execution path and the SQL statement execution 
-- statistics

Using the AUTOTRACE Command

EXPLAIN shows the query execution path by performing an EXPLAIN PLAN. STATISTICS
displays SQL statement statistics. The formatting of your AUTOTRACE report may vary depending 
on the version of the server to which you are connected and the configuration of the server. The 
DBMS_XPLAN package provides an easy way to display the output of the EXPLAIN PLAN
command in several predefined formats.

Note 
• For additional information about the package and subprograms, see the Oracle Database 

PL/SQL Packages and Types Reference 11g guide. 
• For additional information about the EXPLAIN PLAN, see Oracle Database SQL Reference 

11g.
• For additional information about Execution Plans and the statistics, see the Oracle Database 

Performance Tuning Guide 11g.
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Summary

In this appendix, you should have learned how to use SQL*Plus  
as an environment to do the following:

• Execute SQL statements

• Edit SQL statements

• Format the output

• Interact with script files

Summary

SQL*Plus is an execution environment that you can use to send SQL commands to the database 
server and to edit and save SQL commands. You can execute commands from the SQL prompt or 
from a script file.
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Using JDeveloper
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Objectives

After completing this appendix, you should be able to do the 
following:

• List the key features of Oracle JDeveloper

• Create a database connection in JDeveloper

• Manage database objects in Jdeveloper

• Use JDeveloper to execute SQL Commands

• Create and run PL/SQL Program Units

Objectives

In this appendix, you are introduced to the tool JDeveloper. You learn how to use JDeveloper for 
your database development tasks. 
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Oracle JDeveloper

Oracle JDeveloper

Oracle JDeveloper is an integrated development environment (IDE) for developing and 
deploying Java applications and Web services. It supports every stage of the software 
development life cycle (SDLC) from modeling to deploying. It has the features to use the latest 
industry standards for Java, XML, and SQL while developing an application. 

Oracle JDeveloper 11g initiates a new approach to J2EE development with features that enable 
visual and declarative development. This innovative approach makes J2EE development simple 
and efficient.
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Database Navigator

Database Navigator

Using Oracle JDeveloper, you can store the information necessary to connect to a database in an 
object called “connection.” A connection is stored as part of the IDE settings, and can be 
exported and imported for easy sharing among groups of users. A connection serves several 
purposes from browsing the database and building applications, all the way through to 
deployment.
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Creating a Connection

Click the New Connection icon in 
the Database Navigator. 

In the Create Database 
Connection window, enter the 

username, password and the SID.  

Test the connection.

Click OK.

1

2

3

4

Creating a Connection

A connection is an object that specifies the necessary information for connecting to a specific 
database as a specific user of that database. You can create and test connections for multiple 
databases and for multiple schemas.

To create a database connection, perform the following steps:
1. Click the New Connection icon in the Database Navigator. 
2. In the Create Database Connection window, enter the connection name. Enter the username 

and password of the schema that you want to connect to. Enter the SID of the database that 
you want to connect to.

3. Click Test to ensure that the connection has been set correctly.
4. Click OK.
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Browsing Database Objects

Use the Database Navigator to:

• Browse through many objects in a database schema

• Review the definitions of objects at a glance

Browsing Database Objects

After you create a database connection, you can use the Database Navigator to browse through 
many objects in a database schema including tables, views, indexes, packages, procedures, 
triggers, and types.

You can object definitions broken into tabs of information that is pulled out of the data 
dictionary. For example, if you select a table in the Navigator, details about columns, 
constraints, grants, statistics, triggers, and so on are displayed on an easy-to-read tabbed page.
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Executing SQL Statements

1

2

3

Executing SQL Statements

To execute a SQL statement, perform the following steps:

1. Click the Open SQL Worksheet icon.

2. Select the connection.

3. Execute the SQL command by clicking:
• The Execute statement button or by pressing F9. The output is as follows: 

• The Run Script button or by pressing F5. The output is as follows: 
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Creating Program Units

Skeleton of the function

1

2

3

Creating Program Units

To create a PL/SQL program unit: 
1. Select View > Database Navigator. Select and expand a database connection. Right-click a 

folder corresponding to the object type (Procedures, Packages, Functions). Select “New 
[Procedures|Packages|Functions]”. 

2. Enter a valid name for the function, package, or procedure, and click OK. 
3. A skeleton definition is created and opened in the Code Editor. You can then edit the 

subprogram to suit your need.
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Compiling

Compilation with errors

Compilation without errors

Compiling

After editing the skeleton definition, you need to compile the program unit. Right-click the 
PL/SQL object that you need to compile in the Connection Navigator, and then select Compile. 
Alternatively, you can press CTRL + SHIFT + F9 to compile.
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Running a Program Unit

Running a Program Unit

To execute the program unit, right-click the object and select Run. The Run PL/SQL dialog box 
appears. You may need to change the NULL values with reasonable values that are passed into 
the program unit. After you change the values, click OK. The output is displayed in the 
Message-Log window.
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Dropping a Program Unit 

1

2

Dropping a Program Unit

To drop a program unit:
1. Right-click the object and select Drop. 

The Drop Confirmation dialog box appears. 
2. Click Apply. 

The object is dropped from the database. 
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Structure Window

Structure Window

The Structure window offers a structural view of the data in the document that is currently 
selected in the active window of those windows that participate in providing structure: the 
navigators, the editors and viewers, and the Property Inspector.

In the Structure window, you can view the document data in a variety of ways. The structures 
that are available for display are based on document type. For a Java file, you can view code 
structure, UI structure, or UI model data. For an XML file, you can view XML structure, design 
structure, or UI model data. 

The Structure window is dynamic, tracking always the current selection of the active window 
(unless you freeze the window’s contents on a particular view), as is pertinent to the currently 
active editor. When the current selection is a node in the navigator, the default editor is assumed. 
To change the view on the structure for the current selection, select a different structure tab.
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Editor Window

Editor Window

You can view your project files all in one single editor window, you can open multiple views of 
the same file, or you can open multiple views of different files. 

The tabs at the top of the editor window are the document tabs. Selecting a document tab gives 
that file focus, bringing it to the foreground of the window in the current editor. 

The tabs at the bottom of the editor window for a given file are the editor tabs. Selecting an 
editor tab opens the file in that editor.
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Application Navigator

Application Navigator

Application Navigator gives you a logical view of your application and the data that it contains. 
Application Navigator provides an infrastructure that the different extensions can plug in to and 
use to organize their data and menus in a consistent, abstract manner. While Application 
Navigator can contain individual files (such as Java source files), it is designed to consolidate 
complex data. Complex data types such as entity objects, Unified Modeling Language (UML) 
diagrams, Enterprise JavaBeans (EJB), or Web services appear in this navigator as single nodes. 
The raw files that make up these abstract nodes appear in the Structure window.
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Deploying Java Stored Procedures

Before deploying Java stored procedures, perform the following 
steps:

1. Create a database connection.

2. Create a deployment profile.

3. Deploy the objects.

1 2 3

Deploying Java Stored Procedures

Create a deployment profile for Java stored procedures, and then deploy the classes and, 
optionally, any public static methods in JDeveloper using the settings in the profile. 

Deploying to the database uses the information provided in the Deployment Profile Wizard and 
two Oracle Database utilities: 
• loadjava loads the Java class containing the stored procedures to an Oracle database.
• publish generates the PL/SQL call–specific wrappers for the loaded public static 

methods. Publishing enables the Java methods to be called as PL/SQL functions or 
procedures.
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Publishing Java to PL/SQL

1

2

Publishing Java to PL/SQL

The slide shows the Java code and illustrates how to publish the Java code in a PL/SQL 
procedure. 
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http://forums.oracle.com/forums/forum.jspa?forumID=83
Oracle JDeveloper 11g 
Discussion Forum 

http://www.oracle.com/technology/products/jdev/index.html
Oracle JDeveloper
Product Page

http://www.oracle.com/technology/obe/obe11jdev/11/index.html
Oracle JDeveloper 11g 
Tutorials

http://www.oracle.com/technology/documentation/jdev.html
Oracle JDeveloper 11g 
Product Documentation

Topic Web site

How Can I Learn More About JDeveloper 11g ? 
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Summary

In this appendix, you should have learned how to use 
JDeveloper to do the following:

• List the key features of Oracle JDeveloper

• Create a database connection in JDeveloper

• Manage database objects in JDeveloper

• Use JDeveloper to execute SQL Commands

• Create and run PL/SQL Program Units

Objectives

In this appendix, you are introduced to the tool JDeveloper. You learn how to use JDeveloper for 
your database development tasks. 
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Generating Reports by Grouping
Related Data
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Objectives

After completing this appendix, you should be able to use the:
• ROLLUP operation to produce subtotal values

• CUBE operation to produce cross-tabulation values

• GROUPING function to identify the row values created by 
ROLLUP or CUBE

• GROUPING SETS to produce a single result set

Objectives

In this appendix, you learn how to:
• Group data to obtain the subtotal values by using the ROLLUP operator
• Group data to obtain the cross-tabulation values by using the CUBE operator
• Use the GROUPING function to identify the level of aggregation in the result set produced 

by a ROLLUP or CUBE operator
• Use GROUPING SETS to produce a single result set that is equivalent to a UNION ALL

approach
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Review of Group Functions

• Group functions operate on sets of rows to give one result 
per group.

• Example:

SELECT [column,] group_function(column). . .
FROM table
[WHERE condition]
[GROUP BY group_by_expression]
[ORDER BY column];

SELECT AVG(salary), STDDEV(salary),
COUNT(commission_pct),MAX(hire_date)

FROM   employees
WHERE  job_id LIKE 'SA%';

Group Functions

You can use the GROUP BY clause to divide the rows in a table into groups. You can then use 
group functions to return summary information for each group. Group functions can appear in 
select lists and in ORDER BY and HAVING clauses. The Oracle server applies the group 
functions to each group of rows and returns a single result row for each group.

Types of group functions: Each of the group functions—AVG, SUM, MAX, MIN, COUNT, 
STDDEV, and VARIANCE—accepts one argument. The AVG, SUM, STDDEV, and VARIANCE
functions operate only on numeric values. MAX and MIN can operate on numeric, character, or 
date data values. COUNT returns the number of non-NULL rows for the given expression. The 
example in the slide calculates the average salary, standard deviation on the salary, number of 
employees earning a commission, and the maximum hire date for those employees whose 
JOB_ID begins with SA.

Guidelines for Using Group Functions
• The data types for the arguments can be CHAR, VARCHAR2, NUMBER, or DATE.
• All group functions except COUNT(*) ignore null values. To substitute a value for null 

values, use the NVL function. COUNT returns either a number or zero.
• The Oracle server implicitly sorts the result set in ascending order of the grouping columns 

specified, when you use a GROUP BY clause. To override this default ordering, you can use 
DESC in an ORDER BY clause.
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Review of the GROUP BY Clause

• Syntax:

• Example:

SELECT   department_id, job_id, SUM(salary), 
COUNT(employee_id)

FROM     employees
GROUP BY department_id, job_id ;

SELECT [column,]
FROM table
[WHERE condition]
[GROUP BY group_by_expression]
[ORDER BY column];

group_function(column). . .

Review of the GROUP BY Clause  

The example illustrated in the slide is evaluated by the Oracle server as follows:
• The SELECT clause specifies that the following columns be retrieved:

- Department ID and job ID columns from the EMPLOYEES table
- The sum of all the salaries and the number of employees in each group that you have 

specified in the GROUP BY clause
• The GROUP BY clause specifies how the rows should be grouped in the table. The total 

salary and the number of employees are calculated for each job ID within each department. 
The rows are grouped by department ID and then grouped by job within each department.
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Review of the HAVING Clause

• Use the HAVING clause to specify which groups are to be 
displayed.

• You further restrict the groups on the basis of a limiting 
condition.

SELECT [column,] group_function(column)... 
FROM table
[WHERE condition]
[GROUP BY group_by_expression]
[HAVING having_expression] 
[ORDER BY column];

HAVING Clause

Groups are formed and group functions are calculated before the HAVING clause is applied to 
the groups. The HAVING clause can precede the GROUP BY clause, but it is recommended that 
you place the GROUP BY clause first because it is more logical.

The Oracle server performs the following steps when you use the HAVING clause:
1. It groups rows.
2. It applies the group functions to the groups and displays the groups that match the criteria 

in the HAVING clause.
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GROUP BY with ROLLUP and
CUBE Operators

• Use ROLLUP or CUBE with GROUP BY to produce 
superaggregate rows by cross-referencing columns.

• ROLLUP grouping produces a result set containing the 
regular grouped rows and the subtotal values.

• CUBE grouping produces a result set containing the rows 
from ROLLUP and cross-tabulation rows.

GROUP BY with the ROLLUP and CUBE Operators

You specify ROLLUP and CUBE operators in the GROUP BY clause of a query. ROLLUP
grouping produces a result set containing the regular grouped rows and subtotal rows. The 
ROLLUP operator also calculates a grand total. The CUBE operation in the GROUP BY clause 
groups the selected rows based on the values of all possible combinations of expressions in the 
specification and returns a single row of summary information for each group. You can use the 
CUBE operator to produce cross-tabulation rows.

Note: When working with ROLLUP and CUBE, make sure that the columns following the 
GROUP BY clause have meaningful, real-life relationships with each other; otherwise, the 
operators return irrelevant information.
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ROLLUP Operator

• ROLLUP is an extension to the GROUP BY clause.

• Use the ROLLUP operation to produce cumulative 
aggregates, such as subtotals.

SELECT [column,] group_function(column). . .
FROM table
[WHERE condition]
[GROUP BY [ROLLUP] group_by_expression]
[HAVING having_expression];
[ORDER BY column];

ROLLUP Operator

The ROLLUP operator delivers aggregates and superaggregates for expressions within a GROUP 
BY statement. The ROLLUP operator can be used by report writers to extract statistics and 
summary information from result sets. The cumulative aggregates can be used in reports, charts, 
and graphs.

The ROLLUP operator creates groupings by moving in one direction, from right to left, along the 
list of columns specified in the GROUP BY clause. It then applies the aggregate function to these 
groupings.

Note
• To produce subtotals in n dimensions (that is, n columns in the GROUP BY clause) without a 
ROLLUP operator, n+1 SELECT statements must be linked with UNION ALL. This makes 
the query execution inefficient because each of the SELECT statements causes table access. 
The ROLLUP operator gathers its results with just one table access. The ROLLUP operator 
is useful when there are many columns involved in producing the subtotals.

• Subtotals and totals are produced with ROLLUP. CUBE produces totals as well but 
effectively rolls up in each possible direction, producing cross-tabular data.
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ROLLUP Operator: Example

SELECT   department_id, job_id, SUM(salary)
FROM     employees  
WHERE    department_id < 60
GROUP BY ROLLUP(department_id, job_id);

3

1

2

Example of a ROLLUP Operator

In the example in the slide:
• Total salaries for every job ID within a department for those departments whose department 

ID is less than 60 are displayed by the GROUP BY clause 
• The ROLLUP operator displays:

- The total salary for each department whose department ID is less than 60 
- The total salary for all departments whose department ID is less than 60, irrespective of 

the job IDs 
In this example, 1 indicates a group totaled by both DEPARTMENT_ID and JOB_ID, 2 
indicates a group totaled only by DEPARTMENT_ID, and 3 indicates the grand total.
The ROLLUP operator creates subtotals that roll up from the most detailed level to a grand total, 
following the grouping list specified in the GROUP BY clause. First, it calculates the standard 
aggregate values for the groups specified in the GROUP BY clause (in the example, the sum of 
salaries grouped on each job within a department). Then it creates progressively higher-level 
subtotals, moving from right to left through the list of grouping columns. (In the example, the 
sum of salaries for each department is calculated, followed by the sum of salaries for all 
departments.)

• Given n expressions in the ROLLUP operator of the GROUP BY clause, the operation results 
in n + 1 (in this case, 2 + 1 = 3) groupings. 

• Rows based on the values of the first n expressions are called rows or regular rows, and the 
others are called superaggregate rows.
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CUBE Operator

• CUBE is an extension to the GROUP BY clause.

• You can use the CUBE operator to produce cross-
tabulation values with a single SELECT statement.

SELECT [column,] group_function(column)...
FROM table
[WHERE condition]
[GROUP BY [CUBE] group_by_expression]
[HAVING having_expression]
[ORDER BY column];

CUBE Operator 

The CUBE operator is an additional switch in the GROUP BY clause in a SELECT statement. The 
CUBE operator can be applied to all aggregate functions, including AVG, SUM, MAX, MIN, and 
COUNT. It is used to produce result sets that are typically used for cross-tabular reports. 
ROLLUP produces only a fraction of possible subtotal combinations, whereas CUBE produces 
subtotals for all possible combinations of groupings specified in the GROUP BY clause, and a 
grand total.

The CUBE operator is used with an aggregate function to generate additional rows in a result set. 
Columns included in the GROUP BY clause are cross-referenced to produce a superset of groups. 
The aggregate function specified in the select list is applied to these groups to produce summary 
values for the additional superaggregate rows. The number of extra groups in the result set is 
determined by the number of columns included in the GROUP BY clause.

In fact, every possible combination of the columns or expressions in the GROUP BY clause is 
used to produce superaggregates. If you have n columns or expressions in the GROUP BY clause, 
there will be 2n possible superaggregate combinations. Mathematically, these combinations form 
an n-dimensional cube, which is how the operator got its name.

By using application or programming tools, these superaggregate values can then be fed into 
charts and graphs that convey results and relationships visually and effectively.
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CUBE Operator: Example

SELECT   department_id, job_id, SUM(salary)
FROM     employees  
WHERE    department_id < 60
GROUP BY CUBE (department_id, job_id) ;

1

2

3

4

Example of a CUBE Operator

The output of the SELECT statement in the example can be interpreted as follows:
• The total salary for every job within a department (for those departments whose department 

ID is less than 60)
• The total salary for each department whose department ID is less than 60
• The total salary for each job irrespective of the department
• The total salary for those departments whose department ID is less than 60, irrespective of 

the job titles

In this example, 1 indicates the grand total, 2 indicates the rows totaled by JOB_ID alone, 3 
indicates some of the rows totaled by DEPARTMENT_ID and JOB_ID, and 4 indicates some of 
the rows totaled by DEPARTMENT_ID alone.

The CUBE operator has also performed the ROLLUP operation to display the subtotals for those 
departments whose department ID is less than 60 and the total salary for those departments 
whose department ID is less than 60, irrespective of the job titles. Further, the CUBE operator 
displays the total salary for every job irrespective of the department.

Note: Similar to the ROLLUP operator, producing subtotals in n dimensions (that is, n columns 
in the GROUP BY clause) without a CUBE operator requires that 2n SELECT statements be 
linked with UNION ALL. Thus, a report with three dimensions requires 23 = 8 SELECT
statements to be linked with UNION ALL.
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GROUPING Function

The GROUPING function: 
• Is used with either the CUBE or ROLLUP operator

• Is used to find the groups forming the subtotal in a row
• Is used to differentiate stored NULL values from NULL

values created by ROLLUP or CUBE
• Returns 0 or 1

SELECT    [column,] group_function(column) .. ,
GROUPING(expr)

FROM table
[WHERE    condition]
[GROUP BY [ROLLUP][CUBE] group_by_expression]
[HAVING   having_expression]
[ORDER BY column];

GROUPING Function
The GROUPING function can be used with either the CUBE or ROLLUP operator to help you 
understand how a summary value has been obtained.
The GROUPING function uses a single column as its argument. The expr in the GROUPING
function must match one of the expressions in the GROUP BY clause. The function returns a 
value of 0 or 1.
The values returned by the GROUPING function are useful to:

• Determine the level of aggregation of a given subtotal (that is, the group or groups on which 
the subtotal is based)

• Identify whether a NULL value in the expression column of a row of the result set indicates:
- A NULL value from the base table (stored NULL value)
- A NULL value created by ROLLUP or CUBE (as a result of a group function on that 

expression)
A value of 0 returned by the GROUPING function based on an expression indicates one of the 
following:

• The expression has been used to calculate the aggregate value.
• The NULL value in the expression column is a stored NULL value.

A value of 1 returned by the GROUPING function based on an expression indicates one of the 
following: 

• The expression has not been used to calculate the aggregate value. 
• The NULL value in the expression column is created by ROLLUP or CUBE as a result of 

grouping.
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GROUPING Function: Example

SELECT   department_id DEPTID, job_id JOB, 
SUM(salary),
GROUPING(department_id) GRP_DEPT,
GROUPING(job_id) GRP_JOB

FROM     employees
WHERE    department_id < 50
GROUP BY ROLLUP(department_id, job_id);

1
2

3

Example of a GROUPING Function 

In the example in the slide, consider the summary value 4400 in the first row (labeled 1). This 
summary value is the total salary for the job ID of AD_ASST within department 10. To calculate 
this summary value, both the DEPARTMENT_ID and JOB_ID columns have been taken into 
account. Thus, a value of 0 is returned for both the GROUPING(department_id)and 
GROUPING(job_id)expressions.

Consider the summary value 4400 in the second row (labeled 2). This value is the total salary for 
department 10 and has been calculated by taking into account the DEPARTMENT_ID column; 
thus, a value of 0 has been returned by GROUPING(department_id). Because the JOB_ID
column has not been taken into account to calculate this value, a value of 1 has been returned for 
GROUPING(job_id). You can observe similar output in the fifth row.

In the last row, consider the summary value 54800 (labeled 3). This is the total salary for those 
departments whose department ID is less than 50 and all job titles. To calculate this summary 
value, neither of the DEPARTMENT_ID and JOB_ID columns have been taken into account. 
Thus, a value of 1 is returned for both the GROUPING(department_id)and 
GROUPING(job_id)expressions.
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GROUPING SETS

• The GROUPING SETS syntax is used to define multiple 
groupings in the same query.

• All groupings specified in the GROUPING SETS clause are 
computed and the results of individual groupings are 
combined with a UNION ALL operation.

• Grouping set efficiency:
– Only one pass over the base table is required.
– There is no need to write complex UNION statements.

– The more elements GROUPING SETS has, the greater is the 
performance benefit.

GROUPING SETS

GROUPING SETS is a further extension of the GROUP BY clause that you can use to specify 
multiple groupings of data. Doing so facilitates efficient aggregation and, therefore, facilitates 
analysis of data across multiple dimensions. 

A single SELECT statement can now be written using GROUPING SETS to specify various 
groupings (which can also include ROLLUP or CUBE operators), rather than multiple SELECT
statements combined by UNION ALL operators. For example:

SELECT department_id, job_id, manager_id, AVG(salary)
FROM employees
GROUP BY 
GROUPING SETS
((department_id, job_id, manager_id),
(department_id, manager_id),(job_id, manager_id));

This statement calculates aggregates over three groupings: 
(department_id, job_id, manager_id), (department_id, 
manager_id)and (job_id, manager_id) 

Without this feature, multiple queries combined together with UNION ALL are required to 
obtain the output of the preceding SELECT statement. A multiquery approach is inefficient 
because it requires multiple scans of the same data.

 

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
A

ca
de

m
y 

U
se

 O
nl

y 



Oracle Database: SQL Fundamentals II   F - 14

GROUPING SETS (continued)

Compare the previous example with the following alternative:
SELECT department_id, job_id, manager_id, AVG(salary)
FROM employees
GROUP BY CUBE(department_id, job_id, manager_id);

This statement computes all the 8 (2 *2 *2) groupings, though only the(department_id, 
job_id, manager_id), (department_id, manager_id), and (job_id, 
manager_id) groups are of interest to you.

Another alternative is the following statement:
SELECT department_id, job_id, manager_id, AVG(salary)
FROM employees
GROUP BY department_id, job_id, manager_id 
UNION ALL
SELECT department_id, NULL, manager_id, AVG(salary)
FROM employees
GROUP BY department_id, manager_id
UNION ALL
SELECT NULL, job_id, manager_id, AVG(salary)
FROM employees
GROUP BY job_id, manager_id;

This statement requires three scans of the base table, which makes it inefficient. 

CUBE and ROLLUP can be thought of as grouping sets with very specific semantics and results. 
The following equivalencies show this fact:

GROUPING SETS ((a, b, c), (a, b),(a), ())ROLLUP(a, b,c) 

is equivalent to 

GROUPING SETS 
((a, b, c), (a, b), (a, c), (b, c), 
(a), (b), (c), ())

CUBE(a, b, c)
is equivalent to
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GROUPING SETS: Example

SELECT   department_id, job_id, 
manager_id,AVG(salary)

FROM     employees
GROUP BY GROUPING SETS 
((department_id,job_id), (job_id,manager_id));

…
1

…

2

GROUPING SETS: Example

The query in the slide calculates aggregates over two groupings. The table is divided into the 
following groups:

• Department ID, Job ID
• Job ID, Manager ID

The average salaries for each of these groups are calculated. The result set displays the average 
salary for each of the two groups.

In the output, the group marked as 1 can be interpreted as the following:
• The average salary of all employees with the SH_CLERK job ID under manager 122 is 

3,200.
• The average salary of all employees with the AC_MGR job ID under manager 101 is 12,000, 

and so on.

The group marked as 2 in the output is interpreted as the following:
• The average salary of all employees with the AC_MGR job ID in department 110 is 12,000.
• The average salary of all employees with the AD_PRES job ID in department 90 is 24,000, 

and so on.
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GROUPING SETS: Example (continued)

The example in the slide can also be written as:
SELECT department_id, job_id, NULL as manager_id, 

AVG(salary) as AVGSAL
FROM employees
GROUP BY department_id, job_id
UNION ALL
SELECT NULL, job_id, manager_id, avg(salary) as AVGSAL
FROM employees
GROUP BY job_id, manager_id;

In the absence of an optimizer that looks across query blocks to generate the execution plan, the 
preceding query would need two scans of the base table, EMPLOYEES. This could be very 
inefficient. Therefore, the usage of the GROUPING SETS statement is recommended.
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Composite Columns

• A composite column is a collection of columns that are 
treated as a unit.
ROLLUP (a, , d)

• Use parentheses within the GROUP BY clause to group 
columns, so that they are treated as a unit while computing 
ROLLUP or CUBE operations.

• When used with ROLLUP or CUBE, composite columns 
would require skipping aggregation across certain levels.

(b, c)

Composite Columns

A composite column is a collection of columns that are treated as a unit during the computation 
of groupings. You specify the columns in parentheses as in the following statement: ROLLUP 
(a, (b, c), d) 

Here, (b, c) forms a composite column and is treated as a unit. In general, composite 
columns are useful in ROLLUP, CUBE, and GROUPING SETS. For example, in CUBE or 
ROLLUP, composite columns would require skipping aggregation across certain levels.

That is, GROUP BY ROLLUP(a, (b, c) )is equivalent to: 
GROUP BY a, b, c UNION ALL
GROUP BY a UNION ALL
GROUP BY ()

Here, (b, c) is treated as a unit and ROLLUP is not applied across (b, c). It is as though 
you have an alias—for example, z as an alias for (b, c), and the GROUP BY expression 
reduces to:  GROUP BY ROLLUP(a, z).

Note: GROUP BY( ) is typically a SELECT statement with NULL values for the columns a and 
b and only the aggregate function. It is generally used for generating grand totals.

SELECT   NULL, NULL, aggregate_col
FROM     <table_name>
GROUP BY ( );
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Composite Columns (continued)

Compare this with the normal ROLLUP as in:
GROUP BY ROLLUP(a, b, c)

This would be:
GROUP BY a, b, c UNION ALL
GROUP BY a, b UNION ALL
GROUP BY a UNION ALL
GROUP BY ()

Similarly:
GROUP BY CUBE((a, b), c) 

This would be equivalent to:
GROUP BY a, b, c UNION ALL
GROUP BY a, b UNION ALL
GROUP BY c UNION ALL
GROUP By ()

The following table shows the GROUPING SETS specification and the equivalent GROUP BY 
specification.

GROUP BY a UNION ALL
GROUP BY b UNION ALL
GROUP BY ()

GROUP BY GROUPING SETS(a, (b), ()) 

GROUP BY a UNION ALL
GROUP BY ROLLUP(b, c)

GROUP BY GROUPING SETS 
(a,ROLLUP(b, c))
(The GROUPING SETS expression has a composite 
column.)

GROUP BY a, b, cGROUP BY GROUPING SETS((a, b, c))

GROUP BY a UNION ALL
GROUP BY b UNION ALL
GROUP BY b, c

GROUP BY GROUPING SETS(a, b,(b, c))
(The GROUPING SETS expression has a composite 
column.)

GROUP BY a UNION ALL
GROUP BY b UNION ALL
GROUP BY c

GROUP BY GROUPING SETS(a, b, c)

Equivalent GROUP BY StatementsGROUPING SETS Statements
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Composite Columns: Example

SELECT   department_id, job_id, manager_id, 
SUM(salary)

FROM     employees  
GROUP BY ROLLUP( department_id,(job_id, manager_id));

…

3

4

1

2

Composite Columns: Example

Consider the example: 
SELECT department_id, job_id,manager_id, SUM(salary)
FROM   employees  
GROUP BY ROLLUP( department_id,job_id, manager_id);

This query results in the Oracle server computing the following groupings:
• (job_id, manager_id)
• (department_id, job_id, manager_id)
• (department_id)
• Grand total

If you are interested only in specific groups, you cannot limit the calculation to those groupings 
without using composite columns. With composite columns, this is possible by treating JOB_ID
and MANAGER_ID columns as a single unit while rolling up. Columns enclosed in parentheses 
are treated as a unit while computing ROLLUP and CUBE. This is illustrated in the example in 
the slide. By enclosing the JOB_ID and MANAGER_ID columns in parentheses, you indicate to 
the Oracle server to treat JOB_ID and MANAGER_ID as a single unit—that is, a composite 
column.
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Composite Columns: Example (continued)

The example in the slide computes the following groupings:
• (department_id, job_id, manager_id)
• (department_id)
• ( )

The example in the slide displays the following:
• Total salary for every job and manager (labeled 1)
• Total salary for every department, job, and manager (labeled 2)
• Total salary for every department (labeled 3)
• Grand total (labeled 4)

The example in the slide can also be written as:
SELECTdepartment_id, job_id, manager_id, SUM(salary)
FROM  employees  
GROUP  BY department_id,job_id, manager_id
UNION  ALL
SELECT department_id, TO_CHAR(NULL),TO_NUMBER(NULL), 
SUM(salary)
FROM   employees  
GROUP BY department_id
UNION ALL
SELECT  TO_NUMBER(NULL), TO_CHAR(NULL),TO_NUMBER(NULL), 
SUM(salary)
FROM    employees  
GROUP BY ();

In the absence of an optimizer that looks across query blocks to generate the execution plan, the 
preceding query would need three scans of the base table, EMPLOYEES. This could be very 
inefficient. Therefore, the use of composite columns is recommended.
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Concatenated Groupings

• Concatenated groupings offer a concise way to generate 
useful combinations of groupings.

• To specify concatenated grouping sets, you separate 
multiple grouping sets, ROLLUP and CUBE operations with 
commas so that the Oracle server combines them into a 
single GROUP BY clause.

• The result is a cross-product of groupings from each 
GROUPING SET.

GROUP BY GROUPING SETS(a, b), GROUPING SETS(c, d)

Concatenated Groupings

Concatenated groupings offer a concise way to generate useful combinations of groupings. The 
concatenated groupings are specified by listing multiple grouping sets, CUBEs, and ROLLUPs, 
and separating them with commas. The following is an example of concatenated grouping sets:
GROUP BY GROUPING SETS(a, b), GROUPING SETS(c, d)

This SQL example defines the following groupings:

(a, c), (a, d), (b, c), (b, d)

Concatenation of grouping sets is very helpful for these reasons:
• Ease of query development: You need not manually enumerate all groupings.
• Use by applications: SQL generated by online analytical processing (OLAP) applications 

often involves concatenation of grouping sets, with each GROUPING SET defining 
groupings needed for a dimension.
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Concatenated Groupings: Example

SELECT   department_id, job_id, manager_id, 
SUM(salary)

FROM     employees
GROUP BY department_id,

ROLLUP(job_id),
CUBE(manager_id);

…

…

…

1

2 3

Concatenated Groupings: Example

The example in the slide results in the following groupings:
• (department_id,job_id,) (1)
• (department_id,manager_id) (2)
• (department_id) (3)

The total salary for each of these groups is calculated.

The following is another example of a concatenated grouping.
SELECT department_id, job_id, manager_id, SUM(salary) totsal
FROM employees
WHERE department_id<60
GROUP BY GROUPING SETS(department_id), 
GROUPING SETS (job_id, manager_id);
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Summary

In this appendix, you should have learned how to use the:
• ROLLUP operation to produce subtotal values

• CUBE operation to produce cross-tabulation values

• GROUPING function to identify the row values created by 
ROLLUP or CUBE

• GROUPING SETS syntax to define multiple groupings in the 
same query

• GROUP BY clause to combine expressions in various ways:

– Composite columns

– Concatenated grouping sets

Summary

• ROLLUP and CUBE are extensions of the GROUP BY clause.
• ROLLUP is used to display subtotal and grand total values.
• CUBE is used to display cross-tabulation values.
• The GROUPING function enables you to determine whether a row is an aggregate produced 

by a CUBE or ROLLUP operator.
• With the GROUPING SETS syntax, you can define multiple groupings in the same query. 
GROUP BY computes all the groupings specified and combines them with UNION ALL.

• Within the GROUP BY clause, you can combine expressions in various ways:
- To specify composite columns, you group columns within parentheses so that the 

Oracle server treats them as a unit while computing ROLLUP or CUBE operations.
- To specify concatenated grouping sets, you separate multiple grouping sets, ROLLUP, 

and CUBE operations with commas so that the Oracle server combines them into a 
single GROUP BY clause. The result is a cross-product of groupings from each 
grouping set.
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Hierarchical Retrieval
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Objectives

After completing this appendix, you should be able to do the 
following:

• Interpret the concept of a hierarchical query

• Create a tree-structured report

• Format hierarchical data

• Exclude branches from the tree structure

Objectives

In this appendix, you learn how to use hierarchical queries to create tree-structured reports.

 

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
A

ca
de

m
y 

U
se

 O
nl

y 



Oracle Database: SQL Fundamentals II   G - 3

Copyright © 2010, Oracle. All rights reserved.

Sample Data from the EMPLOYEES Table

…

Sample Data from the EMPLOYEES Table

Using hierarchical queries, you can retrieve data based on a natural hierarchical relationship 
between the rows in a table. A relational database does not store records in a hierarchical way. 
However, where a hierarchical relationship exists between the rows of a single table, a process 
called tree walking enables the hierarchy to be constructed. A hierarchical query is a method of 
reporting, with the branches of a tree in a specific order.

Imagine a family tree with the eldest members of the family found close to the base or trunk of 
the tree and the youngest members representing branches of the tree. Branches can have their 
own branches, and so on.

A hierarchical query is possible when a relationship exists between rows in a table. For example, 
in the slide, you see that Kochhar, De Haan, and Hartstein report to MANAGER_ID 100, which is 
King’s EMPLOYEE_ID.

Note: Hierarchical trees are used in various fields such as human genealogy (family trees), 
livestock (breeding purposes), corporate management (management hierarchies), manufacturing 
(product assembly), evolutionary research (species development), and scientific research.
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Natural Tree Structure

De Haan

King

Hunold

EMPLOYEE_ID = 100 (Parent)

MANAGER_ID = 100 (Child)

Whalen

Kochhar

Higgins

Mourgos Zlotkey

Rajs Davies Matos

Gietz Ernst Lorentz

Hartstein

Fay 

Abel Taylor Grant

Vargas

Natural Tree Structure

The EMPLOYEES table has a tree structure representing the management reporting line. The 
hierarchy can be created by looking at the relationship between equivalent values in the 
EMPLOYEE_ID and MANAGER_ID columns. This relationship can be exploited by joining the 
table to itself. The MANAGER_ID column contains the employee number of the employee’s 
manager.

The parent-child relationship of a tree structure enables you to control:
• The direction in which the hierarchy is walked
• The starting point inside the hierarchy

Note: The slide displays an inverted tree structure of the management hierarchy of the 
employees in the EMPLOYEES table.
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Hierarchical Queries

condition:

expr comparison_operator expr

SELECT [LEVEL], column, expr...
FROM   table
[WHERE condition(s)]
[START WITH condition(s)]
[CONNECT BY PRIOR condition(s)] ;

Keywords and Clauses

Hierarchical queries can be identified by the presence of the CONNECT BY and START WITH
clauses.

In the syntax:
SELECT Is the standard SELECT clause
LEVEL For each row returned by a hierarchical query, the LEVEL

pseudocolumn returns 1 for a root row, 2 for a child of a root, and so on.
FROM table Specifies the table, view, or snapshot containing the columns. You can

select from only one table.
WHERE Restricts the rows returned by the query without affecting other rows of

the hierarchy
condition Is a comparison with expressions
START WITH Specifies the root rows of the hierarchy (where to start). This clause is

required for a true hierarchical query.
CONNECT BY Specifies the columns in which the relationship between parent and

child PRIOR rows exist. This clause is required for a hierarchical query.
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Walking the Tree

• Specifies the condition that must be met

• Accepts any valid condition

Using the EMPLOYEES table, start with the employee whose last 
name is Kochhar.

Starting Point

...START WITH last_name = 'Kochhar'

START WITH column1 = value

Walking the Tree

The row or rows to be used as the root of the tree are determined by the START WITH clause. 
The START WITH clause can contain any valid condition.

Examples

Using the EMPLOYEES table, start with King, the president of the company.
... START WITH manager_id IS NULL

Using the EMPLOYEES table, start with employee Kochhar. A START WITH condition can 
contain a subquery.

... START WITH employee_id = (SELECT employee_id
FROM   employees
WHERE  last_name = 'Kochhar')

If the START WITH clause is omitted, the tree walk is started with all the rows in the table as 
root rows. 

Note: The CONNECT BY and START WITH clauses are not American National Standards 
Institute (ANSI) SQL standard.
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Walking the Tree

Walk from the top down, using the EMPLOYEES table.

Direction

Top down  Column1 = Parent Key
Column2 = Child Key

Bottom up Column1 = Child Key
Column2 = Parent Key

CONNECT BY PRIOR column1 = column2

... CONNECT BY PRIOR employee_id = manager_id

Walking the Tree (continued)

The direction of the query is determined by the CONNECT BY PRIOR column placement. For 
top-down, the PRIOR operator refers to the parent row. For bottom-up, the PRIOR operator 
refers to the child row. To find the child rows of a parent row, the Oracle server evaluates the 
PRIOR expression for the parent row and the other expressions for each row in the table. Rows 
for which the condition is true are the child rows of the parent. The Oracle server always selects 
child rows by evaluating the CONNECT BY condition with respect to a current parent row.

Examples

Walk from the top down using the EMPLOYEES table. Define a hierarchical relationship in 
which the EMPLOYEE_ID value of the parent row is equal to the MANAGER_ID value of the 
child row:

... CONNECT BY PRIOR employee_id = manager_id
Walk from the bottom up using the EMPLOYEES table:

... CONNECT BY PRIOR manager_id = employee_id
The PRIOR operator does not necessarily need to be coded immediately following CONNECT
BY. Thus, the following CONNECT BY PRIOR clause gives the same result as the one in the 
preceding example:

... CONNECT BY employee_id = PRIOR manager_id

Note: The CONNECT BY clause cannot contain a subquery.
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Walking the Tree: From the Bottom Up

SELECT employee_id, last_name, job_id, manager_id
FROM   employees
START  WITH  employee_id = 101
CONNECT BY PRIOR manager_id = employee_id ;

Walking the Tree: From the Bottom Up 

The example in the slide displays a list of managers starting with the employee whose employee 
ID is 101.
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Walking the Tree: From the Top Down

SELECT  last_name||' reports to '|| 
PRIOR   last_name "Walk Top Down"
FROM    employees

START   WITH last_name = 'King'
CONNECT BY PRIOR employee_id = manager_id ;

…

Walking the Tree: From the Top Down

Walking from the top down, display the names of the employees and their manager. Use 
employee King as the starting point. Print only one column.

Example

In the following example, EMPLOYEE_ID values are evaluated for the parent row and 
MANAGER_ID and SALARY values are evaluated for the child rows. The PRIOR operator 
applies only to the EMPLOYEE_ID value.

... CONNECT BY PRIOR employee_id = manager_id
AND salary > 15000;

To qualify as a child row, a row must have a MANAGER_ID value equal to the EMPLOYEE_ID
value of the parent row and must have a SALARY value greater than $15,000.
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Ranking Rows with the LEVEL Pseudocolumn

Level 1
root/

parent

Level 3
parent/

child/leaf

Level 4
leaf

De Haan

King

HunoldWhalen

Kochhar

Higgins

Mourgos Zlotkey

Rajs Davies Matos

Gietz Ernst Lorentz

Hartstein

Fay 

Abel Taylor Grant

Vargas

Level 2
parent/

child/leaf

Ranking Rows with the LEVEL Pseudocolumn

You can explicitly show the rank or level of a row in the hierarchy by using the LEVEL
pseudocolumn. This will make your report more readable. The forks where one or more 
branches split away from a larger branch are called nodes, and the very end of a branch is called 
a leaf or leaf node. The graphic in the slide shows the nodes of the inverted tree with their 
LEVEL values. For example, employee Higgens is a parent and a child, whereas employee 
Davies is a child and a leaf.

LEVEL Pseudocolumn

In the slide, King is the root or parent (LEVEL = 1). Kochhar, De Haan, Mourgos, Zlotkey, 
Hartstein, Higgens, and Hunold are children and also parents (LEVEL = 2). Whalen, Rajs, 
Davies, Matos, Vargas, Gietz, Ernst, Lorentz, Abel, Taylor, Grant, and Fay are children and 
leaves (LEVEL = 3 and LEVEL = 4). 

Note: A root node is the highest node within an inverted tree. A child node is any nonroot node. 
A parent node is any node that has children. A leaf node is any node without children. The 
number of levels returned by a hierarchical query may be limited by available user memory.

Value Level for Top Down Level for Bottom up 
1 A root node A root node 
2 A child of a root node The parent of a root node 
3 A child of a child, and so on A parent of a parent, and so on 
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Formatting Hierarchical Reports Using 
LEVEL and LPAD

Create a report displaying company management levels, 
beginning with the highest level and indenting each of the 
following levels.

COLUMN org_chart FORMAT A12

SELECT LPAD(last_name, LENGTH(last_name)+(LEVEL*2)-2,'_') 

AS org_chart
FROM   employees 
START WITH first_name='Steven' AND last_name='King' 
CONNECT BY PRIOR employee_id=manager_id 

Formatting Hierarchical Reports Using LEVEL and LPAD

The nodes in a tree are assigned level numbers from the root. Use the LPAD function in 
conjunction with the LEVEL pseudocolumn to display a hierarchical report as an indented tree.

In the example in the slide:
• LPAD(char1,n [,char2]) returns char1, left-padded to length n with the sequence 

of characters in char2. The argument n is the total length of the return value as it is 
displayed on your terminal screen.

• LPAD(last_name, LENGTH(last_name)+(LEVEL*2)-2,'_')defines the 
display format

• char1 is the LAST_NAME, n the total length of the return value, is length of the 
LAST_NAME +(LEVEL*2)-2, and char2 is '_'

That is, this tells SQL to take the LAST_NAME and left-pad it with the '_' character until the 
length of the resultant string is equal to the value determined by 
LENGTH(last_name)+(LEVEL*2)-2.
For King, LEVEL = 1. Therefore, (2 * 1) – 2 = 2 – 2 = 0. So King does not get padded with 
any '_' character and is displayed in column 1.
For Kochhar, LEVEL = 2. Therefore, (2 * 2) – 2 = 4 – 2 = 2. So Kochhar gets padded with 2 
'_' characters and is displayed indented.
The rest of the records in the EMPLOYEES table are displayed similarly.
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Formatting Hierarchical Reports Using LEVEL and LPAD (continued)
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Pruning Branches

Use the WHERE clause 
to eliminate a node.

Use the CONNECTBY clause
to eliminate a branch.

WHERE last_name != 'Higgins'CONNECT BY PRIOR 
employee_id = manager_id 
AND last_name != 'Higgins'

Kochhar

Higgins

Gietz

Whalen

Kochhar

HigginsWhalen

Gietz

Pruning Branches

You can use the WHERE and CONNECT BY clauses to prune the tree (that is, to control which 
nodes or rows are displayed). The predicate you use acts as a Boolean condition.

Examples

Starting at the root, walk from the top down, and eliminate employee Higgins in the result, but 
process the child rows.

SELECT  department_id, employee_id,last_name, job_id, salary
FROM    employees
WHERE   last_name  != 'Higgins'
START   WITH manager_id IS NULL
CONNECT BY PRIOR employee_id = manager_id;

Starting at the root, walk from the top down, and eliminate employee Higgins and all child rows.
SELECT  department_id, employee_id,last_name, job_id, salary
FROM    employees
START   WITH manager_id IS NULL
CONNECT BY PRIOR employee_id = manager_id
AND     last_name != 'Higgins';
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Summary

In this appendix, you should have learned that you can:

• Use hierarchical queries to view a hierarchical relationship 
between rows in a table

• Specify the direction and starting point of the query

• Eliminate nodes or branches by pruning

Summary

You can use hierarchical queries to retrieve data based on a natural hierarchical relationship 
between rows in a table. The LEVEL pseudocolumn counts how far down a hierarchical tree you 
have traveled. You can specify the direction of the query using the CONNECT BY PRIOR clause. 
You can specify the starting point using the START WITH clause. You can use the WHERE and 
CONNECT BY clauses to prune the tree branches.
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Writing Advanced Scripts
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Objectives

After completing this appendix, you should be able to do the 
following:

• Describe the type of problems that are solved by using 
SQL to generate SQL

• Write a script that generates a script of DROP TABLE
statements

• Write a script that generates a script of INSERT INTO
statements

Objectives

In this appendix, you learn how to write a SQL script to generate a SQL script.
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Using SQL to Generate SQL

• SQL can be used to generate scripts in SQL.

• The data dictionary is:
– A collection of tables and views that contain database 

information

– Created and maintained by the Oracle server

SQL script

SQL Data dictionary

Using SQL to Generate SQL

SQL can be a powerful tool to generate other SQL statements. In most cases, this involves 
writing a script file. You can use SQL from SQL to:

• Avoid repetitive coding
• Access information from the data dictionary
• Drop or re-create database objects
• Generate dynamic predicates that contain run-time parameters

The examples used in this appendix involve selecting information from the data dictionary. The 
data dictionary is a collection of tables and views that contain information about the database. 
This collection is created and maintained by the Oracle server. All data dictionary tables are 
owned by the SYS user. Information stored in the data dictionary includes names of Oracle 
server users, privileges granted to users, database object names, table constraints, and audit 
information. There are four categories of data dictionary views. Each category has a distinct 
prefix that reflects its intended use.

Prefix Description 

USER_ Contains details of objects owned by the user 

ALL_ Contains details of objects to which the user has been granted access rights, in addition to 
objects owned by the user 

DBA_ Contains details of users with DBA privileges to access any object in the database 

V$_ Stores information about database server performance and locking; available only to the DBA 
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Creating a Basic Script

SELECT 'CREATE TABLE ' || table_name || 
'_test ' || 'AS SELECT * FROM ' 
|| table_name ||' WHERE 1=2;' 
AS "Create Table Script"

FROM   user_tables; 

A Basic Script

The example in the slide produces a report with CREATE TABLE statements from every table 
you own. Each CREATE TABLE statement produced in the report includes the syntax to create a 
table using the table name with a suffix of _test and having only the structure of the 
corresponding existing table. The old table name is obtained from the TABLE_NAME column of 
the data dictionary view USER_TABLES.

The next step is to enhance the report to automate the process. 

Note: You can query the data dictionary tables to view various database objects that you own. 
The data dictionary views frequently used include:
• USER_TABLES: Displays description of the user’s own tables
• USER_OBJECTS: Displays all the objects owned by the user
• USER_TAB_PRIVS_MADE: Displays all grants on objects owned by the user
• USER_COL_PRIVS_MADE: Displays all grants on columns of objects owned by the user
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Controlling the Environment

Set system variables 
to appropriate values.

Set system variables 
back to the default 
value.

SQL statement

SET ECHO OFF
SET FEEDBACK OFF
SET PAGESIZE 0

SET FEEDBACK ON
SET PAGESIZE 24
SET ECHO ON

Controlling the Environment

To execute the SQL statements that are generated, you must capture them in a file that can then 
be run. You must also plan to clean up the output that is generated and make sure that you 
suppress elements such as headings, feedback messages, top titles, and so on. In SQL Developer, 
you can save these statements to a script. To save the contents of the Enter SQL Statement box, 
click the Save icon or use the File > Save menu item. Alternatively, you can right-click in the 
Enter SQL Statement box and select the Save File option from the drop-down menu. 

Note: Some of the SQL*Plus statements are not supported by SQL Worksheet. For the complete 
list of SQL*Plus statements that are supported, and not supported by SQL Worksheet, refer to 
the topic titled SQL*Plus Statements Supported and Not Supported in SQL Worksheet in the 
SQL Developer online Help.
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The Complete Picture

SET ECHO OFF              
SET FEEDBACK OFF
SET PAGESIZE 0

SELECT 'DROP TABLE ' || object_name || ';'
FROM    user_objects
WHERE   object_type = 'TABLE'
/

SET FEEDBACK ON
SET PAGESIZE 24
SET ECHO ON

The Complete Picture

The output of the command in the slide is saved into a file called dropem.sql in SQL 
Developer. To save the output into a file in SQL Developer, you use the Save File option under 
the Script Output pane. The dropem.sql file contains the following data. This file can now be 
started from SQL Developer by locating the script file, loading it, and executing it.
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Dumping the Contents of a Table to a File

SET HEADING OFF ECHO OFF FEEDBACK OFF
SET PAGESIZE 0

SELECT
'INSERT INTO departments_test VALUES
(' || department_id || ', ''' || department_name ||
''', ''' || location_id || ''');'
AS "Insert Statements Script"

FROM   departments
/

SET PAGESIZE 24
SET HEADING ON ECHO ON FEEDBACK ON

Dumping Table Contents to a File

Sometimes, it is useful to have the values for the rows of a table in a text file in the format of an 
INSERT INTO VALUES statement. This script can be run to populate the table in case the table 
has been dropped accidentally. 

The example in the slide produces INSERT statements for the DEPARTMENTS_TEST table, 
captured in the data.sql file using the Save File option in SQL Developer.

The contents of the data.sql script file are as follows:
INSERT INTO departments_test VALUES

(10, 'Administration', 1700);
INSERT INTO departments_test VALUES

(20, 'Marketing', 1800);
INSERT INTO departments_test VALUES

(50, 'Shipping', 1500);
INSERT INTO departments_test VALUES

(60, 'IT', 1400);
...
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Dumping the Contents of a Table to a File

'X'

'

'Administration'

','

');

'''X'''

''''

''''||department_name||''''

''', '''

''');'

ResultSource

Dumping Table Contents to a File (continued)

You may have noticed the large number of single quotation marks in the previous slide. A set of 
four single quotation marks produces one single quotation mark in the final statement. Also 
remember that character and date values must be enclosed within quotation marks.

Within a string, to display one quotation mark, you need to prefix it with another single 
quotation mark. For example, in the fifth example in the slide, the surrounding quotation marks 
are for the entire string. The second quotation mark acts as a prefix to display the third quotation 
mark. Thus, the result is a single quotation mark followed by the parenthesis, followed by the 
semicolon.
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Generating a Dynamic Predicate

COLUMN my_col NEW_VALUE dyn_where_clause

SELECT DECODE('&&deptno', null,
DECODE ('&&hiredate', null, ' ',
'WHERE hire_date=TO_DATE('''||'&&hiredate'',''DD-MON-YYYY'')'),
DECODE ('&&hiredate', null,
'WHERE department_id = ' || '&&deptno',
'WHERE department_id = ' || '&&deptno' ||
' AND hire_date = TO_DATE('''||'&&hiredate'',''DD-MON-YYYY'')')) 
AS my_col FROM dual;

SELECT last_name FROM employees &dyn_where_clause;

Generating a Dynamic Predicate

The example in the slide generates a SELECT statement that retrieves data of all employees in a 
department who were hired on a specific day. The script generates the WHERE clause 
dynamically.

Note: After the user variable is in place, you must use the UNDEFINE command to delete it.

The first SELECT statement prompts you to enter the department number. If you do not enter 
any department number, the department number is treated as null by the DECODE function, and 
the user is then prompted for the hire date. If you do not enter any hire date, the hire date is 
treated as null by the DECODE function and the dynamic WHERE clause that is generated is also 
a null, which causes the second SELECT statement to retrieve all the rows from the 
EMPLOYEES table.

Note: The NEW_V[ALUE] variable specifies a variable to hold a column value. You can 
reference the variable in TTITLE commands. Use NEW_VALUE to display column values or the 
date in the top title. You must include the column in a BREAK command with the SKIP PAGE
action. The variable name cannot contain a pound sign (#). NEW_VALUE is useful for 
master/detail reports in which there is a new master record for each page.
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Generating a Dynamic Predicate (continued)

Note: Here, the hire date must be entered in the DD-MON-YYYY format.

The SELECT statement in the slide can be interpreted as follows:
IF   (<<deptno>> is not entered)  THEN

IF  (<<hiredate>> is not entered)  THEN
return empty string

ELSE 
return the string ‘WHERE hire_date = 

TO_DATE('<<hiredate>>', 'DD-MON-YYYY')’
ELSE

IF (<<hiredate>> is not entered)  THEN
return the string ‘WHERE department_id = 

<<deptno>> entered'
ELSE 

return the string ‘WHERE department_id = 
<<deptno>> entered

AND hire_date = 
TO_DATE(' <<hiredate>>', 'DD-MON-YYYY')’

END IF

The returned string becomes the value of the DYN_WHERE_CLAUSE variable, which will be 
used in the second SELECT statement.

Note: Use SQL*Plus for these examples.

When the first example in the slide is executed, the user is prompted for the values for DEPTNO
and HIREDATE:

The following value for MY_COL is generated:

When the second example in the slide is executed, the following output is generated:
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Summary

In this appendix, you should have learned that:

• You can write a SQL script to generate another SQL script

• Script files often use the data dictionary

• You can capture the output in a file

Summary

SQL can be used to generate SQL scripts. These scripts can be used to avoid repetitive coding, 
drop or re-create objects, get help from the data dictionary, and generate dynamic predicates that 
contain run-time parameters.

 

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
A

ca
de

m
y 

U
se

 O
nl

y 



 

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
A

ca
de

m
y 

U
se

 O
nl

y 



Copyright © 2010, Oracle. All rights reserved.

Oracle Database Architectural Components
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Objectives

After completing this appendix, you should be able to do the 
following:

• List the major database architectural components 

• Describe the background processes 

• Explain the memory structures 

• Correlate the logical and physical storage structures

Objectives

This appendix provides an overview of the Oracle Database architecture. You learn about the 
physical and logical structures and various components of Oracle Database and their functions. 
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Oracle Database Architecture: Overview

The Oracle Relational Database Management System 
(RDBMS) is a database management system that provides an 
open, comprehensive, integrated approach to information 
management.

Oracle Database Architecture: Overview

A database is a collection of data treated as a unit. The purpose of a database is to store and 
retrieve related information. 

An Oracle database reliably manages a large amount of data in a multiuser environment so that 
many users can concurrently access the same data. This is accomplished while delivering high 
performance. At the same time, it prevents unauthorized access and provides efficient solutions 
for failure recovery.
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Database

Oracle Database Server Structures

PMONSMON Others

Data files
Online redo 

log files
Control 

files

Instance

RECOARCnDBWn LGWRCKPT

User
process

Storage structures

Server
process

Memory structures

Processes

Database
buffer
cache

Shared pool

Data dictionary
cache

Library
cache

SGA

Redo log
buffer

Oracle Database Server Structures

The Oracle Database consists of two main components—the instance and the database. 
• The instance consists of the System Global Area (SGA), which is a collection of memory 

structures, and the background processes that perform tasks within the database. Every time 
an instance is started, the SGA is allocated and the background processes are started.

• The database consists of both physical structures and logical structures. Because the 
physical and logical structures are separate, the physical storage of data can be managed 
without affecting access to logical storage structures. The physical storage structures 
include:

- The control files where the database configuration is stored
- The redo log files that have information required for database recovery
- The data files where all data is stored

An Oracle instance uses memory structures and processes to manage and access the database 
storage structures. All memory structures exist in the main memory of the computers that 
constitute the database server. Processes are jobs that work in the memory of these computers. A 
process is defined as a “thread of control” or a mechanism in an operating system that can run a 
series of steps.
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Connecting to the Database

• Connection: Communication pathway between a user 
process and a database instance

• Session: A specific connection of a user to a database 
instance through a user process

SQL> Select … Session

Connection

User
User

Connecting to the Database

To access information in the database, the user needs to connect to the database using a tool 
(such as SQL*Plus). After the user establishes connection, a session is created for the user. 
Connection and session are closely related to user process but are very different in meaning.

A connection is a communication pathway between a user process and an Oracle Database 
instance. A communication pathway is established using available interprocess communication 
mechanisms or network software (when different computers run the database application and 
Oracle Database, and communicate through a network).

A session represents the state of a current user login to the database instance. For example, when 
a user starts SQL*Plus, the user must provide a valid username and password, and then a session 
is established for that user. A session lasts from the time the user connects until the time the user 
disconnects or exits the database application.

In the case of a dedicated connection, the session is serviced by a permanent dedicated process. 
In the case of a shared connection, the session is serviced by an available server process selected 
from a pool, either by the middle tier or by Oracle shared server architecture.

Multiple sessions can be created and exist concurrently for a single Oracle Database user using 
the same username, but through different applications, or multiple invocations of the same 
application.
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Interacting with an Oracle Database

User

Database
buffer
cache

Shared pool

Data dictionary
cache

Library
cache

PMONSMON Others

Instance

RECOARCn

SGA

DBWn

Redo log
buffer

LGWRCKPT

User
process

Server
process

Interacting with an Oracle Database

The following example describes Oracle Database operations at the most basic level. It 
illustrates an Oracle Database configuration where the user and associated server process are on 
separate computers, connected through a network.

1. An instance has started on a node where Oracle Database is installed, often called the host 
or database server.

2. A user starts an application spawning a user process. The application attempts to establish a 
connection to the server. (The connection may be local, client server, or a three-tier 
connection from a middle tier.)

3. The server runs a listener that has the appropriate Oracle Net Services handler. The server 
detects the connection request from the application and creates a dedicated server process 
on behalf of the user process.

4. The user runs a DML-type SQL statement and commits the transaction. For example, the
user changes the address of a customer in a table and commits the change.

5. The server process receives the statement and checks the shared pool (an SGA component) 
for any shared SQL area that contains a similar SQL statement. If a shared SQL area is 
found, the server process checks the user’s access privileges to the requested data, and the 
existing shared SQL area is used to process the statement. If not, a new shared SQL area is 
allocated for the statement, so it can be parsed and processed.
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Interacting with an Oracle Database (continued)

6. The server process retrieves any necessary data values, either from the actual data file (in 
which the table is stored) or those cached in the SGA.

7. The server process modifies data in the SGA. Because the transaction is committed, the log 
writer process (LGWR) immediately records the transaction in the redo log file. The 
database writer process (DBWn) writes modified blocks permanently to disk when doing so 
is efficient. 

8. If the transaction is successful, the server process sends a message across the network to the 
application. If it is not successful, an error message is transmitted.

9. Throughout this entire procedure, the other background processes run, watching for 
conditions that require intervention. In addition, the database server manages other users’ 
transactions and prevents contention between transactions that request the same data.
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Oracle Memory Architecture DB structures
Memory
- Process
- Storage

SGA

Database buffer
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Redo log 
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pool
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pool

Shared pool

Large pool

PGA PGA PGA
Background
processes

Server
process 1

Server
process 2

Shared 
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Library 
cache

Data Dictionary 
cache

Other

I/O Buffer

Response 
queue

Request 
queue

Free 
memory

Oracle Memory Structures

Oracle Database creates and uses memory structures for various purposes. For example, memory 
stores program code being run, data shared among users, and private data areas for each 
connected user. 
Two basic memory structures are associated with an instance:

• The System Global Area (SGA) is a group of shared memory structures, known as SGA 
components, that contain data and control information for one Oracle Database instance. 
The SGA is shared by all server and background processes. Examples of data stored in the 
SGA include cached data blocks and shared SQL areas.

• The Program Global Areas (PGA) are memory regions that contain data and control 
information for a server or background process. A PGA is nonshared memory created by 
Oracle Database when a server or background process is started. Access to the PGA is 
exclusive to the server process. Each server process and background process has its own 
PGA.
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Oracle Memory Structures (continued)

The SGA is the memory area that contains data and control information for the instance. The 
SGA includes the following data structures:

• Database buffer cache: Caches blocks of data retrieved from the database 
• Redo Log buffer: Caches redo information (used for instance recovery) until it can be 

written to the physical redo log files stored on the disk
• Shared pool: Caches various constructs that can be shared among users
• Large pool: Is an optional area that provides large memory allocations for certain large 

processes, such as Oracle backup and recovery operations, and input/output (I/O) server 
processes

• Java pool: Is used for all session-specific Java code and data within the Java Virtual 
Machine (JVM)

• Streams pool: Is used by Oracle Streams to store information required by capture and apply

When you start the instance by using Enterprise Manager or SQL*Plus, the amount of memory 
allocated for the SGA is displayed.

With the dynamic SGA infrastructure, the size of the database buffer cache, the shared pool, the 
large pool, the Java pool, and the Streams pool changes without shutting down the instance. 

Oracle Database uses initialization parameters to create and configure memory structures. For 
example, the SGA_TARGET parameter specifies the total size of the SGA components. If you 
set SGA_TARGET to 0, Automatic Shared Memory Management is disabled.
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Process Architecture

• User process:
– Is started when a database user or a batch process connects 

to the Oracle Database

• Database processes:
– Server process: Connects to the Oracle instance and is 

started when a user establishes a session
– Background processes: Are started when an Oracle instance 

is started

DB structures
- Memory
 Process
- Storage

PMONSMON

Others

Instance

RECOARCn

DBWn LGWRCKPT

PGA

User
process

Server
process

Background processes

SGA

Process Architecture

The processes in an Oracle Database server can be categorized into two major groups:
• User processes that run the application or Oracle tool code
• Oracle Database processes that run the Oracle database server code. These include server 

processes and background processes.

When a user runs an application program or an Oracle tool such as SQL*Plus, Oracle Database 
creates a user process to run the user’s application. The Oracle Database also creates a server 
process to execute the commands issued by the user process. In addition, the Oracle server also 
has a set of background processes for an instance that interact with each other and with the 
operating system to manage the memory structures and asynchronously perform I/O to write 
data to disk, and perform other required tasks. 

The process structure varies for different Oracle Database configurations, depending on the 
operating system and the choice of Oracle Database options. The code for connected users can 
be configured as a dedicated server or a shared server.

• With dedicated server, for each user, the database application is run by a user process, 
which is served by a dedicated server process that executes Oracle database server code.

• A shared server eliminates the need for a dedicated server process for each connection. A 
dispatcher directs multiple incoming network session requests to a pool of shared server 
processes. A shared server process serves any client request.
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Process Architecture (continued)

Server Processes

Oracle Database creates server processes to handle the requests of user processes connected to 
the instance. In some situations when the application and Oracle Database operate on the same 
computer, it is possible to combine the user process and the corresponding server process into a 
single process to reduce system overhead. However, when the application and Oracle Database 
operate on different computers, a user process always communicates with Oracle Database 
through a separate server process.

Server processes created on behalf of each user’s application can perform one or more of the 
following:

• Parse and run SQL statements issued through the application.
• Read necessary data blocks from data files on disk into the shared database buffers of the 

SGA, if the blocks are not already present in the SGA.
• Return results in such a way that the application can process the information.

Background Processes

To maximize performance and accommodate many users, a multiprocess Oracle Database 
system uses some additional Oracle Database processes called background processes. An Oracle 
Database instance can have many background processes.

The following background processes are required for a successful startup of the database 
instance:

• Database writer (DBWn) 
• Log writer (LGWR)  
• Checkpoint (CKPT) 
• System monitor (SMON)
• Process monitor (PMON)

The following background processes are a few examples of optional background processes that 
can be started if required:

• Recoverer (RECO)
• Job queue
• Archiver (ARCn)
• Queue monitor (QMNn)

Other background processes may be found in more advanced configurations such as Real 
Application Clusters (RAC). See the V$BGPROCESS view for more information about the 
background processes. 
On many operating systems, background processes are created automatically when an instance is 
started.
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Database Writer Process 

Writes modified (dirty) buffers in the database buffer cache to 
disk:

• Asynchronously while performing other processing

• Periodically to advance the checkpoint

Database buffer 
cache

Database writer 
process

Data files

DBWn

Database Writer Process

The database writer (DBWn) process writes the contents of buffers to data files. The DBWn
processes are responsible for writing modified (dirty) buffers in the database buffer cache to 
disk. Although one database writer process (DBW0) is adequate for most systems, you can 
configure additional processes (DBW1 through DBW9 and DBWa through DBWj) to improve 
write performance if your system modifies data heavily. These additional DBWn processes are 
not useful on uniprocessor systems.

When a buffer in the database buffer cache is modified, it is marked “dirty” and is added to the 
LRUW list of dirty buffers that is kept in system change number (SCN) order, thereby matching 
the order of Redo corresponding to these changed buffers that is written to the Redo logs. When 
the number of available buffers in the buffer cache falls below an internal threshold such that 
server processes find it difficult to obtain available buffers, DBWn writes dirty buffers to the 
data files in the order that they were modified by following the order of the LRUW list.
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Log Writer Process

• Writes the redo log buffer to a redo log file on disk

• LGWR writes:
– A process commits a transaction 

– When the redo log buffer is one-third full

– Before a DBWn process writes modified buffers to disk

Redo log buffer Log writer 
process

Redo log files

LGWR

Log Writer Process

The log writer (LGWR) process is responsible for redo log buffer management by writing the 
redo log buffer entries to a redo log file on disk. LGWR writes all redo entries that have been 
copied into the buffer since the last time it wrote.

The redo log buffer is a circular buffer. When LGWR writes redo entries from the redo log 
buffer to a redo log file, server processes can then copy new entries over the entries in the redo 
log buffer that have been written to disk. LGWR normally writes fast enough to ensure that 
space is always available in the buffer for new entries, even when access to the redo log is 
heavy.

LGWR writes one contiguous portion of the buffer to disk. LGWR writes:
• When a user process commits a transaction
• When the redo log buffer is one-third full
• Before a DBWn process writes modified buffers to disk, if necessary
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Checkpoint Process 

Records checkpoint information in:

• The control file 

• Each datafile header

Checkpoint 
process

Data files

Control 
fileCKPT

Checkpoint Process 

A checkpoint is a data structure that defines an SCN in the redo thread of a database. 
Checkpoints are recorded in the control file and each data file header, and are a crucial element 
of recovery.

When a checkpoint occurs, Oracle Database must update the headers of all data files to record 
the details of the checkpoint. This is done by the CKPT process. The CKPT process does not 
write blocks to disk; DBWn always performs that work. The SCNs recorded in the file headers 
guarantee that all the changes made to database blocks before that SCN have been written to 
disk.

The statistic DBWR checkpoints displayed by the SYSTEM_STATISTICS monitor in Oracle 
Enterprise Manager indicate the number of checkpoint requests completed.
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System Monitor Process 

• Performs recovery at instance startup

• Cleans up unused temporary segments

Instance

Temporary 
segment

System monitor 
process

SMON

System Monitor Process

The system monitor (SMON) process performs recovery, if necessary, at instance startup. 
SMON is also responsible for cleaning up temporary segments that are no longer in use. If any 
terminated transactions were skipped during instance recovery because of file-read or offline 
errors, SMON recovers them when the tablespace or file is brought back online. SMON checks 
regularly to see whether it is needed. Other processes can call SMON if they detect a need for it.
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Process Monitor Process

• Performs process recovery when a user process fails:
– Cleans up the database buffer cache

– Frees resources used by the user process

• Monitors sessions for idle session timeout 

• Dynamically registers database services with listeners

Process monitor 
process Database buffer 

cache

Failed user 
process

UserPMON

Process Monitor Process 

The process monitor (PMON) performs process recovery when a user process fails. PMON is 
responsible for cleaning up the database buffer cache and freeing resources that the user process 
was using. For example, it resets the status of the active transaction table, releases locks, and 
removes the process ID from the list of active processes.

PMON periodically checks the status of dispatcher and server processes, and restarts any that 
have stopped running (but not any that Oracle Database has terminated intentionally). PMON 
also registers information about the instance and dispatcher processes with the network listener.

Like SMON, PMON checks regularly to see whether it is needed and can be called if another 
process detects the need for it.
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Oracle Database Storage Architecture

Database

Data files
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Oracle Database Storage Architecture

The files that constitute an Oracle database are organized into the following:
• Control files: Contain data about the database itself (that is, physical database structure 

information). These files are critical to the database. Without them, you cannot open data 
files to access the data within the database.

• Data files: Contain the user or application data of the database, as well as metadata and the 
data dictionary

• Online redo log files: Allow for instance recovery of the database. If the database server 
crashes and does not lose any data files, the instance can recover the database with the 
information in these files.

The following additional files are important to the successful running of the database:
• Backup files: Are used for database recovery. You typically restore a backup file when a 

media failure or user error has damaged or deleted the original file.
• Archived log files: Contain an ongoing history of the data changes (redo) that are generated 

by the instance. Using these files and a backup of the database, you can recover a lost data 
file. That is, archive logs enable the recovery of restored data files.

• Parameter file: Is used to define how the instance is configured when it starts up
• Password file: Allows sysdba/sysoper/sysasm to connect remotely to the database 

and perform administrative tasks
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Oracle Database Storage Architecture (continued)

• Network files: Are used for starting the database listener and store information required for 
user connections

• Trace files: Each server and background process can write to an associated trace file. When 
an internal error is detected by a process, the process dumps information about the error to 
its trace file. Some of the information written to a trace file is intended for the database 
administrator, whereas other information is for Oracle Support Services. 

• Alert log files: These are special trace entries. The alert log of a database is a chronological 
log of messages and errors. Each instance has one alert log file. Oracle recommends that 
you review this alert log periodically.
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Logical and Physical Database Structures

Database

Logical Physical

Tablespace Data file

OS block
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Oracle data
block

Schema

Logical and Physical Database Structures

An Oracle database has logical and physical storage structures. 

Tablespaces

A database is divided into logical storage units called tablespaces, which group related logical 
structures together. For example, tablespaces commonly group all of an application’s objects to 
simplify some administrative operations. You may have a tablespace for application data and an 
additional one for application indexes.

Databases, Tablespaces, and Data Files

The relationship among databases, tablespaces, and data files is illustrated in the slide. Each 
database is logically divided into one or more tablespaces. One or more data files are explicitly 
created for each tablespace to physically store the data of all logical structures in a tablespace. If 
it is a TEMPORARY tablespace, instead of a data file, the tablespace has a temporary file.
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Logical and Physical Database Structures (continued) 

Schemas

A schema is a collection of database objects that are owned by a database user. Schema objects 
are the logical structures that directly refer to the database’s data. Schema objects include such 
structures as tables, views, sequences, stored procedures, synonyms, indexes, clusters, and 
database links. In general, schema objects include everything that your application creates in the 
database.

Data Blocks

At the finest level of granularity, an Oracle database’s data is stored in data blocks. One data 
block corresponds to a specific number of bytes of physical database space on the disk. A data 
block size is specified for each tablespace when it is created. A database uses and allocates free 
database space in Oracle data blocks.

Extents 

The next level of logical database space is called an extent. An extent is a specific number of 
contiguous data blocks (obtained in a single allocation) that are used to store specific type of 
information.

Segments 

The level of logical database storage above an extent is called a segment. A segment is a set of 
extents allocated for a certain logical structure. For example, the different types of segments 
include:

• Data segments: Each nonclustered, non-indexed-organized table has a data segment with 
the exception of external tables, global temporary tables, and partitioned tables, where each 
table has one or more segments. All of the table’s data is stored in the extents of its data 
segment. For a partitioned table, each partition has a data segment. Each cluster has a data 
segment. The data of every table in the cluster is stored in the cluster’s data segment. 

• Index segments: Each index has an index segment that stores all of its data. For a 
partitioned index, each partition has an index segment.

• Undo segments: One UNDO tablespace is created per database instance that contains 
numerous undo segments to temporarily store undo information. The information in an 
undo segment is used to generate read-consistent database information and, during database 
recovery, to roll back uncommitted transactions for users.

• Temporary segments: Temporary segments are created by the Oracle Database when a 
SQL statement needs a temporary work area to complete execution. When the statement 
finishes execution, the temporary segment’s extents are returned to the instance for future 
use. Specify a default temporary tablespace for every user or a default temporary 
tablespace, which is used databasewide.

The Oracle Database dynamically allocates space. When the existing extents of a segment are 
full, additional extents are added. Because extents are allocated as needed, the extents of a 
segment may or may not be contiguous on the disk.

 

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
A

ca
de

m
y 

U
se

 O
nl

y 



Oracle Database: SQL Fundamentals II   I - 21

Copyright © 2010, Oracle. All rights reserved.

Processing a SQL Statement

• Connect to an instance using:
– The user process

– The server process

• The Oracle server components that are used depend on 
the type of SQL statement:
– Queries return rows.

– Data manipulation language (DML) statements log changes.

– Commit ensures transaction recovery.

• Some Oracle server components do not participate in SQL 
statement processing.

Processing a SQL Statement

Not all the components of an Oracle instance are used to process SQL statements. The user and 
server processes are used to connect a user to an Oracle instance. These processes are not part of 
the Oracle instance, but are required to process a SQL statement.

Some of the background processes, SGA structures, and database files are used to process SQL 
statements. Depending on the type of SQL statement, different components are used:

• Queries require additional processing to return rows to the user.
• DML statements require additional processing to log the changes made to the data.
• Commit processing ensures that the modified data in a transaction can be recovered.

Some required background processes do not directly participate in processing a SQL statement, 
but are used to improve performance and to recover the database. For example, the optional 
Archiver background process, ARCn, is used to ensure that a production database can be 
recovered.
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Processing a Query

• Parse:
– Search for an identical statement.

– Check the syntax, object names, and privileges.

– Lock the objects used during parse.

– Create and store the execution plan.

• Execute: Identify the rows selected.

• Fetch: Return the rows to the user process.

Processing a Query

Queries are different from other types of SQL statements because, if successful, they return data 
as results. Other statements simply return success or failure, whereas a query can return one row 
or thousands of rows. 

There are three main stages in the processing of a query:
• Parse
• Execute
• Fetch

During the parse stage, the SQL statement is passed from the user process to the server process, 
and a parsed representation of the SQL statement is loaded into a shared SQL area. 

During parse, the server process performs the following functions:
• Searches for an existing copy of the SQL statement in the shared pool
• Validates the SQL statement by checking its syntax
• Performs data dictionary lookups to validate table and column definitions

The execute stage executes the statement using the best optimizer approach and the fetch 
retrieves the rows back to the user.
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Shared Pool

• The library cache contains the SQL statement text, parsed 
code, and execution plan.

• The data dictionary cache contains table, column, and 
other object definitions and privileges.

• The shared pool is sized by SHARED_POOL_SIZE.

Data dictionary
cache

Library

cache

Shared pool

Shared Pool

During the parse stage, the server process uses the area in the SGA known as the shared pool to 
compile the SQL statement. The shared pool has two primary components:

• Library cache
• Data dictionary cache

Library Cache

The library cache stores information about the most recently used SQL statements in a memory 
structure called a shared SQL area. The shared SQL area contains:

• The text of the SQL statement
• The parse tree, which is a compiled version of the statement
• The execution plan, with steps to be taken when executing the statement

The optimizer is the function in the Oracle server that determines the optimal execution plan.

If a SQL statement is reexecuted and a shared SQL area already contains the execution plan for 
the statement, the server process does not need to parse the statement. The library cache 
improves the performance of applications that reuse SQL statements by reducing parse time and 
memory requirements. If the SQL statement is not reused, it is eventually aged out of the library 
cache.
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Shared Pool (continued)

Data Dictionary Cache

The data dictionary cache, also known as the dictionary cache or row cache, is a collection of the 
most recently used definitions in the database. It includes information about database files, 
tables, indexes, columns, users, privileges, and other database objects.

During the parse phase, the server process looks for the information in the dictionary cache to 
resolve the object names specified in the SQL statement and to validate the access privileges. If 
necessary, the server process initiates the loading of this information from the data files.

Sizing the Shared Pool

The size of the shared pool is specified by the SHARED_POOL_SIZE initialization parameter.
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Database Buffer Cache

• The database buffer cache stores the most recently used 
blocks.

• The size of a buffer is based on DB_BLOCK_SIZE.

• The number of buffers is defined by DB_BLOCK_BUFFERS.

Database buffer
cache

Database Buffer Cache

When a query is processed, the server process looks in the database buffer cache for any blocks 
it needs. If the block is not found in the database buffer cache, the server process reads the block 
from the data file and places a copy in the buffer cache. Because subsequent requests for the 
same block may find the block in memory, the requests may not require physical reads. The 
Oracle server uses a least recently used algorithm to age out buffers that have not been accessed 
recently to make room for new blocks in the buffer cache.

Sizing the Database Buffer Cache

The size of each buffer in the buffer cache is equal to the size of an Oracle block, and it is 
specified by the DB_BLOCK_SIZE parameter. The number of buffers is equal to the value of 
the DB_BLOCK_BUFFERS parameter.
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Program Global Area (PGA)

• Is not shared

• Is writable only by the server process

• Contains:
– Sort area

– Session information

– Cursor state

– Stack space

Server
process

PGA

Program Global Area (PGA)

A Program Global Area (PGA) is a memory region that contains data and control information 
for a server process. It is a nonshared memory created by Oracle when a server process is 
started. Access to it is exclusive to that server process, and is read and written only by the Oracle 
server code acting on behalf of it. The PGA memory allocated by each server process attached to 
an Oracle instance is referred to as the aggregated PGA memory allocated by the instance. 

In a dedicated server configuration, the PGA of the server includes the following components:
• Sort area: Is used for any sorts that may be required to process the SQL statement
• Session information: Includes user privileges and performance statistics for the session
• Cursor state: Indicates the stage in the processing of the SQL statements that are currently 

used by the session
• Stack space: Contains other session variables

The PGA is allocated when a process is created, and deallocated when the process is terminated.
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Processing a DML Statement
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Processing a DML Statement

A data manipulation language (DML) statement requires only two phases of processing:
• Parse is the same as the parse phase used for processing a query.
• Execute requires additional processing to make data changes.

DML Execute Phase

To execute a DML statement:
• If the data and rollback blocks are not already in the buffer cache, the server process reads 

them from the data files into the buffer cache
• The server process places locks on the rows that are to be modified
• In the redo log buffer, the server process records the changes to be made to the rollback and 

data blocks
• The rollback block changes record the values of the data before it is modified. The rollback 

block is used to store the “before image” of the data, so that the DML statements can be 
rolled back if necessary.

• The data block changes record the new values of the data
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Processing a DML Statement (continued)

The server process records the “before image” to the rollback block and updates the data block. 
Both of these changes are done in the database buffer cache. Any changed blocks in the buffer 
cache are marked as dirty buffers (that is, buffers that are not the same as the corresponding 
blocks on the disk).

The processing of a DELETE or INSERT command uses similar steps. The “before image” for a 
DELETE contains the column values in the deleted row, and the “before image” of an INSERT
contains the row location information.

Because the changes made to the blocks are only recorded in memory structures and are not 
written immediately to disk, a computer failure that causes the loss of the SGA can also lose 
these changes.
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Redo Log Buffer

• Has its size defined by LOG_BUFFER

• Records changes made through the instance

• Is used sequentially

• Is a circular buffer

Redo log buffer

Redo Log Buffer

The server process records most of the changes made to data file blocks in the redo log buffer, 
which is a part of the SGA. The redo log buffer has the following characteristics:

• Its size in bytes is defined by the LOG_BUFFER parameter.
• It records the block that is changed, the location of the change, and the new value in a redo 

entry. A redo entry makes no distinction between the types of block that is changed; it only 
records which bytes are changed in the block.

• The redo log buffer is used sequentially, and changes made by one transaction may be 
interleaved with changes made by other transactions.

• It is a circular buffer that is reused after it is filled, but only after all the old redo entries are 
recorded in the redo log files.
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Rollback Segment

DML statement

Old image

New image
Rollback segment

Table

Rollback Segment

Before making a change, the server process saves the old data value in a rollback segment. This 
“before image” is used to:

• Undo the changes if the transaction is rolled back
• Provide read consistency by ensuring that other transactions do not see uncommitted 

changes made by the DML statement
• Recover the database to a consistent state in case of failures

Rollback segments, such as tables and indexes, exist in data files, and rollback blocks are 
brought into the database buffer cache as required. Rollback segments are created by the DBA. 

Changes to rollback segments are recorded in the redo log buffer.
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COMMIT Processing
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COMMIT Processing 

The Oracle server uses a fast COMMIT mechanism that guarantees that the committed changes 
can be recovered in case of instance failure.

System Change Number

Whenever a transaction commits, the Oracle server assigns a commit SCN to the transaction. 
The SCN is monotonically incremented and is unique within the database. It is used by the 
Oracle server as an internal time stamp to synchronize data and to provide read consistency 
when data is retrieved from the data files. Using the SCN enables the Oracle server to perform 
consistency checks without depending on the date and time of the operating system.

Steps in Processing COMMITs

When a COMMIT is issued, the following steps are performed:
1. The server process places a commit record, along with the SCN, in the redo log buffer.
2. LGWR performs a contiguous write of all the redo log buffer entries up to and including

the commit record to the redo log files. After this point, the Oracle server can guarantee 
that the changes will not be lost even if there is an instance failure.
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COMMIT Processing (continued)

3. The user is informed that the COMMIT is complete.
4. The server process records information to indicate that the transaction is complete and that 

resource locks can be released.

Flushing of the dirty buffers to the data file is performed independently by DBW0 and can occur 
either before or after the commit.

Advantages of the Fast COMMIT

The fast COMMIT mechanism ensures data recovery by writing changes to the redo log buffer 
instead of the data files. It has the following advantages:

• Sequential writes to the log files are faster than writing to different blocks in the data file.
• Only the minimal information that is necessary to record changes is written to the log files; 

writing to the data files would require whole blocks of data to be written.
• If multiple transactions request to commit at the same time, the instance piggybacks redo 

log records into a single write.
• Unless the redo log buffer is particularly full, only one synchronous write is required per 

transaction. If piggybacking occurs, there can be less than one synchronous write per 
transaction.

• Because the redo log buffer may be flushed before the COMMIT, the size of the transaction 
does not affect the amount of time needed for an actual COMMIT operation.

Note: Rolling back a transaction does not trigger LGWR to write to disk. The Oracle server 
always rolls back uncommitted changes when recovering from failures. If there is a failure after 
a rollback, before the rollback entries are recorded on disk, the absence of a commit record is 
sufficient to ensure that the changes made by the transaction are rolled back.
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Summary of the Oracle Database Architecture
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Summary of the Oracle Database Architecture

An Oracle database comprises an instance and its associated database:
• An instance comprises the SGA and the background processes

- SGA: Database buffer cache, redo log buffer, shared pool, and so on
- Background processes: SMON, PMON, DBWn, CKPT, LGWR, and so on

• A database comprises storage structures:
- Logical: Tablespaces, schemas, segments, extents, and Oracle block
- Physical: Data files, control files, redo log files

When a user accesses the Oracle database through an application, a server process 
communicates with the instance on behalf of the user process.
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Additional Practices 
The following exercises can be used for extra practice after you have discussed data 
manipulation language (DML) and data definition language (DDL) statements in the 
lessons titled “Managing Schema Objects” and “Manipulating Large Data Sets.” 
 
Note: Run the lab_ap_cre_special_sal.sql, 
lab_ap_cre_sal_history.sql, and lab_ap_cre_mgr_history.sql 
scripts in the labs folder to create the SPECIAL_SAL, SAL_HISTORY, and 
MGR_HISTORY tables. 
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Additional Practices 
 

1. The Human Resources department wants to get a list of underpaid employees, 
salary history of employees, and salary history of managers based on an industry 
salary survey. So they have asked you to do the following: 

Write a statement to do the following: 

- Retrieve details such as the employee ID, hire date, salary, and manager ID 
of those employees whose employee ID is more than or equal to 200 from 
the EMPLOYEES table. 

- If the salary is less than $5,000, insert details such as the employee ID and 
salary into the SPECIAL_SAL table. 

- Insert details such as the employee ID, hire date, and salary into the 
SAL_HISTORY table. 

- Insert details such as the employee ID, manager ID, and salary into the 
MGR_HISTORY table. 

2. Query the SPECIAL_SAL, SAL_HISTORY, and MGR_HISTORY tables to view 
the inserted records. 

 

 

 

 
 

 

 

 

 
 

 

 

SAL_HISTORY 

MGR_HISTORY 

SPECIAL_SAL 
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Additional Practices (continued) 

Oracle Database: SQL Fundamentals II   Additional Practices - 5 

 
 

3. Nita, the DBA, needs you to create a table, which has a primary key constraint, 
but she wants the index to have a different name than the constraint. Create the 
LOCATIONS_NAMED_INDEX table based on the following table instance chart. 
Name the index for the PRIMARY KEY column as LOCATIONS_PK_IDX. 

4. Query the USER_INDEXES table to display the INDEX_NAME for the 
LOCATIONS_NAMED_INDEX table. 

 

              
 

Column Name Deptno Dname 

Primary Key Yes  

Data Type Number VARCHAR2 

Length 4 30 
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The following exercises can be used for extra practice after you have discussed 
datetime functions. 

You work for a global company and the new vice president of operations wants to 
know the  
different time zones of all the company branches. The new vice president has requested 
the following information: 

5.  Alter the session to set the NLS_DATE_FORMAT to DD-MON-YYYY 
HH24:MI:SS. 

 
6.  

a. Write queries to display the time zone offsets (TZ_OFFSET) for the following 
time zones: 

– Australia/Sydney  

 
 

– Chile/Easter Island  

 
 

b. Alter the session to set the TIME_ZONE parameter value to the time zone 
offset of Australia/Sydney. 

c. Display SYSDATE, CURRENT_DATE, CURRENT_TIMESTAMP, and 
LOCALTIMESTAMP for this session. 
Note: The output might be different based on the date when the command is 
executed. 

 
  

d. Alter the session to set the TIME_ZONE parameter value to the time zone 
offset of Chile/Easter Island. 

Note: The results of the preceding question are based on a different date, and 
in some cases, they will not match the actual results that the students get. 
Also, the time zone offset of the various countries may differ, based on 
daylight saving time. 

 
e. Display SYSDATE, CURRENT_DATE, CURRENT_TIMESTAMP, and 

LOCALTIMESTAMP for this session. 

Note: The output may be different based on the date when the command is 
executed. 
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f. Alter the session to set NLS_DATE_FORMAT to DD-MON-YYYY. 

Note 

• Observe in the preceding question that CURRENT_DATE, 
CURRENT_TIMESTAMP, and LOCALTIMESTAMP are all sensitive to the 
session time zone. Observe that SYSDATE is not sensitive to the session time 
zone. 

• The results of the preceding question are based on a different date, and in 
some cases, they will not match the actual results that the students get. Also 
the time zone offset of the various countries may differ, based on daylight 
saving time. 

 

7.  The Human Resources department wants a list of employees who are up for 
review in January, so they have requested you to do the following: 

Write a query to display the last names, month of the date of hire, and hire date of 
those employees who have been hired in the month of January, irrespective of the 
year of hire. 
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The following exercises can be used for extra practice after you have discussed 
advanced subqueries. 

 

8. The CEO needs a report on the top three earners in the company for profit 
sharing. You are responsible to provide the CEO with a list. Write a query to 
display the top three earners in the EMPLOYEES table. Display their last names 
and salaries. 

 
 

 

9. The benefits for the state of California have been changed based on a local 
ordinance. So the benefits representative has asked you to compile a list of the 
people who are affected. 
Write a query to display the employee ID and last names of the employees who 
work in the state of California. 
Hint: Use scalar subqueries. 

 
 

 

10. Nita, the DBA, wants to remove old information from the database. One of the 
things she thinks is unnecessary is the old employment records. She has asked you 
to do the following: 

Write a query to delete the oldest JOB_HISTORY row of an employee by looking 
up the JOB_HISTORY table for the MIN(START_DATE) for the employee. 
Delete the records of only those employees who have changed at least two jobs. 
Hint: Use a correlated DELETE command. 
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11. The vice president of Human Resources needs the complete employment records 
for the annual employee recognition banquet speech. The vice president makes a 
quick phone call to stop you from following the DBA’s orders.  
 
Roll back the transaction. 

 

12. The sluggish economy is forcing management to take cost reduction actions. The 
CEO wants to review the highest paid jobs in the company. You are responsible 
to provide the CEO with a list based on the following specifications: 

Write a query to display the job IDs of those jobs whose maximum salary is 
above half the maximum salary in the entire company. Use the WITH clause to 
write this query. Name the query MAX_SAL_CALC. 
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Additional Practices: Case Study  

In the case study for the SQL Fundamentals I course, you built a set of database tables for 
a video application. In addition, you inserted, updated, and deleted records in a video 
store database and generated a report. 

The following is a diagram of the tables and columns that you created for the video 
application: 

 

Note: First, run the dropvid.sql script in the labs folder to drop tables if they 
already exist. Then run the  buildvid.sql script in the labs folder to create and 
populate the tables.  

1. Verify that the tables were created properly by running a report to show the list of 
tables and their column definitions. 
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2. Verify the existence of the MEMBER_ID_SEQ and TITLE_ID_SEQ sequences 
in the data dictionary. 

 

3. You want to create some users who have access only to their own rentals. Create a 
user called Carmen and grant her the privilege to select from the RENTAL table.  
Note: Make sure to prefix the username with your database account. For example, 
if you are the user oraxx, create a user called oraxx_Carmen. 

4. Add a price column (number 4,2) to the TITLE table to store how much it costs 
to rent the title. 

5. Add a CATEGORY table to store CATEGORY_ID and 
CATEGORY_DESCRIPTION. The table has a foreign key with the CATEGORY 
column in the TITLE table. 

6. Select all the tables from the data dictionary. 

7. There is no real need to store reservations any longer. You can drop the table. 
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8. Create a RENTAL_HISTORY table to store the details of a rental by member for 
the last six months. (Hint: You can copy the RENTAL table.) 

9. Show a list of the top 10 titles rented in the last month grouped by category. 

 

10. You want to calculate the late fee (price of title/day) if the member brings back 
the video six days late. 

 

11. Show a list of members who have rented two or more times. 

 

12. Show a list of titles who have a status of rented. 

 

13. Show a list of members who have “99” in their phone numbers. 

 

 

 

O
ra

cl
e 

In
te

rn
al

 &
 O

ra
cl

e 
A

ca
de

m
y 

U
se

 O
nl

y 



 

Oracle Database: SQL Fundamentals II   Additional Practices - 13 

Additional Practices Solution  
 

The following exercises can be used for extra practice after you have discussed data 
manipulation language (DML) and data definition language (DDL) statements in the 
lessons titled “Managing Schema Objects” and “Manipulating Large Data Sets.” 

Note: Run the lab_ap_cre_special_sal.sql, 
lab_ap_cre_sal_history.sql, and lab_ap_cre_mgr_history.sql 
scripts in the labs folder to create the SPECIAL_SAL, SAL_HISTORY, and 
MGR_HISTORY tables 

.
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Additional Practices Solution  
1. The Human Resources department wants to get a list of underpaid employees, 

salary history of employees, and salary history of managers based on an industry 
salary survey. So they have asked you to do the following: 

Write a statement to do the following: 

- Retrieve details such as the employee ID, hire date, salary, and manager ID 
of those employees whose employee ID is more than or equal to 200 from 
the EMPLOYEES table. 

- If the salary is less than $5,000, insert details such as the employee ID and 
salary into the SPECIAL_SAL table. 

- Insert details such as the employee ID, hire date, and salary into the 
SAL_HISTORY table. 

- Insert details such as the employee ID, manager ID, and salary into the 
MGR_HISTORY table. 

 
INSERT ALL 
WHEN SAL < 5000 THEN 
INTO  special_sal VALUES (EMPID, SAL) 
ELSE 
INTO sal_history VALUES(EMPID,HIREDATE,SAL) 
INTO mgr_history VALUES(EMPID,MGR,SAL)    
SELECT employee_id EMPID, hire_date HIREDATE, 
         salary SAL, manager_id MGR 
FROM employees 
WHERE employee_id >=200;  

 

2. Query the SPECIAL_SAL, SAL_HISTORY, and the MGR_HISTORY tables to 
view the inserted records. 

   
      SELECT * FROM special_sal; 
      SELECT * FROM sal_history; 
      SELECT * FROM mgr_history; 

3. Nita, the DBA, needs you to create a table, which has a primary key constraint, 
but she wants the index to have a different name than the constraint. Create the 
LOCATIONS_NAMED_INDEX table based on the following table instance chart. 
Name the index for the PRIMARY KEY column as LOCATIONS_PK_IDX.  
 
Column Name Deptno Dname 

Primary Key Yes  

Data Type Number VARCHAR2 

Length 4 30 
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CREATE TABLE LOCATIONS_NAMED_INDEX 
(location_id NUMBER(4) PRIMARY KEY USING INDEX 
(CREATE INDEX locations_pk_idx ON 
LOCATIONS_NAMED_INDEX(location_id)), 
location_name VARCHAR2(20)); 

 

4. Query the USER_INDEXES table to display the INDEX_NAME for the 
LOCATIONS_NAMED_INDEX table. 

 
SELECT INDEX_NAME, TABLE_NAME 
FROM USER_INDEXES 
WHERE TABLE_NAME = ‘LOCATIONS_NAMED_INDEX’; 
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The following exercises can be used for extra practice after you have discussed 
datetime functions. 

You work for a global company and the new vice president of operations wants to 
know the different time zones of all the company branches. The new vice president has 
requested the following information: 

5. Alter the session to set NLS_DATE_FORMAT to DD-MON-YYYY HH24:MI:SS. 

 
        ALTER SESSION 
        SET NLS_DATE_FORMAT = ‘DD-MON-YYYY HH24:MI:SS’; 

 

6.  
a.  Write queries to display the time zone offsets (TZ_OFFSET) for the following 

time zones: 

– Australia/Sydney 
 

  SELECT TZ_OFFSET (‘Australia/Sydney’) from  dual;  

– Chile/Easter Island 
 

  SELECT TZ_OFFSET (‘Chile/EasterIsland’) from dual; 

 

b. Alter the session to set the TIME_ZONE parameter value to the time zone 
offset of Australia/Sydney. 

 

ALTER SESSION SET TIME_ZONE = ‘+10:00’; 

c. Display SYSDATE, CURRENT_DATE, CURRENT_TIMESTAMP, and 
LOCALTIMESTAMP for this session. 
Note: The output may be different based on the date when the command is 
executed. 

 SELECT SYSDATE, CURRENT_DATE, CURRENT_TIMESTAMP, 
 LOCALTIMESTAMP FROM DUAL; 

 

d. Alter the session to set the TIME_ZONE parameter value to the time zone 
offset of Chile/Easter Island. 

Note: The results of the preceding question are based on a different date, and 
in some cases, they will not match the actual results that the students get. 
Also, the time zone offset of the various countries may differ, based on 
daylight saving time. 

 
  ALTER SESSION SET TIME_ZONE = ‘-06:00’; 

  

e. Display SYSDATE, CURRENT_DATE, CURRENT_TIMESTAMP, and 
LOCALTIMESTAMP for this session. 
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Note: The output may be different based on the date when the command is 
executed. 

 

  SELECT SYSDATE, CURRENT_DATE, CURRENT_TIMESTAMP, 
 LOCALTIMESTAMP FROM DUAL; 
 

f. Alter the session to set NLS_DATE_FORMAT to DD-MON-YYYY. 

 
  ALTER SESSION SET NLS_DATE_FORMAT = ‘DD-MON-YYYY’; 

 

Note 

• Observe in the preceding question that CURRENT_DATE, 
CURRENT_TIMESTAMP, and LOCALTIMESTAMP are all sensitive to the session 
time zone. Observe that SYSDATE is not sensitive to the session time zone. 

• The results of the preceding question are based on a different date, and in some 
cases, they will not match the actual results that the students get. Also, the time 
zone offset of the various countries may differ, based on daylight saving time. 

 

7. The Human Resources department wants a list of employees who are up for 
review in January, so they have requested you to do the following: 

Write a query to display the last names, month of the date of hire, and hire date of 
those employees who have been hired in the month of January, irrespective of the 
year of hire. 
 

 SELECT last_name, EXTRACT (MONTH FROM HIRE_DATE), HIRE_DATE 
FROM employees 
WHERE EXTRACT (MONTH FROM HIRE_DATE) = 1;  

 
The following exercises can be used for extra practice after you have discussed 
advanced subqueries. 
Note: If you have converted the HIRE_DATE column to TIMESTAMP using 
code_05_12_sb.sql, the display of the HIRE_DATE column would be like 13-JAN-
00 12.00.00.000000000 AM 

 

8. The CEO needs a report on the top three earners in the company for profit 
sharing. You are responsible to provide the CEO with a list. 

     Write a query to display the top three earners in the EMPLOYEES table. Display 
their last names and salaries. 

 SELECT last_name, salary 
        FROM   employees e 
        WHERE 3  > (SELECT COUNT (*) 
                FROM   employees 
                WHERE e.salary < salary); 
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9. The benefits for the state of California have been changed based on a local 
ordinance. So the benefits representative has asked you to compile a list of the 
people who are affected. Write a query to display the employee ID and last names 
of the employees who work in the state of California. 
Hint: Use scalar subqueries. 

        
       SELECT employee_id, last_name 
       FROM employees e 
       WHERE ((SELECT location_id 
                   FROM departments d 
                   WHERE e.department_id = department_id ) 
               IN  (SELECT location_id 
                        FROM locations l 
                        WHERE state_province = ‘California’)); 

  

 

10. Nita, the DBA, wants to remove old information from the database. One of the 
things she thinks is unnecessary is the old employment records. She has asked you 
to do the following:  

Write a query to delete the oldest JOB_HISTORY row of an employee by looking 
up the JOB_HISTORY table for the MIN(START_DATE)for the employee. 
Delete the records of only those employees who have changed at least two jobs. 
Hint: Use a correlated DELETE command. 
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Oracle Database: SQL Fundamentals II   Additional Practices - 19 

 

  
  DELETE FROM job_history JH 
 WHERE employee_id =  
                 (SELECT employee_id  
                    FROM employees E 
                    WHERE JH.employee_id = E.employee_id 
                    AND START_DATE = (SELECT MIN(start_date) 
                                  FROM job_history JH 
                              WHERE JH.employee_id =               
                                                E.employee_id) 
                                  AND 3 > (SELECT COUNT(*)   
                                 FROM job_history JH 
                              WHERE JH.employee_id =  
                                                E.employee_id 
                          GROUP BY EMPLOYEE_ID 
                          HAVING COUNT(*) >= 2)); 

 

11. The vice president of Human Resources needs the complete employment records 
for the annual employee recognition banquet speech. The vice president makes a 
quick phone call to stop you from following the DBA’s orders. 

Roll back the transaction. 

  
ROLLBACK; 

 
12. The sluggish economy is forcing management to take cost reduction actions. The 

CEO wants to review the highest paid jobs in the company. You are responsible 
to provide the CEO with a list based on the following specifications: 

Write a query to display the job IDs of those jobs whose maximum salary is 
above half the maximum salary in the entire company. Use the WITH clause to 
write this query. Name the query MAX_SAL_CALC. 

  
     WITH  
 MAX_SAL_CALC AS (SELECT job_title, MAX(salary) AS 
 job_total 
 FROM employees, jobs 
 WHERE employees.job_id = jobs.job_id 
 GROUP BY job_title) 
 SELECT job_title, job_total 
 FROM MAX_SAL_CALC 
 WHERE job_total > (SELECT MAX(job_total) * 1/2 
 FROM MAX_SAL_CALC) 
 ORDER BY job_total DESC; 
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Additional Practices: Case Study Solutions 

First, run the dropvid.sql script in the labs folder to drop tables if they already 
exist. Then run the buildvid.sql script in the labs folder to create and populate 
the tables.  

1. Verify that the tables were created properly by running a report to show the list of 
tables and their column definitions.  

SELECT table_name,column_name,data_type,nullable 
FROM user_tab_columns 
WHERE table_name 
IN('MEMBER','TITLE','TITLE_COPY','RENTAL','RESERVATION'); 

2. Verify the existence of the MEMBER_ID_SEQ and TITLE_ID_SEQ sequences 
in the data dictionary.  
 

SELECT sequence_name FROM user_sequences; 

  

3. You want to create some users who have access only to their own rentals. Create a 
user called Carmen and grant her the privilege to select from the RENTAL table. 
Note: Make sure to prefix the username with your database account. For example, 
if you are the user oraxx, create a user called oraxx_Carmen. 

CREATE USER oraxx_carmen IDENTIFIED BY oracle ; 
GRANT select ON rental TO oraxx_carmen; 

4. Add a price column (number 4,2) to the TITLE table to store how much it costs 
to rent the title. 

ALTER TABLE title ADD(price NUMBER(6)) 

5. Add a CATEGORY table to store CATEGORY_ID and 
CATEGORY_DESCRIPTION. The table has a foreign key with the CATEGORY 
column in the TITLE table. 

CREATE TABLE CATEGORY  
   ( "CATEGORY_ID" NUMBER(6,0) NOT NULL ENABLE,  
 "CATEGORY_DESCRIPTION" VARCHAR2(4000 BYTE),  
  CONSTRAINT "CATEGORY_PK" PRIMARY KEY ("CATEGORY_ID")) 

6. Select all the tables from the data dictionary. 

SELECT table_name FROM user_tables order by table_name; 

7. There is no real need to store reservations any longer. You can drop the table. 

DROP TABLE reservation cascade constraints; 
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8. Create a RENTAL_HISTORY table to store the details of a rental by member for 
the last six months. (Hint: You can copy the RENTAL table.) 

 CREATE TABLE rental_history as select * from rental where '1' 
= '1' 

9. Show a list of the top 10 titles rented in the last month grouped by category. 

SELECT t.CATEGORY, t.TITLE  
FROM TITLE t, RENTAL r  
WHERE t.TITLE_ID = r.TITLE_ID AND 
      r. BOOK_DATE > (SYSDATE - 30) AND 
      rownum < 10 
order by category; 

10. You want to calculate the late fee (price of title/day) if the member brings back 
the video six days late. 

SELECT t.title, m.member_id, t.price, (t.price*6) latefee  
FROM title t, member m, rental r  
WHERE t.title_id = r.title_id AND 
   m.member_id = r.member_id AND 
   r.act_ret_date is null; 

11. Show a list of members who have rented two or more times. 

SELECT member_id, last_name, first_name FROM member m 
where 2 <= (select count(*) from rental_history where 
member_id = m.member_id); 

12. Show a list of  titles who have a status of rented. 

SELECT t.title  
FROM title t  
JOIN (select title_id, status from title_copy) b 
ON t.title_id = b.title_id AND b.status = 'RENTED'; 

13. Show a list of members who have “99” in their phone numbers. 

SELECT REGEXP_COUNT(phone,'99',1,'i') position, member_id, 
last_name, first_name 
FROM member 
WHERE REGEXP_COUNT(phone,'99',1,'i') > 0; 
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